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B. ANSYS Workbench 简介 Training Manual

?什么是 ANSYS Workbench ?
–ANSYS Workbench 中提供了与 ANSYS 系统求解器的强大交互功能的
方 法。这个环境提供了一个独特的 CAD 及设计过程的集成系统。

? ANSYS Workbench 由多种的应用模块组成（例子） ：
–Mechanical ：利用 ANSYS 的求解器进行结构和热分析。

? 网格划分也包含在 Mechanical 应用中。

–Mechanical APDL ：采用传统的 ANSYS 用户界面对高级机械和多物理场进行分析。

– Fluid Flow (CFX) ：利用 CFX 进行 CFD 分析。
– Fluid Flow (FLUENT) ：使用 FLUENT 进行 CFD 分析 。
– Geometry (DesignModeler) ：创建几何模型（ DesignModeler ）和 CAD 几何模型的修
改
。– Engineering Data ：定义材料性能。

– Meshing Application ：用于生成 CFD 和显示动态网格。
– Design Exploration ：优化分析。
– Finite Element Modeler (FE Modeler) ：对 NASTRAN 和 ABAQUS 的网格进行转化以
进 行 ansys 分析。

– BladeGen (Blade Geometry) ：用于创建叶片几何模型。
– Explicit Dynamics ：具有非线性动力学特色的模型用于显式动力学模拟。
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⋯ ANSYS Workbench 简介 Training Manual

? Workbench 环境支持两种类型的应用程序：
–本地应用 (workspaces): 目前的本地应用包括工项目管理，工程数据和优化设计

? 本机应用程序的启动，完全在 Workbench 窗口运行。

–数据综合应用 : 目前的应用包括 Mechanical, Mechanical APDL, Fluent, CFX, 
AUTODYN 和其他。

本地应用

数据综合应用
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? Workbench –Mechanical 的分析类型 : ?
–结构分析 (静态和瞬态 ):

? 线性和非线性结构分析 .

–动力学分析 :
? 模态，谐波，随机振动，柔体和刚体动力学。

–热传递（稳态和瞬态）：
? 求解温度场和热流。与温相关的导热系数、对流系数的材料。

?注意，以上的可用功能由用户的 ANSYS 许可文件决定。并非所有列出的功能已涵盖在此入 门
课程 .

–静磁场 :
? 执行三维静磁场分析。

–形状优化 :
? 使用拓扑优化技术显示可能发生体积减小的区域。

C. ANSYS Workbench - Mechanical 简介 Training Manual
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? Mechanical Application
–自动仿真环境，并可以方便与 ANSYS 的求解器技术进行结合使用。
–以前称为 simulation 模块。

? Mechanical APDL Application
–用户界面环境，主要通过命令流、自定义和脚本语言实现。

–以前称为 ANSYS PREP7/POST1 接口。

⋯ 产品构造 Training Manual
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? Workbench 有两种启用方式 :
–从 Windows 开始菜单：

–从 CAD 系统：

D. 启动 Mechanical Training Manual



简介

1-7

?大多数的 Workbench 界面主要分为 2 部分，（一会儿还有其他可选的部
分）

工具栏 项目图表

E. Workbench 环境 Training Manual
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?工具栏包括四部分 :

? Analysis systems :可以直接在项目中
使用预先定义好的模板。

? Component systems :建立、扩展分析
系统的各种应用程序。

? Custom Systems : 应用于耦合 (FSI, 
热应力 ,等 )分析的预先定义好的模板。
用户也可以创建自己的预定义系统。

? Design Exploration : 参数管理和优化
工具

工具栏 Training Manual
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。

?显示在工具箱的 systems 和
components 取决于安装的产品

?用“View All / Customize ”窗
口的控制按钮 ,可以展开或闭合
显示在工具箱的项。

?左边的工具箱专用窗口不使用时
通常是关闭的。

. . . 工具栏 Training Manual
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? Workbench 项目示图区是定义一个 system 或一组 system 操作流程的
图示 法。

?项目示图区的操作总是从左到右。
? Workbench 有几个本地应用程序 , 即完全在 Workbench 窗口运行的 :
–Project Schematic, Engineering Data and Design Exploration

? 非本地应用程序 (叫做数据集成 ) 在各自的窗口运行 :
–Mechanical (formerly Simulation), Mechanical APDL (formerly

ANSYS), ANSYS Fluent, ANSYS CFX, Etc . . .
? 存储单元可以通过 RMB 菜单选择来删除 .

项目图表 Training Manual
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. . . 项目图表 Training Manual

?这是为项目图表所选择的静力结构分析的例子。

?工具栏中的选择项可以拖拉和投放在图表上，或者进行简单的双击。
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?在项目表中拖放应用组件和 /或系统到任意位置，一个完整的分析项目就定
义好了。

?“连接”表明系统之间的协作程度。
?下面的例子中，拖拉和投放结构分析流程到热分析的 A4 下。
?在完成操作之前，注意有不同的“投放目标”，以便在系统与系统之间提
供不同分析类型之间的联系（下一页继续）。
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. . . 项目图表 Training Manual

?完成前面的操作之后，请注意这里的联系只在 model 及以上的等级。
?这样就不存在热 /结构耦合。

? 注意每个系统板块是给了字母标号的 (A, B, C, 等 )。
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. . . 项目图表 Training Manual

? 在“Solution ”处投放结构系统，我们得到结构与热的耦合分析求解。

注意，可选的“投放
目标”表示数据将在
A2 至 A4 区共享，并在

A6 区转移。
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. . . 项目图表 Training Manual

?工作流程也可以由 RMB 建立，选择 “Transfer Data To New ”或者
“Transfer Data From New”.

?使用 RMB 建立系统流程图，仅显示可用的传递模块。
?根据模板中加亮部分的不同，显示的传递模块即不同。
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. . . 项目图表 Training Manual

?识别板块的状态 :

? 无法执行 :缺少数据。

? 需要注意：需要修正或更新板块。

? 需要刷新：上行数据发生了变化。需要刷新板块（更新也会刷新板块）。

? 需要更新：数据已更改，必须重新生成板块的输出。

? 数据确定。

? 输入变化：板块需要局部更新，但当下一个执行更新是由于上游的改变时
可能会发生变化。
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可选择的 Workbench 窗
口

Training Manual

? “View”菜单（ 和 RMB）允许的其他信息在 Workbench 环境中显示。
–下面，选择 Geometry 和属性显示。
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F. Workbench 文件管理 Training Manual

? Workbench 创建一个项目文件和一系列的子目录去管理所有相关文件。

?使用者应允许 Workbench 管理这些目录的内容。请不要手动修改项目目录
的内容或结构。

?当保存一个项目时，会创建项目文件（ .wbpj ），使用用户指定的文件名（例如 MyFile.wbpj ）。
?使用项目名创建一个项目目录。在上面的例子中，该目录应该为

MyFile_files 。
?子目录会在项目目录里被创建（下面解释）。
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. . . Workbench 文件管理 Training Manual

?目录结构 :
–dp n:这是设计点目录。这基本上是特定分析下的所有参 数状态。一个单独的分析
中，将只有一个“ dp0”目录。

–global: 包含每个分析中每个程序的子目录。比如，右侧 的“Mesh”目录将包含
数据库，和其他相关文件。

–SYS:““SYS”目录包含项目中每个系统类型的子目录
(e.g. Mechanical, Fluent, CFX, etc.) 。每个系统子目录
包含求解详细文件。例如 MECH 子目录包含结果文件
ds.dat 文件 , 和 solve.out 文件等。

–user_files: 包含和项目相关的输入文件和用户宏文件。
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?从 Workbench “View”菜单启动“ Files ”选项，会
出 现一个窗口，包含所有文件的详细信息和位置。
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. . . Workbench 文件管理 Training Manual

?存档：快速生成包含所有相关文件的压缩文件。

–文件是压缩格式，可以使用 WB2 或任何解压缩程序 打
开“Restore Archive . . . ”

–当存档系统窗口打开时，可有几种选择 。
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? Workbench 单位制 :
–允许访问预定义的单位系统。
–允许自定义单位的创建。

–控制显示工程数据，参数和图表的单位。
–激活单位系统对话框去控制。

Units can be displayed in 
the active Project system or 
as they were defined in their 

source (e.g. CAD system).

1-22
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. . .单位制 Training Manual

?复制现有的单位系统，以创建用户单位系统，然后修改。
?用户单位系统可以输出和输入。
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H. License 许可文
件

Training Manual

? Workbench 许可证管理也可通过如下所示的用户界面，从 Workbench 项
目 页面激活 (“Tools > License Preferences . . . “).
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? 可用许可显示，激活和 “use order ”可以使用向上 /向下箭头指定。
–0 = off, 1 = on
–许可文件的顺序代表授权许可使用的优先顺序。

? 当多个应用程序打开， Workbench 用户可指定一个 单独
的许可证，或所有打开的应用程序使用各自的许 可文件。

. . . License 许可文
件

Training Manual



简介

1-26

?如下图所示，一个用户可以有 3个同时打开的力学模型。使用许可管理可以
选择打开 3个或只使用 1个的共享。在共享的情况下，只有激活的分析使
用 许可文件（余下的将是只读）。

. . . License 许可文
件

Training Manual
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概述 Training Manual

? 在这一章中，将涉及 Mechanical 的基础应用，其中包括：
A. 启动 Mechanical
B. Mechanical 应用向导
C. 基本分析步骤

的能力，除了标记的。

D.  工程数据应用
E.  Workshop 2.1 – ANSYS Mechanical 基础

? 本章所描述的能力是 ANSYS DesignSpace Entra 普遍适用的许可和以
上
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A. 启动
Mechanical

Training Manual

?回想一下，有两个运行 Mechanical 的方式：
–在 ANSYS Workbench 上打开⋯

–⋯ 或者在 CAD 系统上打开
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?用户界面的组成如下图所示：

工具栏
菜单

图形窗口

树形大纲
Mechanical 应用向

导

详细列表 信息窗口

状态栏

⋯ Mechanical 界面 Training Manual
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?菜单提供很多 Mechanical 功能。比较常用的菜单项如下：
–标题栏列出分析类型、产品名和 ANSYS 许可。
–“File > Clean ”是删除网格划分和 /或结果产生的数据库。
–“Units ”可以改变单位 .
–“Tools > Options ⋯  ”可以自己设置和选择。
–“Help > Mechanical Help ”进入帮助。

分析类型 产品名 许可

. . . GUI –菜单 Training Manual
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?有一些工具栏为用户提供快速访问功能，在菜单中也可以找到。

–工具栏可以在 Mechanical 窗口的顶部的任何地方重新定位。
–“Context ” 工具条 , 其更新将决定于当前 “Outline ”  tree的分支。
–如果光标在工具栏按钮上，出现功能提示。

⋯ GUI –工具栏 Training Manual
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“ ” “ ”

? “Standard ”工具栏如下：

–鼠标左键可以是在 选择 模式或 图形操作 模式切换。上面的工具栏按钮
归类为“实体选择”和“图形操作”的控制两类。

–图形的选择可以做到用单个的选择或框选择。主要受“选择模式”图标控制。

? “Graphics ”工具栏用于选择几何和图形操作：

选择模式
选择工具 图形处理 可视窗口

建立 Mechanical Wizard 注解 注释

抓拍

模型求解 切割平面

⋯ GUI –工具栏 Training Manual
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?纲要树提供了一个简单的进行模型、材料、网格、载荷和求解管理的简单
的方法。
–“Model”分支包含分析中所需的输入数据。
– “Static Structural ”分支包含载荷和分析
有关边界条件。

–“Solution ”分支包含结果和求解信息。
–其他分支 (这不包括的 )也是可用的。

⋯ GUI –提纲树 Training Manual
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?纲要树显示每个分支的图标，以单表其状态。图标例子如下：

–对号表明分支完全定义 /OK
–问号表示项目数据不完全（需要输入完整的数据）
–闪电表明需要解决

–感叹号意味着存在问题
–“X”意思是项目抑制（不会被求解）
–透明对号为全体或部分隐藏
–绿色闪电表示项目目前正在评估

–减号意味着映射面网格划分失败

–斜线标记表明部分结构以进行网格划分
–红色闪电表示失败的解决方案

在熟悉基本的状态符号之前，允许使用者进行快速调试

⋯ GUI –提纲树 Training Manual
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? The Details View 包含数据输入和输出区域。内容的改变取决于选定的分
支
。

–白色区域 : 输入数据
? 白色文本区域下的数据在编辑。

–灰色 (红色 ) 区域 : 信息显示
? 在灰色领域的数据不能修改。

–黄色区域 : 不完整的输入信息
? 黄色领区域的数据显示信息丢失。

⋯ GUI –详细查看 Training Manual
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?图形窗口中显示几何和结果。还有列出工作表（表格）， HTML 报告，以及
打印预览选项的功能。

报告预览
工作表

打印预览图形

⋯ GUI –图形窗口 Training Manual
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?分析向导是一个可选组件，可提醒用户完成分析所
需要的步骤。

–分析向导提供了一个必要的步骤清单和它们的图
标符号。

–绿色对号表示该项目已完成
–绿色的“ i ”显示了一个信息项目
–灰色的符号表示该步骤无法执行

–一个红色的问号的意思是指一个不完整的项目
–一个“ X”是指该项目还没有完成
–闪电表示该项目准备解决或更新

?分析向导可以通过 按钮切换开启 /关闭。
?分析向导菜单上的选项将根据分析的类型而改变。

⋯ GUI – Mechanical 应用向导 Training Manual
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? 选择“Required Steps ”清单上的一个项目，则出现提示框，解释功能如何
实现。

在下面的例子，选中 “Verify Materials ”，并标注说明用户在什么地方可以改变
这个项目。

B. Mechanical 应用向
导

Training Manual
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? Mechanical 向导方便那些不熟悉
Mechanical 的用户。
–除了基本的功能，还有更多高级选项的 图标也显示在右
侧的图中。

⋯ Mechanical 应用向导 Training Manual
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?分析的目的是确定基于一些激励或加载类型系统下的响应。
?数学模型：
–CAD 几何模型是理想的物理模型
–网格模型是一个 CAD 模型的数学表达方式

CAD 模型 有限元网格划分模型

–计算求解的精度取决于各种因素：
? 如何很好的用物理模型代替取决于怎么假设。
? 数值精度是由网格密度决定。

C. 基本分析步骤 Training Manual
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预处理

?每个分析都分为四步：

–预处理
? 几何模型导入
? 定义和分配部件的材料特性
? 模型的网格划分

后处理

求解
? 施加负载和支撑
? 需要查看的结果

–求解模型
–后处理

? 检查结果
? 检查求解的合理性

–准备工作
? 什么类型的分析：静态，模态，等？
? 怎么构建模型：部分或整体？
? 什么单元：平面或实体机构？

准备工作

⋯ 基本步骤 Training Manual
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? Mechanical 中的向导帮助用户在以下的基础分析模块上进行预先讨论：
–附加 /输入几何体
–选择材料特性
–(划分网格 )

?  如果这一部没有执行手动操作， Mechanical 将会执行默认的网格划分。

–施加载荷和支撑

–需要查看的结果

?接下来的几个例题会使用到 Mechanical 向导⋯

–求解计算
–检查结果 /后处理

⋯ 基本分析步骤 Training Manual
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? 选择“ Verify Materials ”并用插图显示在下拉菜单中怎样附加 /输入材料属性（工程
数据会在这章的后面提及） 。在选择“Verify Mate rials ”之
后，所有 “Geometry” 分支
的部分突出，并且 Details 
view 显示可选的材料。

⋯ 向导例题 :附加 /输入几何体 Training Manual
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?弹出的窗口消息表明，用户应该回到 Workbench 接口来访问工程数据

– 上图显示的 Mechanical 材料仅供演示。用户可以修改材料属性值。

–默认的材料是 “Structural Steel ” ，但可以改变。
–作为加到项目中的材料，将会出现在材料分配详情区域。

⋯ 向导例题 :选择材料特性 Training Manual
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?在指定和确认材料后， 从 Stress Wizard 中选择“ Insert Structural Loads”。
–荷载的应用是在 Context toolbar 的下拉菜单项中。

在选择“Insert Loads ”后 , 注
意 “Environment”分支是突
出的。

通过突出的 “Environment” 
分支,  改变 Context toolbar 
和 Details view 。

向导例子 : 插入荷载与支撑 Training Manual
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?载荷和支撑的施加有两种不同的方法：
–预先在图形窗口选择几何实体，然后从 Context Toolbar 选择荷载和支撑

–或者，从 Context Toolbar 中选择载荷和支撑，然后在图形窗口选择几何实体，最后在中
点击“Apply”。

添加载荷和支撑 Training Manual
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? 指定荷载类型之后，需要在 Details view 输入详细的数据。
–注意， Outline Tree 下的相关载荷分支的图标将会变成完成状态。

⋯ 施加荷载和支撑 Training Manual
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?结构载荷的施加方向：
? 若选择“ Components” , 键入 X, Y, 或 Z 向载荷
大小

? 若选择“ Vector ”,选择确定载荷方向的几何并 输入载荷幅
值

? 可以通过 “Tools > Options ⋯
> Mechanical: Miscellaneous
> Load Orientation Type”改变默认选项

–可以选择使用总体坐标系或用户自定义坐标
系

? 用户定义坐标系在后面讨论

⋯ 施加载荷和支撑 Training Manual
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? 几何可以用于控制载荷方向 ：
? 在 “Details ” 窗口 , 选择 “Define By: Vector ”。
? 可利用三种类型的几何：

–垂直于面或沿着圆柱面的轴向

–沿着直线或垂直于圆柱边

–两点定义的矢量 方向

? 点击 “Direction ”并选择用于定义方向的几何体。 在图形窗口切换箭头
的方向。

?  结束时按 “Apply ”。
? 输入载荷大小。

箭头按钮可以调整载荷的方向

⋯施加载荷和支撑 Training Manual
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–鼠标右键用来选择几何实体或控制曲线生成。

–用户可以选择几何项目（顶点，边，面，体）或操纵视图（旋转，平移，放大 / 
缩小，框放大）

–选择方式可以进行单个或框选：
? 单个选择方式，按住鼠标左键拖拉进行多选
? 在单个选择模式下，可以用按 Ctrl 键和鼠标左键来选择或不选多个实体

–在框选模式，从左向右拖动鼠标，选中完全在边界框的实体。
–在框选模式，由右至左拖动鼠标，选中部分在边界框选择部分的任何实体。

⋯ 鼠标控制 Training Manual
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? 在选择模式下鼠标中键提供了图形操作的捷径
–点击 + 拖拉鼠标的中键 = 动态旋转
–CTRL+ 鼠标的中键 = 拖动
–Shift + 鼠标的中键 =动态缩放
–滚动鼠标中键可以用来放大 /缩小
–RMB + 拖拉= 框放大
–点击一次鼠标右键，选择 “Fit ”，实现全窗口显示

⋯ 鼠标控制（捷径） Training Manual
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?选择平面允许用户方便地选择在其他表面看不到的表面。
–当用户选择面时，如果在指针下面隐藏更多的面，选择面板就会出现。选择面板的颜色 与
它所代表的面的颜色相同，同时指针所指的方向按厚度排列

⋯ 选择平面 Training Manual
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? The Engineering Data 的应用提供了对材料属性的全面控制。
–Engineering data 是每项工程分析的必须部分。
–Engineering data 可以单独打开 (作为分析项目的开始）。

要打开独立的 Engineering Data ，
添 加工具箱中的组件系统（拖 /放或

双击
），然后 RMB>“ 编辑或双击。

要在项目 RMB 中编辑
Engineering Data>“编辑

或双击

D. Engineering Data Training Manual
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. . . Engineering Data Training Manual

? Engineering Data 的应用程序显示如下。

总过滤器 选定以下材料属性

工具栏

过滤材料列表

选定材料的性能 属性表



30-2

Basics

. . . Engineering Data Training Manual

?窗口交互显示层叠数据。
?查看或修改材料属性的一般工作流程如下所示： 材料
数据库 > 选择材料 > 材料属性

以表格和图形格式 显示属

性

选择数据库

选择材料

选择属性



2-31

Basics

. . . Engineering Data Training Manual

Engineering Data 区包含已在当前项目中使
用
的材料清单。

复选框允许对资料库编
辑锁定。

显示现有材料库的清单。这些是
ANSYS 软件提供的或用户定义

Favorites 是每个项目都有的，无需由资料
库

浏览现有的材料库，或

总过滤器

输出的材料 。
选择材料库的位置。
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. . . Engineering Data Training Manual

?工具箱提供了大量的材料属性，可以添加现有的或新材料的定义。
?要修改材料现有的材料库必须要解锁，（注意这是永久修改，材料存储 在
该资料库）。

?当前项目中的工程数据资料可以被修改，而不会影响材料库。

The Toolbox Customization 设置允许 对工具栏上显示的材料属性进
行过滤。
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. . . Engineering Data Training Manual

?若要在当前项目现有的资料库中增加一种 材料，单击材料旁边的加号
（+）。

?在当前项目中定义的任何材料将被标记， 如右侧所
示。

?如果 “added” 每一种材料将可以应用在 现有的项
目上 (他变成现有 “Engineering Data”的一部分 )。

注意，添加材料到
“Favorites ”列表
中， RMB 材料和
添 加。
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. . . Engineering Data Training Manual

?要创建新的材料首先选择材料
库的存储路径（或当前项目的
工程数据）。

?输入一个名称，对新材料进行
说明。

?从工具箱中双击或拖放所需的
属性。

?最后输入属性的值。
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. . . Engineering Data Training Manual

? Engineering Data 的单位制 :
–您可以选择显示 “Values as Defined ” or “Values

in Project Units ”.
–“AsDefined ”单位是单独约束的。

“Project Units ”采用通用的单 位
菜单选项。
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Basics

E. Workshop 2-1 – Mechanical Basics Training Manual

? Workshop 2.1 – Mechanical 基础
?目标 :
–应用 Stress Wizard, 建立模型，并求解结构模型的应力，位移和安全 系
数。



Workbench - Mechanical 
Introduction

作业 2.1

ANSYS Mechanical 基础

WS2.1-1 



WS2.1: Basics

对作业 2.1 的提
示

作业 Supplement

?第一个作业包含了大量的信息，练习时，可以更加的熟悉基本的
Workbench Mechanical 功能（菜单位置等），因此后续的作业就包含了
较少的细节描述。

?整个作业的菜单路径将被记录如下： “First pick > Second pick > etc. ”.
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作业 2.1 –目标 作业 Supplement

?使用 Stress Wizard ，建立求解结构模型的应 力、变形和安全因
子。

?问题描述：
–模型是由 Parasolid 文件得到的一个控制箱盖子
（如图所示）。盖子假设是在一个外压下使用
（1 Mpa/145 psi ） 。

–盖子是由铝合金制成的。

–我们的目标是确定这个部件能在假设的环境下
使用。
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作业 2.1 –假设 作业 Supplement

?在深孔施加约束 ,接合面及内表面使用无摩 擦支撑约
束.
–无摩擦支撑约束是一种施加在整个面的法
线方向上的约束 .除了支撑面的正、负法线
方向 , 该约束允许其余各方向的平移 . 这是
一种保守的方法 .
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作业 2.1 - 环境 作业 Supplement

? 载荷 : 载荷为 1MPa 的压力，作用在外壳的 17 个外表面上 .
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作业 2.1 – Project Schematic 作业 Supplement

?打开 Project page （项目页）
?在 Units 菜单中确定：
–Project 单位设为 US Customary (lbm, in, s, F, A, lbf, V).
–选择“ Display Values in Project Units ”
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. . . 作业 2.1 – Project Schematic 作业 Supplement

1. 在 Toolbox 中建立一个 Static 
Structural 系统 （通过拖放或点
击鼠标右键选择）

2. 在 Geometry 子模块上点击鼠标
右键选择 Import Geometry ，
选 择导入 “Cap_fillets.x_t ”文
件
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作业 2.1 - 前处理 作业 Supplement

3. 双击 Model 打开 Mechanical application.
4. 当 Mechanical application 打开模型时，会在图
形 窗口中显示出来，而 Mechanical Application
Wizard 会显示在右侧。

当 Mechanical 开始
时而 Wizard 没有显
示，则通过图标打开
它。
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作业 2.1 - 前处理 作业 Supplement

5. 设置单位系统：
? 在主菜单中选择 Units > Metric (mm, kg, N, s, mV, 

mA).
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. . . 作业 2.1 - 前处理 作业 Supplement

6. 为部件选择一个合适的材料：
a. 在 Mechanical Wizard 选择“ Verify Material ”
b. 请注意标注框中显示的 Engineering Data （工程数据），是从

WB2 中得到的（ Project Schematic ）。

c. 返回到 Project schematic 窗口并双击 “Engineering Data”得
到它的材料特性
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. . . 作业 2.1 - 前处理 作业 Supplement

9. 刷新 Model cell （点击鼠标右键选
择）然后返回到 Mechanical 窗口
。

7. 在 General Materials 点亮的同时点
击 “Aluminum Allow ”旁边的 ‘+’将
这个材料添加到当前项目。

8. 返回到 Project （项
目）

? 请注意 Model 模块指出需要进行一
次
刷新。
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. . . 作业 2.1 - 前处理 作业 Supplement

10. 点亮“ Part 1”并选择 “Material >
Assignment ” 栏来改变铝合金的材
料特性。
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. . . 作业 2.1 - 前处理 作业 Supplement

11. 插入载荷：
a. 在 Wizard 中选择“ Insert Structural Loads”
b. 按照提示框来插入一个 “Pressure ”（压力载荷）
c. 在“Static Structural ”中将出现一个 Pressure 选项

a.
c.

b.
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. . . 作业 2.1 - 前处理 作业 Supplement

12. 施加载荷到几何模型上：
a) 选择部件的一个外表面
b) 通过 Extend to Limits 图表选择余下的 16 个表面（共选择了 17 个面）
c) 点击 “Apply ”
d) 在 “Magnitude ”中输入 1MPa.

b.

a.
c.

d. 
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. . . 作业 2.1 - 前处理 作业 Supplement

13. 给部件施加约束：
a. 在 Wizard 中选择 “ InsertSupports ”
b. 按照提示框插入一个 “Frictionless Support ” . 
c. 将其施加到组件的 4个反孔表面上

b.

c.

a.
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. . . 作业 2.1 - 前处理 作业 Supplement

14. 重复步骤 13.a 和 13.b ，将“Frictionless
Support ”（无摩擦约束）施加到底部隐窝的内
表面上（在选择了其中一个内表面后使用
extend to limits 选择其它面 ）。

15. 重复步骤 13.a 和 13.b ，将“Frictionless
Support ”（无摩擦约束）施加到底部凹进去的
刃面上。
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. . . 作业 2.1 - 前处理 作业 Supplement

“

注意 Stress Tool detail 允许 4个不同的配置 （后面解释）。 本作业我们定义为

Max Equivalent Stress ” theory （最大等效应力理论） .

16. 在 Mechanical Wizard 中要求：
a) 插入 Structural Results （结构结果）（提示使
用 Solution toolbar ）

b) Deformation > Total.
c) Stress > Equivalent (von-Mises).
d) Tools > Stress Tool.

b. c. d.

a.
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作业 2.1 –求解 作业 Supplement

17. 求解模型：
a. 在 Wizard 中选择“Solve ”
b. 按照提示点击 “Solve ”.

? 注意在 Wizard 中不管怎样点击 Solve ”也不会自动启动求解模型，而是
给出一个“solve ”图标。相反，应该通过“outline ”的任何分支上点击右
键选择“ solve ”

b.

a.
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作业 2.1 –结果 作业 Supplement

18. 查看结果：
a. 在 Wizard 中点击 “View Results ”
b. 按照提示框，结果在 “Solution ”分支中可用

b.

a.
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. . . 作业 2.1 - 结果 作业 Supplement

? 绘制模型的变形图，常在 structural analysis （结构分析中）提供了真实变
形结果显示。检查变形的一般特性（方向和大小）可以避免建模步骤中的
明显错误。常常使用动态显示。
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. . . 作业 2.1 - 结果 作业 Supplement

?在查看了应力结果后，展开 safety tool 并绘制安全因子（ safety 
factor ） 图。注意所选失效准则给出的最小安全因子刚刚超过 1。
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作业 2.1 - 报告 作业 Supplement

19. 创建一个 HTML 报告：

a.

a.

b.
c.

首先选择需要放在报告中的绘图项，通过选择
对应的分支和绘图方式实现（这是你的选择）

接着，从 toolbar 中插入一个 “Figure ”
点击“Report Preview ”生成报告

b. 

c.
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. . . 作业 2.1 –报告 作业 Supplement

Figures 简介：

? Figures 并不局限于结果。例如，添加一个 environment （环境分支）的
图 形，在报告中将包括模型的边界约束 。

? Figures 是独立的。你可以建立独立的图形，并可以查看它们的方向、放大
程度等，而不用考虑实际模型的方向或其它图形。

?独立的分支可以包含多个 Figures （图形）。



Workbench - Mechanical 
Introduction

第三章前

处理

3-1 





General Preprocessing

3-2

简介 Training Manual

? 在这一章，将会涵盖不使用 Wizards 的使用特征：
? 内容 :

A. 几何
B. 接触

G. 作业 3-2, “网格控制”

? 这一章介绍的功能会应用在 ANSYS DesignSpace Entra 和更高级的产
品 的许可中。

C.  作业 3-1, “接触控制”
D.  网格划分
E.  命名选择
F.  坐标系
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简介 Training Manual

?上一章，通过使用 Mechanical Wizards 介绍 Mechanical GUI 。
? 本章介绍不使用 Wizards 的 GUI 操作。



General Preprocessing

3-4

? The Outline Tree 是进行分析的基本步骤
–The Context Toolbar, Details View, 和 Graphics Window 的更新 , 都是靠

Outline Tree 的分支进行选择。
–本章将会重点使用 Outline Tree 。

使用Outline Tree 意味着用
户导航会通过 Simulation 
GUI.

⋯ 简介 Training Manual
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? Geometry 分支列出了模型的组成部分。
?在模拟过程中，有三种类型的实体会被分析
到：
–实体一般是 3D 或 2D 体/面/部件
–只由面组成 的面体
–只由线组成的线体
–后面将一一进行讲解

A. 几何分支 Training Manual
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? 实体一般为 3D 或 2D:
– 3D 实体是由带有二次状态方程的高阶四面体或六面体实体单元进行网格划分的。
– 2D 实体是由带有二次状态方程的高阶三角形或四边形实体单元进行网格划分的。

? “2D”开关设置在 Project 页输入。
?  几何导入后，不能将几何类型由 2D 变成 3D 。

– 结构的每个节点含有三个平动自由度（ DOF）或对热场有一个温度自由度。

三维实体 二维实体
轴对称横截面

⋯ 体的类型 Training Manual
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General Preprocessing

⋯体的类型 Training Manual

? 面体素 是指几何上为 2D，空间上为 3D 的体素：
–面体为有一层薄膜（有厚度）的结构，厚度作为输入值提供。

– 面体由带有 6 个自由度 (UX, UY, UZ, ROTX, ROTY, ROTZ) 的线性壳单元进行网格划分
。

? 线体素 是指几何上为一维空间上为三维的结构：

–是用来描述与长度方向相比较其他两个方向的尺寸很小的结构，截面的形状不会显示出
来。 。

–线体由带有个 6 个自由度 (UX, UY, UZ, ROTX, ROTY, ROTZ) 的线性梁单元行网格划分
。

3-7

表面体
线体
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⋯ 多体部件 Training Manual

?在很多应用程序中，体素（ bodies ） 和 部件（ parts ） 是一样的。但在 DM 中可以有多
体部件存在。

相邻体上共用节
点

? 多体部件中共用边界的地方，在公共界面上的节点是共用的。
? 如果节点是共享的，在这种情况下是不需要定义接触的。

?例子 :
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”

⋯ 材料属性 Training Manual?为体添加材料属性，从目录树中选取体，然后在
下拉菜单中选取 “Material ”
–新的材料数据可以在“ Engineering Data  下添加
和输入。然后新的材料就可以从下拉菜单中得到
。

–对于 surface bodies ，如上所讲，定义一个厚度
是必要的。
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?提供体素和已经定义的材料的总表
–选择 “Geometry ”分支和 “Worksheet ”

⋯ 几何体表格 Training Manual
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? 存在多个部件时 ，需要确定部分之间的相互关系。
–接触区域定义部件是如何相互作用的。

?若不进行接触或点焊设置，部件将不会相互影响：
–在结构分析，接触和点焊防止部件防止部件的相互渗透，同时也提供了部件之间荷载传递
的方法。

– 在热分析，接触和点焊允许部件之间的热传递。

–多体部件不需要接触或点焊。

表面接触单元可以看作是“皮肤”，它覆盖的地区将发生接触。

载荷
A B

B. 接触 Training Manual
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General Preprocessing

⋯ 实体接触 Training Manual

?输入装配体，自动检测接触面并生成接触
对:

–临近面用于检测接触状态。接触探测公差在
“Connections ”分支细节可以看到。

?接触也是使用的二维几何体。接触“面” 
是指的边界。

?某些许可允许表面到边缘，边缘到边缘和
混合体 /面接触。

?请注意，需要在进行分析之前检查自动
生
成的接触对。
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General Preprocessing

⋯ 实体接触 Training Manual

–接触单元提供部件间的连接关系。

–每个部分维持独立的网格。这意味着，小体和大体没必要保持一致的网格精度。

注意在不部件接口处不匹
配的网格 。 四面体单元
和六面体单元 组合是可
能的。
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General Preprocessing

⋯ 实体接触 Training Manual

Contact ”分支的 Detail view 中可以关掉透明显示

?在“ contact ”分支点击某个接触对，构成这个接触对的部件就会变成透明的，以 便
观察。

–选取一个接触对，与该接触对无关的部件变成透明的。
–透明度可以通过 “Tools > Options ⋯  > Simulation:Contact: Transparency ”控制 .
在“
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General Preprocessing

⋯ 实体接触 Training Manual

? “Go To” 的作用是允许接触定义时有更多的细节描述 ：
– corresponding bodies in tree
– Bodies without contact
– Contact regions for selected bodies
– Contacts common to selected bodies

–接触可以基于部件名称进行快速的重命名。

RMB
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General Preprocessing

⋯ 实体接触 Training Manual

? 选择“contact ” 和“ target ”面手动定义接触对。
点击鼠标右键选择
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General Preprocessing

⋯ 高级实体接触 Training Manual

? 对 ANSYS Professional 许可和以上，高级接触操作是可行的：
–自动检测尺寸和滑动

–不对称接触

–接触结果工具

–更多接触可用公式

– Pinball 控制
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General Preprocessing

⋯ 高级实体接触 Training Manual

? Pinball 区域表示接触探测区域：
– 当接触间隙在 pinball 半径内时进行接触计算 /检测。
– 可输入 Pinball 半径尺寸，以确保粘性接触是一个大间隙或裂口问题成立。
– Pinball 半径以球形显示在图形窗口中。
–四种接触状态：近场，远场，关闭 /滑动，关闭 /粘着。
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?壳接触，包括线与面或线与线接触：
–壳接触的默认项是关闭的。

–用户可以打开面与线或线与线接触 。

–设置优先级防止在给定设置优先级的区域的生成多个 接触区
域。

⋯ 表面体接触 Training Manual
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General Preprocessing

?点焊连接提供了离散点接触组装的方法：
–点焊是在 CAD 软件中定义的。目前，只有在 Mechanical 支持的 DesignModeler 和

Unigraphics 中可以定义点焊。

点焊对

⋯点焊 Training Manual
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? “Connections ”分支中的 “Worksheet”表列出了定义的所有接触和点焊 。

⋯ 接触表 Training Manual
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General Preprocessing

? Workshop 3.1 –接触控制
?目标 :
–研究多种接触的行为。

C. Workshop 3.1 – Contact Control Training Manual
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General Preprocessing

“ ”

?节点和单元是几何模型网格划分的组成：
–在求解开始时自动生成默认网格。
–用户可以在 生成 网格之前，去检查网格控制设置。
–较细的网格产生更精确的解，但也会增加 CPU 时间以及对内存要求。

D. 网格划分 Training Manual
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⋯ 整体网格划分控制 Training Manual

?基于物理场的网格划分允许用户指定物理场，选择如下
的场类型控制选项：
–实体单元中间节点
–单元形状检查
–类型转换

?物理场包括 :
–结构
–电磁

–流体

–显示

?物理场设置将预先配置高级网格缺省设置，这些将在随
后讲述

?注意：本章只论述结构网格。
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General Preprocessing

⋯整体网格划分控制 Training Manual

? 基本网格划分控制在 “Mesh” 分支下的“Defaults ”中是可用的。
–用户控制单个网格大小的选项

3-25

? “Relevance”设置在 –100 与 +100 之
间

- Relevance = 粗划分 + Relevance = 细划分



General Preprocessing

⋯整体网格划分控制 Training Manual

?高级全局控制：
–Relevance Center ：设置关联性滑块点
–Element Size ：为整个模型定义单元大小 。

–Shape Checking ：
? Standard Mechanical –适用于线性应力，线性模
型和线性热分析

? Aggressive Mechanical –适用于大变形和材料非
线性

? Solid Element Midside Nodes ：

3-26

–Program Controlled （程序控制）（默认选项）
、Dropped （ 退化形式）或 Kept （原有形式）

单元
A

单元
B

原有形式 退化形式



General Preprocessing

⋯整体网格划分控制 Training Manual

3-27

? Straight Sided Elements ：
–当模型中存在实体或存在由 DesignModeler 得到 的场体时进行显示。电磁分析
时必须使用。

? Initial Size seed ：
–控制着每个部件网格的初始大小。（更多细节参 见下一
页）

? Smoothing ：
–尝试通过移动节点位置来提高单元质量。可设置 平滑迭代次数（低、
中、高）。

? Transition ：
–控制单元增长速率（平缓、快速）。



General Preprocessing

⋯整体网格划分控制 Training Manual
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? Initial Size Seed （初始种子大小）：
–Active Assembly （默认） :

? 初始网格大小将由激活的部件（未抑制的）决定。
–Full Assembly （整个组件）：

? 初始网格大小不会受部件的状态（抑制或活动）的影响。
–Parts （部件）：

?初始种子独立地建立在每个部件大小基础上，且网格不会因为部件受抑制而改变。一般给与一个
细化的网格。

基于部件网格种子划分得到
的节点数： 44,013
（网格划分建立在部件种子
的基础上，因此部件间不太
统一。）

基于组件的网格种子划分得到的节
点数： 15,670
（部件间的网格划分更统一）
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General Preprocessing

⋯局部网格划分控制 Training Manual

? 局部的 Mesh Controls （网格控制）可以应用于选择的几何模型或一个命名的选择
集。只有选中了 Mesh，这些功能才可行。可行的控制包括：

–Mapped Face Meshing （面映射网格划分（不包括 EMAG 和循环））

– Inflation Control （膨胀控制）

–Pinch Control （修剪控制）

–Gap Tool （只不包括 EMAG ）

– Method Contro （方法控制）
– Sizing Control （大小控制）

– Contact Sizing Control （接触大小控制）

– Refinement Control （加密控制）
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Method Control ：为用户提供了如何划分实体模型的 选项：只能适用于
实体。

? Automatic （默认选项）：
–若可以的话，物体将被扫掠划分网格。否则，将使用

Tetrahedrons 下的 Patch Conforming 网格划分器。

?接下来⋯⋯
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Tetrahedrons ：
–完全进行四面体网格划分。

? Patch Conforming ：
–Expansion Factor （扩展因子） 控制着四面体单
元的内在增长速率。

? Patch Independent 网格划分：
–在进行网格划分时，可能忽略面以及它的边界。

–只有当面上施加了边界条件时，它的边界是不能忽 略
的。

–参见下一页 Patch Independent 选项
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Patch Independent 选项：
–Maximum Element Size ： 初始单元划分的大小

–Approx Number of Elements ：模型中期望的单元数目（可以被其它网格划分
控制覆盖）

–Define defeaturing Tolerance –根据大小和角度过滤掉几何边。如果设为 Yes
，会出现一个 Defeaturing Tolerance 栏，可以输入一个数值。

? 提示： defeaturing 可以使网格划分忽略掉 small features ，而跳过它们进行网格
划 分。 Simulation （模拟）文件夹包含有完整的描述和示例。

?接下来⋯⋯
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Curvature and Proximity Refinement 设为 Yes：
–Define by ：最大单元大小或单元数目近似值

–Defeaturing Tolerance （若为 yes ）：为 defeature 边添加误差控制。

–Curvature and Proximity ：基于 features 的曲率和近似，自动加密网格 。

–Num Cells across Gap –指定在狭窄空隙中的单元数目。加密受限于 Min Size Limit
。

–Span Angle –网格将在弯曲区域进行划分，直到每个单元都在指定角度跨度内。受限
于 Min Size Limit.
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Hex Dominant ： 主要使用六面体进行自由网格划分
。对不能进行扫掠划分的实体模型划分网格很有用。
（只能在 ANSYS Structural 或更高版本中使用）

? hex-dominant 网格划分的算法，是先主要使用四边
形生成一个面网格，然后根据需要填充锥体和四面体
单元。

? 如果实体可能不适合进行 hex-dominant 网格划分，将提醒
用户 。

采用 Hex-Dominated 网格划分的实体
模 型：

Tetrahedrons （四面体） – 443 (9%)

Hexahedron （六面体） – 2801(62%)

Wedge（楔形体） – 124 (2%)

Pyramid （锥体） – 1107 (24%)
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General Preprocessing

⋯局部网格划分控制 : 方法 (继续 ) Training Manual

? Sweep （扫掠划分）：
–扫掠划分单元（六面体，也可能是楔形体），否则就是四面体。

? Automatic （自动选择） , manual source （手动选择源面）或 manual source and target
（手动选择源面和目标面）

? Automatic Thin Model （自动指定厚度模型） –在厚度方向上就一个六面体或楔形体单元
。可以在实体壳单元（ SOLSH190 ）和实体单元（ Solid185 ）之间选择。

?  Manual Thin Model （手动指定厚度模型） –允许选择一个源面

中间的实体采用的是扫掠划分
，而其它实体是四面体单元划
分。

–在 mesh 上点击鼠标右键选择 Show Sweepable Bodies 。
– Type ：扫掠方向上的划分数目或单元大小。
– Sweep Bias Type ： 扫掠方向上的间隔比例

– Src/Trg Selection ：
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General Preprocessing

⋯局部网格划分控制 Training Manual

? Sizing ：
–“Element Size ”指定平均单元长度或划分数目（ 选择依赖于
几何模型选集）

–“Soft ”控制可以被其它网格控制覆盖，而 “Hard”控制
不会。

–可以进行网格偏置划分。

–上面可行的选项依赖于选定的实体：

? Sphere of Influence sizing, 参见下一页。

Entity Eleme n t Size # of Elem. Division Sphere of Influe nce
Bodies x x
Faces x x
Edges x x x
Vertices x

在一个部件上使用了 Face 
Sizing
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General Preprocessing

⋯局部网格划分控制 Training Manual

“

? Sphere of Influence:
–使用局部坐标系确定中心。

–球体内的所有关注的实体都会受到网格大小设置的影响。关注于一个点
Sphere of Influence ” (红

色显示 ) 已经定义。球体内所
关注实体的单元大小是给定的
平均单元大小。

关注于两个面
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General Preprocessing

⋯局部网格划分控制 Training Manual

” ”

? Contact Sizing ：对于面面接触或面边接触区域，在接触面上生 成相同大小的单
元。
–可以指定“ Element Size 或 “Relevance
–选择 Mesh Control 菜单下的 Contact Sizing 来指定接触区域

–或把 Contact Region Objects （接触域对象）拖放到
Mesh Objects （网格划分对象）中。

本例中，两个部件间的接触域指
定了Contact Sizing Type 中的
Relevance （相关性）。注意现
在的网格在接触域里是一致的。

3-38
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⋯局部网格划分控制 Training Manual

3-39

? Element refinement 细化已经存在的网格
–首先用 global and local size controls （整体和局部网格大小控制）创建一个初始网
格， 然后在指定位置应用 element refinement （单元加密） 。

–加密系数范围是 1~3（最小到最大）。加密控制把初始网格的单元边分割为两半。加密水
平控制加密迭代的次数。

图示例子中，左边的加密水平为 2， 而右边是默
认的网格设置。
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⋯局部网格划分控制 Training Manual
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?面映射网格划分：在面上生成规则的网格：
–下面例子中，外表面的面映射网格划分得到了更均匀的网格。

–如果某种原因下不能进行映射划分，网格划分仍将继续，但是会在
Outline Tree 中以图标的形式显示出来：

?对于面实体，三角形映射划分和四边形映射划分都可行。



General Preprocessing

⋯局部网格划分控制 Training Manual
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? Inflation Control ： 对沿指定边界添加多层单元有用。

提示： Inflation 更常用在 CFD 和 EMAG 中，但可能对结构应用中的应力集中等
也有帮助。
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⋯局部网格划分控制 Training Manual
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? Pinch ：允许删除小线和点以去除 小的特征
–Master: 保留原有几何配置的几何模型
–Slave ：向 master 改变对齐的几何模型
–可以是自动的（网格划分时）或局部的（添加 Pinch 分支）
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⋯ 网格划分失败 Training Manual

?如果不能得到很好形状的单元，会出来一个错误信息：

–在屏幕中，选中 problematic geometry ，然后会生成一个名为 Problematic Geometry
的选择集，这样用户可以检查模型。
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General Preprocessing

⋯网格划分失败 Training Manual

?网格划分失败的原因有很多：
–在面上指定了不一致的大小控制，会导致形状很差的单元出现。
–非常复杂的 CAD 几何模型，如小长条或扭曲的面。
–严格的网格形状检查（在 Mesh 中的 Aggressive 设置）。

?一些避免网格划分失败的方法：
–给几何模型指定可行的网格大小。
–指定小一点的网格大小，让网格划分得到形状较好的单元。

–在 CAD 系统中，使用消除隐藏线图形查看，来搜索并删除长条状的或不想要的
几何。

–使用虚拟子块来组合细长条的或非常小的面。
–后面讨论这个选项
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“ “

? Virtual Topology ： 为进行网格控制组合面和边：

–把 Virtual Topology ”添加到 Model”上。
–一个“ Virtual Cell ”（虚拟子块）就是把一组相邻的面作为 一个单独的面来发
挥作用。

– 在网格划分过程中，原始面内部的线会被永远忽略掉。

–对于其它操作，如施加载荷和约束，一个虚拟子块可以被认 为是一个单个的
实体。

–虚拟子块可以通过点击鼠标右键选择自动生成：
? “Behavior ” 控制着自动执行 Merge Face Edges 的程度。

? 示例 . . .

⋯ Virtual Topology Training Manual
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?考虑下面的例子：

⋯ Virtual Topology 例子 Training Manual

虚拟子块
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?记住拓扑可以改变！
–示例： : 在这个虚拟子块的上表面上添加了一个斜面，就不能再识别内部的线。初始网格

单元的边用实线表示而原来的斜面和顶
面都显示为蓝色虚线 .

不再存在斜面

使用虚拟拓
扑网格划分

⋯ Virtual Topology 例子 Training Manual



3-48

General Preprocessing

?命名选择集工具栏为组合几何实体提供了很好的功能：

? 等
–提示， visibility 和 suppression 只能应用在实体命名选择集。

操作 显示 /隐藏 抑制 /激活

创建 定义名称

–命名选择集允许把点，边，面或实体组合在一起。
–它可用于网格加密控制，施加载荷和约束等。

–为需要经常选择的几何集提供了一个简便方法
? 定义接触域
? 指定结果

E. 命名选择集 Training Manual
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?创建命名选择集：
– 选择感兴趣的点、边、面或实体，然后点击 Selection Group
图标

–在对话框中输入一个名称

–新的命名集将出现在 Named Selection Toolbar （命名选
择 集工具栏）和 Outline Tree （大纲树）下。

? 提示：
– 在一个指定的命名选择集里只允许出现一种实体类型。例如，在相同
的命名集里就不能同时出现点和边。

– 命名选择集可以通过 CAD 系统导入（见第十章）。

⋯ 定义命名选择集 Training Manual
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?在很多细节窗口中可以直接引用命名选择集：
? 示例（压载荷） ：
–在 Details of Pressure 中，把 Method 由 Geometry Selection 换成 Named Selection
–从下拉菜单中选择 Named Selection

? 模拟时会过滤掉不能使用的命名选择集类型

⋯ 使用命名选择集 Training Manual
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?在点中了 geometry 的时候，命名选择集还可以用在其它情况：
–选择细节窗口中的 Geometry ，进入采集模式

–切换到命名选择集工具栏

–选择可使用的选项：

? “Select Items in Group ” , “Add to Current Selection ” , “Remove from CurrentSelection ”

2

3

1

–然后点击细节窗口中的 Apply

⋯使用命名选择集 Training Manual
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? Coordinate Systems 通常默认的是不显示，但是可以在 Model 下进行添加
得 到。

–Coordinate systems 可用于网格控制、质量点、指定方向的载荷和结果。
? 基于 CAD 原始模型，开始就添加了 Global Coordinate

System （整体坐标系）。
? 可以从 CAD 系统中导入 Local Coordinate Systems （局部坐标系）
（参见 Simulation （模拟）文件夹）

F. 坐标系 Training Manual
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? 坐标系可以通过点击 环境工具栏上的 Coordinate System
图 标

?可以是直角坐标或柱坐标
?在定义了坐标系以后，就会出现响应的工具栏。

?可以通过下面任意一种方式定义局部坐标系：
–选择几何（结合坐标系 Associative Coordinate System ）。
坐 标系会移动到几何上，它的平移和旋转都依赖于几何模型。

–指定坐标（没有结合坐标系 Non-Associative Coordinate 
System ）。坐标系将保持原有的定义：它独立于几何模型 .

删除平移 选装 调换 Move Up/Down 

⋯ 坐标系 Training Manual
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? 在各种应用中的细节窗口的下拉菜单中都可以使用坐标系（见下面例子）：

指定方向位移

指定方向载荷

Sizing w/ Sphere of 
Influence Option

质量点
指定方向结果

⋯ 坐标系 Training Manual
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?作业 3.2 –网格控制
?目标 :
–使用不同的网格控制，加强对螺线管模型网格 划
分。

G. Workshop 3.2 – Mesh Control Training Manual



3-56

General Preprocessing

Workbench - Mechanical 
Introduction

作业 3.1

接触控制

WS3.1-1 





WS3.1: Contact Control

WS3.1-2

作业 3.1 –目标 Workshop Supplement

? 作业 3.1 调查了一个简单组件的接触行为。 目的是为了说明由于不适当接
触 导致的刚体运动是怎么产生的。

?问题描述：
–模型从一个简单 Parasolid 组件文件获得

–我们的目标是在组件的各部件中建立接触，查看非对称加载对结果有何影响



WS3.1: Contact Control

作业 3.1 –假设 Workshop Supplement

?假设 arm shaft 和 side plate 上的孔间的摩擦忽略不计，同样 arm shaft 
和 stop shaft 之间的接触也忽略不计。最后假设 stop shaft 固定在两个
side plate 之间。

WS3.1-3

Arm Shaft

Side Plate

Side Plate

Stop Shaft
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WS3.1-4

作业 3.1 – Project Schematic Workshop Supplement

?打开 Project page （项目页）
?通过 “Units ”菜单确定：
–Project 单位设置为 “US Customary (lbm, in, s, F, A, lbf,  V).
–选择“ Display Values in Project Units ”



WS3.1: Contact Control

WS3.1-5

. . .作业 3.1 – Project Schematic Workshop Supplement

1. 在 Toolbox （工具箱）中双击
Static Structural 建立新的分析
系 统

1.

2. 在 Geometry 上点击鼠标右键选
择 Import Geometry 导入
Contact_Arm.x_t 文件

2.



WS3.1: Contact Control

WS3.1-6

3. 双击 Model 打开 Mechanical application.

4. 设置作业单位制系统：
– Units > U.S Customary (in, lbm, lbf, °F, s, V, A) 4.

作业 3.1 –前处理 Workshop Supplement

3.
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. . .作业 3.1 –前处理 Workshop Supplement

5. 在 Connections 上点击鼠标右键选
择
Rename Based on Definition

5.
? 在各个部件彼此之间都定义了接触。
注意还显示了接触的类型（如
bonded 等 ）
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6. 在前面假设的基础上改变其中 3个接
触区域为 “NoSeparation ”：
a. 使用 CTRL 关键字来选择所示的 3 个
接 触区域

b. 在细节描述里改变类型为 No
Separation
? 每个接触区域也可以分别修改，不过一
下选择其中 3个节省了时间

. . .作业 3.1 –前处理 Workshop Supplement

a.

b.
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7. 固定组件（选择 Static Structural ”
branch (A5) ）：
a. 选择 Side Plates 的两个端面

b. RMB（点击鼠标右键） > Insert > 
Fixed Support.

b.

作业 3.1 –环境 Workshop Supplement

a.
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c.

d.

8. 在 ArmShaft 上施加一个集中力：
a. 选择 ArmShaft 的上表面
b. RMB（点击鼠标右键选择） > Insert > Force.
c. 在 detail of force 里选择
Component d. 设置如下：

a.

? Y component = - 10 lbf (minus 10)
? Z component =  +1

b.

. . .作业 3.1 –环境 Workshop Supplement
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9. 选择 Solution branch (A6) 并 RMB
（点击鼠标右键选择） > Insert >
Deformation > Total.

10. Solve （求解）（你会看到模型可能 没有约束的
警告信息）
– 选择 “Total Deformation ”查看结果

– 尽管轻微，但我们可以发现
ArmShaft 开始向一边移动。目前的设
置还没有 接触或边界条件来阻止移
动。如果载 荷值足够大，求解就会失
败。

作业 3.1 –初始求解 Workshop Supplement

9.

10.
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11. 在 ArmShaft 上施加一个无摩擦约束：
a. 选择 ArmShaft 其中一个轴端面
b. RMB（点击鼠标右键选择） > Insert

>Frictionless Support. a.

? 可以选择轴的任意端

b.

? 无摩擦约束给施加面上提供了垂直方向 的
限制。这样，轴就可以自由转动而不 会
跑到平面外（即限制了 Z方向的位移）

作业 3.1 –改变环境 Workshop Supplement
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? 再次求解模型和查看变形，发现 ArmShaft 没有发生移动。
– 建立接触模型时，把握住什么运动需要考虑或不考虑是很重要的。

作业 3.1 –修整结果 Workshop Supplement
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Static Structural Analysis

4-2

概要 Training Manual

? 本章，将练习线性静力结构分析，模拟过程中包括：
A. 几何和单元
B. 组件和接触类型
C. 分析设置

? 本节描述的应用一般都能在 ANSYS DesignSpace Entra 或更高版本中
使 用。
– 尽管本章中讨论的一些选项可能需要更高级的许可， 但都给了提示。

D.  环境，如载荷和约束
E.  求解模型
F. 结果和后处理
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线性静态结构分析基础 Training Manual

? 对于一个线性静态结构分析（ Linear Static Analysis ），位移 {x}由下面的矩 阵
方程解出：

K x F

假设：
– [K] 是一个常量矩阵

?  假设是线弹性材料行为
? 使用小变形理论

? 记住关于线性静态结构分析的假设是很重要的。非线性静态分析和动态分析在 后面
章节讲解。

? 可能包含一些非线性边界条件
– {F}是静态加在模型上的

? 不考虑随时间变化的力
? 不包含惯性影响 （质量、阻尼）
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?在结构分析中，可能模拟各种类型的实体。

?对于面实体，在 Details of surface body 中一定要指定厚度值。

?线实体的截面和方向，在 DesignModeler 里进行定义，并自动导入到
Simulation （模拟）中。

A. 几何模型 Training Manual
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?在模型中添加一个质量点来模拟结构中没有明确建模的重量体：
–质量点只能和面一起使用。

–它的位置可以通过下面任一种方法指定：
? 用户自定义的坐标系中指定（ x， y， z） 坐标值
? 通过选择顶点 /边/面指定位置

–质量点只受包括加速度、重力加速度和角加速度的影响。

–质量是与选择的面联系在一起的，并假设它们之间没有刚度。

–不存在转动惯性

⋯ 质量点 Training Manual
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?在线性静态结构分析中需要给出杨氏模量和泊松比 ：
–在 Engineering Data 中输入材料参数
–存在惯性时，需要给出材料密度
–当施加了一个均匀的温度载荷时，需要给出热膨胀系数–在均匀温度载荷条件下，不需要指定导热系数
–想得到应力结果，需要给出应力极限

–进行疲劳分析时需要定义疲劳属性
? 在许可协议中需要添加疲劳分析模块

⋯ 材料特性 Training Manual
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?在导入实体装配体时，在实体之间会自动创建接触对。
–面对面接触允许在两个实体边界划分的单元不匹配

–Contact 下的 Tolerance controls （容差控制），可以让用户使用滚动条指定自动接触检
查的容差

B. 组件 –实体接触 Training Manual
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⋯组件 –实体接触 Training Manual

?在模拟中，每个接触对都要定义接触面和目标面：
–接触区域的一个表面视作接触面，另一表面即为目标面

–接触面不能穿透目标面
当一面被设计为接触面为另一面被设为目标面，这就是非对称接触

? 如果两边互为接触面（ C）和目标面（ T），那就叫对称接触

? 默认的实体组件间的接触是对称接触
? 用户可以根据需要将接触类型改为非对称接触（ ANSYS Professional 或更高版本）

对称接触 非对称接触
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⋯组件 –实体接触 Training Manual

?可以使用的五种接触类型：

– Bonded 和 No Separation 是线性接触并只需要一次迭代

– Frictionless ，Rough 和 Frictional 是非线性接触并需要多
次 迭代

Contact Type Iterations Normal Behavior (Separation)Tangential Behavior (Sliding)
Bonded 1 No Gaps No Sliding
No Separation 1 No Gaps Sliding Allowed
Frictionless Multiple Gaps Allowed Sliding Allowed
Rough Multiple Gaps Allowed No Sliding
Frictional Multiple Gaps Allowed Sliding Allowed

4-9

?非线性接触类存在一个 Interface Treatment （界面处理）
选项：

? Offset ：给初始调整指定一个 0 或非 0的值
? Adjusted to Touch ： ANSYS 把间隔缩小到恰好接触的位置 （

ANSYS Professional 或更高版本）
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⋯组件 –实体接触 Training Manual

C

?界面调整选项：

Offset ： 接触面在正向或相反方向上
偏移一个指定的距离（可以程序设置

偏移量）

Adjusted to touch ：不考虑实际的间距
，把接触面移向目标面，给出一个初始 接

触

4-10

C TT
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⋯组件 –实体接触 Training Manual

4-11

? Advanced 选项 （更多细节参见第三 章的 pinball 区域的细节设
置）：
–Pin Ball Region ：

? Inside pinball = near-field contact
? Outside pinball = far-field contact
? 使求解器更有效的进行接触计算

?对 ANSYS Professional 或更高版本而言
，支持壳体和实体的混合组件与更多的接 触
选项

本例中，两部件间的间距比
pinball
区域大，故不会自动闭合它们键的
间隔。



Static Structural Analysis

4-12

⋯组件 –点焊 Training Manual

? Spot weld 提供了在分离点上连接壳体组件的方法：
–Spotweld 在 CAD 软件中进行定义。目前，只有 DesignModeler 和 Unigraphics 支持点
焊定义（ Spotweld ） 。
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⋯组件 –接触总结 Training Manual

?在模拟中可以使用的接触类和选项的总结：

Contact Geometry Solid Body Face (Scope = 
Contact)

Solid Body Edge (Scope = 
Contact)

Surface Body 
(Scope = Contact)

Face Surface Body Edge 
(Scope = Contact)

Solid Body Face (Scope = 
Target)

All types Bonded, No Separation All types Bonded

All formulations All formulations All formulations MPC formulation

Symmetry respected Symmetry NOT respected Symmetry respected Symmetry NOT respected

Solid Body Edge (Scope = 
Target)

Not 
solving 1

supported for Bonded, No Separation Not supported 
solving 1

for Bonded

All formulations MPC formulation

Symmetry NOT respected Symmetry NOT respected

Surface Body 
(Scope = Target)

Face All types All types All types Bonded

All formulations All formulations All formulations Augmented Lagrange, 
Pure Penalty, and MPC 
formulations

Symmetry respected Symmetry NOT respected Symmetry respected Symmetry NOT respected

Surface Body 
(Scope = Target)

Edge Not 
solving 1

supported for Bonded Not supported 
solving 1

for Bonded
MPC formulation Augmented Lagrange, 

Pure Penalty, and MPC 
formulations

Symmetry NOT respected Symmetry NOT respected

1 –对于面边接触，面通常被设计为目标面而边被指定为接触面
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C. 分析设置 Training Manual

? details of Analysis Settings 中提供了一般的求解
过 程控制：

? Step Controls （求解步控制）：
–人工时间步控制和自动时间步控制

–指定分析中的分析步数目和每个步的终止时间

–在静态分析里的时间是一种跟踪机制（后面讨论）

? Solver Controls （求解控制）：
–两种求解方式（默认是 Program Controlled ）：

?  直接求解 （ANSYS 中是稀疏矩阵法）

? 迭代求解 （ ANSYS 中是 PGC（预共轭梯度法 ）） .
–Weak springs ：

? 尝试模拟得到无约束的模型



4-15

Static Structural Analysis

? Analysis Data Management （分析数据管理器
）：

–Solver Files Directory ：给出了相关分析文件的
保存路径

–Future Analysis ：指定求解中是否要进行后续分
析 （ 如 预 应 力 模 型 ） 。 如 果 在 project 
schematic 里指定了耦合分析，将自动设置该选
项。

–Scratch Solver Files Directory ：求解中的临时
文件夹

–保存 ANSYS DB 分析文件
–Delete Unneeded Files ： 在 Mechanical APDL
中，可以选择保存所有文件以备后用

–Solver Units ： Active System 或 manual.

–Solver Unit System ：如果以上设置是人工的，
那当 Mechanical APDL 共享数据的时候，就可
以 选择 8 个求解单位系统中的一个来保证一致性
（在 用户操作界面中不影响结果和载荷显示）

. . . 分析设置 - Analysis Data Management Training Manual
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? Step Controls （分析步控制）：
–在静态分析中允许设置多个分析步，并一步一步的求解。

–对于静态分析，终止时间被用作确定载荷步和载荷子步的
追踪器。

–可以一个分析步一个分析步的查看结果。 在给出的

Tabular Data 里可以指定每个分析步的载荷值。

在图形窗口中给出了时间
和载荷值的关系图

. . . 分析设置 -分析步控制 Training Manual
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?通过选择 Analysis Type ，然后选择 Worksheet 表单查看所有不同分析
步。

. . . 多个分析步 Training Manual
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?求解完成后，可以选择需要的求解步，然后点击鼠标右键选择 Retrieve
This Result ，查看每个独立步骤的结果。

选择需要的求解步
，然后点击鼠标右
键选择 Retrieve 

This Result

. . . 多个分析步 Training Manual
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?载荷和约束是以所选单元的自由度的形式定义的。 UY

?实体的自由度是 x， y 和 z方向上的平移 （壳体还得加上 UX

旋转自由度，绕 x，y 和 z轴的转动）
UZ

?约束，不考虑实际的名称，也是以自由度的形式定义的
。

?例如，在块体的 Z面上施加一个光滑约束，表示它 Z方
向 上的自由度不再是自由的（其它自由度是自由
的）。

光滑面

D. 载荷和约束 Training Manual
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?载荷类型：
–惯性载荷：

? 这些载荷施加在整个模型上
? 对于惯性计算时需要知道密度
? 这些载荷专指施加在定义好的质量点上的力 （Point Masses ）

–结构载荷：
? 施加在系统部件上的力或力矩

–结构约束：
? 防止在某一特定区域上移动的约束

–热载荷：? 热载荷会产生一个温度场，使模型中发生热膨胀或热传导。

. . . 载荷和约束 Training Manual
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?载荷和约束的方向分量可以在整体坐标系或局部坐标 系中
定义：
–在细节窗口中， 把 Define 

B
通过下拉菜单选择坐标系

改为 Component ，然后

Load Supports Coordinate Systems
Acceleration No
Standard Earth Gravity Yes
Rotational  Velocity Yes
Force Yes
Remote Force Location of Origin Only
Bearing Load Yes
Moment Yes
Given  Displacement Yes

⋯ 方向载荷 Training Manual
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? 加速度：
–施加在整个模型上，单位是长度比上时间的平方。

–加速度可以定义为分量或矢量的形式。

–物体运动方向为加速度的反方向。

? 重力加速度：
–根据所选的单位制系统确定它的值。

–整个模型以给定的速率绕轴转动。
–以分量或矢量的形式定义。
–输入单位可以是弧度每秒（默认选项），也可是度每秒。

–重力加速度的方向定义为整体坐标系或局部坐标系的其中一个坐标轴方向。

–物体运动方向与重力加速度的方向相同。

?角加速度：

⋯ 加速度和重力加速度 Training Manual
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?施加压力：
–以与面正交的方向施加在面上。
–指向面内为正，反之为负。
–单位是单位面积的力。?施加集中力：
–集中力可以施加在点、边或面上。
–它将均匀的分布在所有实体上， 单位是 mass*length/time 2。

–可以以矢量或分量的形式定义集中力。

⋯ 集中力和压力 Training Manual
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? 静水压力：

–在面（实体或壳体）上施加一个线性变化的力，模拟结构
上的流体载荷。

–流体可能处于结构内部或外部
? 用户指定：

–加速度的大小和方向
–流体密度
–代表流体自由面的坐标系
–对于壳体，提供了一个顶面 /底面选项

内部 外部

⋯ 静水压力 Training Manual
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：? 轴承负载（集中力）

–使用投影面的方法将力的分量按照投影面积分布在压
缩边上。

? 不允许存在轴向分量
? 每个圆柱面上只能使用一个轴承负载。

–在施加该载荷时，若圆柱面是分裂的，一定要
选中它的两个半圆柱面。

–轴承负载可以矢量或分量的形式定义。

轴承负载 集中力

⋯ 轴承负载 Training Manual
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?力矩载荷：
–对于实体，力矩只能施加在面上。

– 如果选择了多个面，力矩则均匀分布在多个面上。

–可以根据右手法则以矢量或分量的形式定义力矩。

–对于面，力矩可以施加在点上、边上或面上。

–力矩的单位是力乘上距离。

⋯ 力矩 Training Manual



4-27

Static Structural Analysis

? 远程载荷：
–给实体的面或边施加一个远离的载荷。
–用户指定载荷的原点（附着于几何上或用坐标指定）
–可以以矢量或分量的形式定义。

–给面上施加一个等效力或等效力矩。

–例如： 在一个 10 英寸的梁端的范围内施加了一个 1 lbf 的远程载荷，且远程
载
荷距离固支端 20英寸。

F=1 lbf

20” 反作用力矩

⋯ 远程载荷 Training Manual
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：? 螺栓预紧力
–给圆柱形截面上施加预紧力以模拟螺栓连接：

? 预紧力（集中力）
? 或者
? 调整量（长度）

–对于顺序加载，还有其它额外选项（见下一页）

–需要给物体指定一个局部坐标系统（在 Z 方向上的预紧力）
–自动生成两个载荷步求解：

? LS1： 施加有预紧力、边界条件和接触条件
? LS2：预紧力部分的相对运动是固定的并施加了一个外部载荷

. . . 螺栓预紧力 Training Manual



4-29

Static Structural Analysis

2

4

3

1

? 螺栓载荷提示：
– 只用于三维模拟

– 只用于圆柱形面体或实体

– 需要精确的网格划分（在轴向上至少得有 2个单
元）

?针对顺序加载，在 Details of Bolt Pretension 的 Define By 选
项提供了如下选项：
– Load 或 Adjustment ：如前面所讲定义

– Lock : 固定所有位移（载荷施加和保持）
– Open ：保持预紧力 “ open”（即无预紧力）

. . . 螺栓预紧力 –顺序模拟 Training Manual
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? 线压力载荷：
–只能用于三维模拟中，通过载荷密度形式给一个边上施加一个分布载荷
–单位是单位长度上的载荷

–可按以下方式定义：
? 幅值和向量
?  幅值和分量方向 (总体或者局部坐标系 )
? 幅值和切向

. . . 线压力 Training Manual
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?固定约束：
–限制点、边或面的所有自由度

–允许在面 /边界上模拟弹簧行为
–基础的刚度为使基础产生单位法向偏移所需要的压力

? 实体：限制 x， y 和 z方向上的移动
? 面体和线体：限制 x， y和 z方向上的移动和绕各轴的转动

?已知位移：
–在点、边或面上施加已知位移

–允许给出 x、y 和 z方向上的平动位移（在用户定义坐标系
下）

–“ 0”表示该方向是受限的，而空白表示该方向自由。

? 弹性约束：
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⋯ 约束 Training Manual

束：?无摩擦约
–在面上施加法向约束（固定）

– 对实体而言，可以用于模拟对称边界约束

–例如
在径向是固定的

面内可以自由移动
面外的移动是受限的

在轴向和切向是自
由的
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?圆柱面约束 :
–为轴向、径向或切向约束提供单独控制
–施加在圆柱面上

例如 . . .

径向

切向

轴向
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⋯ 约束 Training Manual

? 仅有压缩的约束：
–只能在正常压缩方向施加约束

–可以模拟圆柱面上受 销钉、螺栓等的作用

–需要进行迭代（非线性）求解

载荷

载荷

约束（实体）

只可压缩
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⋯ 约束（线 /面实体） Training Manual

?简单约束：
–可以施加在梁或壳体的边缘或者顶点上
限制平移，但是所有旋转都是自由的

?约束转动：

简单约束边 约束转动边

–可以施加在壳或梁的表面、边缘或者顶点上

–约束旋转，但是平移不限制

平动受限 平动自由

转动自由 转动受限
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⋯ 热加载 Training Manual

?热条件：
–在结构分析中施加一个均匀温度

–出现在结构分析的 Loads 下拉选项中
–必须指定参考温度（见下一页）
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refth

? 温度差会在结构中导致热膨胀或热传导 ：
–热应变（ th） 按下式计算：

x y
th th

z T T 
– 热膨胀系数 （CTE 材料特性 ）

–Tref 参考温度 （热应变为 0 时的温度）
–T 施加的温度（见前面页）
–在整体环境中定义参考温度，或把它作为单个实体的特性进行定义。

⋯ 热加载 Training Manual
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?点击在标准工具箱里的 Solve 按钮，求解模型 :
–默认两个处理器进行求解

–通过 Tools > Solve Process Settings 设置使用的处理器个数

⋯ 求解模型 Training Manual
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?作业 4.1 –线性结构分析
?目标：
–分析由 5 部分组成的叶轮式泵模型，在皮带上有一个 100N 的预紧力。

E. 作业 4.1 –线性结构分析 Training Manual
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?在后处理中可以得到多种不同的结果：
–各个方向变形及总变形
–应力应变分量、主应力应变或者应力应变不变量。
–接触输出

–支反力

?在 DS 中，结果通常是在计算前指定的，但是它们也可以在计算完成后指定
。

–如果求解一个模型后再指定结果，可以点击 Solve 按钮 ，然后就可以检索结
果。

–不需要新的求解

F. 结果和后处理 Training Manual
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?经常在变形的几何体上显示云图和矢量图。
?利用 Context Toolbar 改变结果的显示。

⋯ 显示结果 Training Manual
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?可以显示模型的变形：
–整体变形是一个标量：

U total  

–在 Directional 里可以指定变形的 x，y 和 z分量，显示在整体或局部坐标系
中。

–可以得到变形的矢量图 （如下）

⋯ 变形 Training Manual

U 2 x U 2  U 2y z
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?应力和应变：
–应力和弹性应变有六个分量 (x, y, z, xy, yz, xz) ，而热应变有三个分量 (x, y, z) 。
–对应力和应变而言，它们的分量可以在 Normal 和 Shear 里指定，而对于热应变，在

Thermal 中指定。
–主应力关系 ： s1 > s2 > s3

强度定义为下面值的最大绝对值：

? s1 - s2, s2 - s3 或 s3 - s1

⋯ 应力和应变 Training Manual
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? 安全系数（应用 4种失效理论） ：
–柔性理论：

? 最大等效应力
? 最大剪切应力

–脆性理论：
? Mohr-Coulomb 应力

? 最大拉伸应力

–使用每个安全因子的应力工具，都可以绘制出安全 边界
和应力比。

⋯ 应力工具 Training Manual
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?通过 Solution 下的 Contact Tool 可以得到接触结果

⋯ 接触结果 Training Manual
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? 为 Contact Tool 选择接触域（ 2 种方法） ：
1. Worksheet view (details) ： 从表单中选择接触域

? 接触面，目标面或同时选择两者

2. Geometry ：在图形窗口中选择接触域

⋯ 接触结果 Training Manual



4-48

Static Structural Analysis

?除了标准结果，用户可以插入自定义结果
?可以包括数学表达式和多个结果的组合
?按两种方式定义：
–选择 solution 菜单中的 User Defined Result

–或在 Solution Worksheet 中选中结果后点击鼠标右键选择 Create 
User Defined Result.

用户自定义结果 Training Manual
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?在 Details of User Defined Result 中，表达
式 允许使用各种数学操作符号，包括平方
根、绝 对值，指数等。

? 用户定义结果可以用一种 Identifier （标识
符） 来标注

? 结果图例包含 identifier （标识符）和表达式

. . .用户自定义结果 Training Manual
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? 作业 4.2 –二维结构分析
? 二维结构分析

? 这里给出的是二维轴对称模型

压力盖 弹簧卡环

G. 作业 4.2 –二维结构分析 Training Manual
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作业 4.1 线性

结构分析

WS4.1-1 



WS4.1: Linear Structural Analysis

WS4.1-2

作业 4.1 –目标 Workshop Supplement

? 作业 4 是一个叶轮式泵，它是一个由 5部分组成的组件。目标是组件在皮
带 上受一个 100N 的预紧力时，分析测试：
–负载下，叶轮不会发生超过 0.075mm 的偏离
–使用塑料泵壳时，在安装孔周围不会超过材料的弹性极限
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WS4.1-3

作业 4.1 –假设 Workshop Supplement

?假设泵壳相对其它部件是刚性的。为了模拟它，需要在安装面上施加一个
无摩擦约束。

?类似的，无摩擦接触用来模拟螺栓和安装孔间的接触。（注意如果想在安
装孔处获得精确的应力，最好选择 compression only （只承受压缩） 约束
。）

? 最后，用一个轴承载荷力（ X = 100 N ）模拟传动带产生的力。轴承载荷均
匀分布在与皮带接触的滑轮面。
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WS4.1-4

?打开 Project 页.
? 在 Units 菜单确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV)
–选择 Display Values in Project Units

作业 4.1 – Project Schematic Workshop Supplement
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WS4.1-5

1. 从 Toolbox 中插入一个
Static Structural 系统到
Project Schematic

1.

2. 在 Geometry 上点击鼠标右键选择
Import Geometry > Browse 。导
入文件 Pump_assy3.x_t 。

2.3. 双击 Model 启动
Mechanical
application

3.

. . .作业 4.1 - Project Schematic Workshop Supplement



WS4.1: Linear Structural Analysis

WS4.1-6

4. 设置作业单位制系统：
? Units > Metric (mm, kg, N, s, mV, mA)

4.
5. 把 Engineering Data 添加到 Polyethylene （返回
到 Workbench 窗口）：
a. 双击 Engineering Data
b. 选择 General Materials ，点击 Polyethylene 附近
的 “+”图标

c. 返回到 Project 页

a.

c.

b.

作业 4.1 –前处理 Workshop Supplement
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WS4.1-7

esh.
6. 刷新 Model 模块：

a. RMB（点击鼠标右键选择） > Refr

? 返回到 Mechanical 窗口

7. 该表泵壳上的材料（ Part 1）：
a. 在 geometry 下选中 Part 1
b. 在 Details of Part 1 中把材料设
为 Polyethylene

作业 4.1 –前处理 Workshop Supplement

6a.

7a.

7b.
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WS4.1-8

8. 改变前面 4 个接触区域的接触行为（下面所示）：
a. 按住 shift 键选中前面 4个接触
b. 从 Details of multiple selection 中改变接触类型
为 no separation

? 余下接触仍为 bonded

b.

. . .作业 4.1 –前处理 Workshop Supplement

a.
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WS4.1-9

9. 在滑轮上施加一个轴承载荷：
a. 选中 Static 
Structural b. 选中滑轮
的沟面
c. RMB（点击鼠标右键选择） > Insert > Bearing Load”.
d. 从 Details of bearing load 窗口中给 X Components 赋一

100 N 的力 a.

作业 4.1 –环境 Workshop Supplement
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WS4.1-10

d.

b.
c.
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –环境 Workshop Supplement

10. 给组件施加约束：
a. 选中泵壳（ part 1 ）的装配面
b. RMB（点击鼠标右键选择） > Insert > Frictionless Suppo rt ”.

b.

a.
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –环境 Workshop Supplement

? 现在，给装配孔的螺丝孔部分施加无摩擦约束（如图示）。
?  每个需要的面需要通过按住 CTRL 键来一一选择，但是也可以使用 DS 提供的宏文
件
（同过指定大小选择）来选择需要的面。在选择了一个初始面后，运行宏文件选择
同样大小的面。注意，宏文件同样适用于边和体的选择。
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –环境 Workshop Supplement
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. . .作业 4.1 –环境 Workshop Supplement

a. 选中其中任意一个螺丝孔面
b. 通过 Tools > Run Macro . . . 选

a.

C:\Program Files\ANSYSInc\v120\AISOL\DesignSpace\DSPages\macros

c. 浏览选择文件 selectBySize.js
d. 点击 Open

b.

11. 选择螺丝孔面（使用指定大小选择的宏文件）：

WS4.1-12

c.

d.
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. . .作业 4.1 –环境 Workshop Supplement

WS4.1-13

12. 约束螺丝孔面：
a. 通过上下文菜单点击 Supports 选择

Frictionless Support ，或 RMB（点击鼠标右
键 选择） > Insert > Frictionless Support

a.



WS4.1: Linear Structural Analysis

WS4.1-14

. . . 作业 4.1 –求解 Workshop Supplement

14.

13. 选中 Analysis Settings 并在 details of Analysis
Settings 窗口中把 Weak Springs 由 Program
Controlled 改为 Off 13.

– 注：由于无摩擦约束没有绑到接触上，因此 Workbench-Mechanical
将在求解中选择使用 weak springs 。如果知道模型是完全约束的，就
可以关掉这个功能。在关掉 weak springs 之前确定没有刚体位移。否
则将导致求解不收敛。

14. 求解模型：
? 在工具栏中选择 solve ，或则在 Solution 上点击鼠标
右 键选择 Solve 。
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WS4.1: Linear Structural Analysis

作业 4.1 –后处理 Workshop Supplement

15. 把结果添加到 solution 中 ：
a. 选中 solution
b. 从上下文菜单中选择 Stresses > Equivalent (von-Mises) ，或则 RMB（点
击 鼠标右键选择） > Insert > Stress > Equivalent (von-Mises)

c. 重复以上步骤，选择 Deformation > Total Deformation

? 再次求解
– 注：添加结果并重新求解不会导致完成的求解。结果将保存在数据库，而且重新求解的结果通过更
新即可。

b. c.

a.
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –后处理 Workshop Supplement

?尽管整体图形可以作为可靠的检查来验证载荷，但是却不够理想。因为模
型的很多部分受到的影响很小。

?为了提高结果的质量，需要查看单个部分的结果。
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –后处理 Workshop Supplement

16. 查看单个实体或面的结果：
a. 选中 Solution 并选择实体选择模式。

b.  选择叶轮（ part 2 ）
c. RMB （点击鼠标右键选择） > Insert > Stress > 

equivalent (von- Mises)

? 注意新结果细节显示的是所查看实体的结果 .

17. 重复上面的过程，并插入叶轮的 Total Deformation （整体变形）结
果。

18. 重复上面的过程，查看泵壳（ part 1 ）的应力和整 体变
形结果。

a.

b.

c.
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –后处理 Workshop Supplement

19. 重命名新结果：
a. 在 result 上点击鼠标右键选择
Rename b. 如图所示重命名结果，简化
后处理

20. 求解

b.
a.
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –后处理 Workshop Supplement

?通过检查叶轮的变形可以确定已达到其中一个目标：最大的变形接近
0.024mm （目标值小于 0.075mm ）。
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WS4.1: Linear Structural Analysis

. . .作业 4.1 –后处理 Workshop Supplement

?通过泵壳的整体应力图知，其应力水平低于材料的弹性极限（抗拉强度为
25 MPa ）。同样可以查看感兴趣区域的结果图。
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作业 4.2

二维结构分析

WS4.2-1 



WS4.2: 2D Structural Analysis

WS4.2-2

作业 4.2 –目标 Workshop Supplement

? 作业 4.2 的对象是一个有两部分的组件，它们是 pressure cap 和 retaining
flange （整体模型如下图）。

?按二维轴对称模型求解（在下一页给出）。

Pressure Cap

Retaining Ring

整体模型
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WS4.2-3

作业 4.2 –假设 Workshop Supplement

?二维轴对称模型描述：
? retaining ring 在它的装配孔处是固定的。

? 部件之间的接触是光滑的。
? pressure cap 的基座是用一个只能受压的支撑约束的。

– 注：由于存在螺栓孔，故结构不是真正的轴对称。

Pressure Cap

Retaining Ring



WS4.2: 2D Structural Analysis

WS4.4-2

?打开 Project 页
?在 Units 菜单中确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV).
–选择 Display Values in Project Units

. . . 作业 4.2 – Project Schematic Workshop Supplement
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WS4.2-5

1. 双击 Static Structural 添加一
个 新的系统

1

2. 在 Geometry 点击鼠标右键选择
Properties

作业 4.2 – Project Schematic Workshop Supplement

2



WS4.2: 2D Structural Analysis

WS4.6-2

3. 在 Analysis Type 中选择 2D
? 一旦设置好了，就可以关闭

properties 窗口

? 注意，这样的设置表示分析的不是三
维整体模型而是一个对称截面。在导
入几何模型之前就设置好是很重要的
，因为在导入后就不能再改变设置。

作业 4.2 - Project Schematic Workshop Supplement

3
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WS4.2-7

4. 双击 Engineering Data 添加
material properties （材料特性）

5. 选中 General Materials 的同时点击结构
钢 图标‘+’把材料添加到项目中。

6. 返回到 Project

6

作业 4.2 - Project Schematic Workshop Supplement

4

5
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WS4.8-2

7. 在 Geometry 上点击鼠标右键选
择 Import Geometry ，导入文
件:
Axisym_pressure_2D_12.x_t

8. 双击 Model 启动 Mechanical

作业 4.2 –几何模型建立步骤 Workshop Supplement

7

8
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g

作业 4.2 –前处理 Workshop Supplement

9. 设置作业单位制系统：
? Units > Metric (mm, kg, N, s, mV, mA)

WS4.2-9

10. 改变部件特性为轴对称：
a. 选中 Geometry
b. 在 Details of Geometry 中把 2D Behavior 改
为 Axisymmetric

a.

? 部件重命名：
?

?

Part1 ：点击鼠标右键选择 Rename ，重命名为
Retainin
Ring Part2 ：点击鼠标右键选择 Rename ，重命名为
Pressure Cap

b.

9
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WS4.2-10

“ ”

⋯作业 4.2 –前处理 Workshop Supplement

12. 修改接触行为：
a. 在 Details of Contact Region 中，把 Type
设为 Frictionless

11. 改变 Pressure Cap 的材
料：
a. 选择 Pressure Cap

11a.
b. 在 Details of Pressure Cap 中选择

Material ，把 Assignment 设为
Stainless Steel

11b.

12a.
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WS4.2-11

⋯作业 4.2 –接触 Workshop Supplement

13. 执行网格划分：
a. 在 Mesh 点击鼠标右键选择 Generate Mesh

a.



WS4.2: 2D Structural Analysis

作业 4.2 –环境 Workshop Supplement

14. 给模型施加载荷（确定选中 Static Structural ）：
a. 选择 Pressure Cap 的 4 个内边（如黑色虚线所示） 。

? 提示：选择其中一个边，在使用 “extend to limits ”

b. RMB （点击鼠标右键选择） > Insert > Pressure 
c. 这是压力值为 0.1 MPa.

WS4.2-12

a. b.

c.
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WS4.2-13

⋯作业 4.2 –环境 Workshop Supplement

15. 给模型施加约束：

a. 选中 pressure cap 的底边（如图中所示黑色虚线） b.

b. RMB（点击鼠标右键选择） > Insert > 
Compression Only Support

a.



WS4.2: 2D Structural Analysis

WS4.2-14

⋯作业 4.2 –环境 Workshop Supplement

c. 选择 retaining ring 上部的中线（如图所示黑色虚线）
d. RMB（点击鼠标右键选择） > Insert > Fixed Support

? 注：记住，这里的轴对称假设是指 retaining    ring 是一个连续实体。实际上在它的环面上存在螺纹
孔。 因此，当模型在里生成时，就有意的生成了一条独立的线来添加约束。

d.

c.
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WS4.2-15

? 求解模型
? 轴对称性：

? 注意模型处在 X 正半轴空间内，且 Y 轴是它的旋转轴。此即轴对称性。
? 轴对称性假设模型是一个完全 360度模型 因此 在 X方向上没有限制 在 X正半轴上的压力假设是和 X负半轴桑
的压力相同。

? 查看警告和错误信息：
a. 在图形窗口的底部的 Messages 中给出了错误和警告信息。
b. 在 message 上双击查看。点击 OK 关闭警告窗。

? 提示：由于是用光滑接触和只受压的支撑来约束 pressure cap 的，因此使用 weak springs 来阻止发生刚体运
动。

作业 4.2 –求解 Workshop Supplement
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WS4.2-16

? 在 Solution 中插入结果：
? 选中 Solution ，点击鼠标右键选择 Stress > Equivalent (von-Mises)
? 选中 Solution branch ， 点击鼠标右键选择 Insert> Deformation > Total
? 选择实体选择模式，选择 pressure cap ，重复步骤 a. 和 b.

? 提示：现在在 pressure   cap上已经添加了查看刚才选择两个结果。这允许分开查看它的响应。

? 求解

作业 4.2 –后处理 Workshop Supplement



WS4.2: 2D Structural Analysis

WS4.2-17

? 选中查看每个结果对象

Pressure Cap 的整体变形所有实体上的等效应力

⋯作业 4.2 –后处理 Workshop Supplement
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WS4.2-18

通过选中 Solution Information 查看求解时间：

– 图形窗口将变成工作表查看。移到求解信息的底部并注意 Elapsed Time （运
行时间） （随机器而改变）。

? 注，CP时间给出的是整个过程的时间。在multiprocessor     machines 中常会超过运行时间。

⋯作业 4.2 –后处理 Workshop Supplement
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WS4.2-19

? 对比三维对称模型网格划分的运行时间：
–2D Elapsed Time = 9.0 seconds.
–3D Elapsed Time = 41.0 seconds.

. . . 作业 4.2 –对比 Workshop Supplement
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第五章 模

态分析

5-1 





Vibration Analysis

5-2

简介 Training Manual

?在这一章中，将介绍模态分析。进行模态分析类似线性静力分析。
–假设用户已学习了第 4章线性静力结构分析部分。

?本章内容 :
–模态分析步骤
–有预应力的模态分析步骤

?本节所述的功能，一般适用于 ANSYS DesignSpace Entra 及以上版本的
许 可。
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模态系统分析基础 Training Manual

K 2 
i M 0i

?假设 :

? 对于模态分析，振动频率 i和模态 i 是根据下面的方程计算的出的：

–[K] 和 [M] 不变 :
? 假设材料特性为线弹性的? 利用小位移理论，并且不包括非线性的
? 不存在 [C] , 因此无阻尼
? 无 {F}  , 因此无激振力
? 结构可以强迫振动也可以不强迫振动

–模态 { } 是相对值，不是绝对值
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?模态分析与线性静态分析的过程非常相似，因此不对所有的步骤做详细介
绍。用蓝色斜体字的步骤是针对模态分析的。
–附加几何模型

–设置材料属性

–加支撑 (如果有的话 )
–求解频率测试结果–设置频率测试选项
–求解
–查看结果

–定义接触区域 (如果有的话 )
–定义网格控制 (可选择 )
–定义分析类型

A.模态系统分析步骤 Training Manual
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?模态分析支持各种几何体：

? 质量点的存在会降低结构自由振动的频率。

? 材料属性 : 杨氏模量 ,泊松比 , 和 密度是必需的。

–实体 , 表面体 和线体

?可以使用质量点 :
? 质点在模态分析中只有质量（无硬度）。

⋯几何体和质点 Training Manual
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? 模态分析，可能存在接触。然而，由于模态分析是纯粹的线性分析，所以，所采 用
的接触不同于非线性分析中的接触类型，具体如下表所示：

Contact Type Static Analysis
Modal Analysis

Initially Touching Inside Pinball Region Outside Pinball Region
Bonded Bonded Bonded Bonded Free 
No Separation No Separation No Separation No Separation Free 
Rough Rough Bonded Free Free 
Frictionless Frictionless No Separation Free Free 

?接触模态分析：–粗糙接触和摩擦接触：
? 将在内部表现为黏结或不分离
? 如果有间隙存在，非线性接触行为将是自由无约束的（例如， 接触不存在）

–绑定和不分离的接触情形将取决 pinball 区域的大小。

⋯ 接触区域 Training Manual
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?从 Workbench 的工具栏中选择 “Modal”指定模型的分析类型。
?在 Analysis Settings 中 :
–提取的模态阶数： 1到 200（默认的是 6）。
–指定频率变化的范围（默认的是 0到 1e+08Hz ）。

⋯ 分析类型 Training Manual
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?结构和热载荷无法在模态中存在。

?约束 :
–假如没有或者只存在部分的约束 , 刚体模态将被检测 . 这些模态将处于 0HZ 附近 . 与 静态结
构分析不同 , 模态分析并不要求禁止刚体运动 .

–边界条件对于模态分析来说，是很重要的。因为他们能影响零件的振型和固有频率 . 因此需
要仔细考虑模型是如何被约束的 .

–压缩约束是非线性的，因此在此分析中不被使用 .

⋯ 载荷和约束 Training Manual
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? 求解模型 (没有要求的结果 ).

?可以从图表或者图形中选择需要振型或者全部振型进行显示 .
?嵌入“Total Deformation ”结果中需要求解模态。

?求解结束后，求解分支会显示一个图标，显示频率和模态阶数 .

⋯ 求解 Training Manual
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?模态 :
–由于在结构上没有激励作用，因此振型只是与自由振动相关的相对值。

–在详细列表里可以看到每个结果的频率值 .
–应用图形窗口下方的时间标签的动画工具栏来查看振型

⋯ 检查结果 Training Manual
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? Workshop 5.1 –模态分析
?目标 :
–检查用 18 号钢制造的马达盖子（如下所示）的振动特性。

B. Workshop 5.1 –模态 Training Manual
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? 在某些情况下，在执行模态分析时可能需要考虑预应力影响。

K S i
2 M  0 i

原来的模态方程被修改为包括 [S] 阵

–处于不变载荷作用的应力作用下的结构可能会影响固有频率，例如吉他调弦
。

K xo F
进行线性静力分析

o S 
应力刚度矩阵用于计算结

构分析

C. 有预应力的模态 Training Manual
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?在项目图表里建立一个静力结构分析与模态分析相结合的并有预应力存在
的分析模型。

?注意在模型分支里，结构分析结果变成开始状态
的。
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⋯没有 /有预应力作用的例子 Training Manual

?对一边固支的薄板的结构，简单对比一下两种分析
–进行两个分析，对比模态和有预应力的模态分析的不同。 有预应力的模态分析模态分析



5-15

Vibration Analysis

?在这个例子中，提供了在有外力存在的拉伸状态下增加固有频率的方法。

有预应力的模态

第一模态频率 : 99.679 Hz

模态

第一模态频率 : 83.587 Hz
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⋯没有 /有预应力作用的例子 Training Manual

? Workshop 5.2 –预应力模态分析
?目标 :模拟拉杆在有应力和无应力状态下的模态响应（如下所示）。

D. Workshop 5.2 –预应力模态
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Workbench - Mechanical 
Introduction

作业 5.1 

模态分析

WS5.1-1 



WS5.1: Basics

WS5.1-2

作业 5.1 –目标 Workshop Supplement

?目标是调查一个由 18#钢制造的发动机盖的振动特性。它被固定在一个工作
频率为 1000 Hz 的设备上。



WS5.1: Basics

WS5.1-3

作业 5.1 –假设 Workshop Supplement

?盖子被嵌套在一个圆柱形裙箍上，而且在螺栓孔处受到约束。为了模拟裙
箍的接触区域，其表面被开了一个缺口（如图所示）。 在这个面上使用无
摩擦约束来模拟接触区域。无摩擦约束限制了面的法向，因此轴向和切向
位移是允许的，而不允许出现径向位移。

?为了模拟螺栓连接处，需要在螺栓孔的边 上使用固定
约束
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WS5.1-4

?打开 Project 页
?在 Units 菜单中确定：
–项目单位设为 US Customary (lbm, in, s, F, A, lbf, V)
–选择 Display Values in Project Units

. . . 作业 5.1 – Project Schematic Workshop Supplement



WS5.1: Basics

WS5.1-5

1. 在 Toolbox 中双击 Modal 建立
一
个新的分析系统

1.

2. 在 Geometry 上点击鼠标右键
选
择导入文件

3. 双击 Model 打开
Mechanical
application

2.

3.

作业 5.1 – Project Schematic Workshop Supplement



WS5.1: Basics

WS5.1-6

5.

4. 设置作业单位制系统：
– Units > U.S Customary (in, lbm, lbf, °F, s, V, A)

5. 重命名模型：
– 在 Model 上点击鼠标右键选择 Rename ，重命名
为 “5 Hole Cover ”.

4.

作业 5.1 –步骤 Workshop Supplement
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WS5.1-7

? 因为模型是由几何面构成，因此使用壳单元进行网
格划分。几何面需要给定厚度尺寸。

a.
6. 指定部件的厚度：

a. 选中 Part 1
? 提示： Thickness 栏现在是用黄色显示的，表示没有定
义。 同时，这个部件名旁边还有一个问号表示没有完全定
义。

b. 点击 Thickness 栏，把 Thickness 设为 0.05 in.
? 提示： 输入厚度值把状态标记由问号改为复选标记，表示
已经完全定义。

b.

作业 5.1 –前处理 Workshop Supplement



WS5.1: Basics

WS5.1-8

7. 给模型施加约束（选中 Modal ） ：
a. 确定是出于面选择模式。选择圆柱形的缺裂面，点
击鼠标右键选择 Insert > Frictionless Support
（无摩擦约束）

a.

b. 选择边选择模式并选择 5个空洞的边，点击鼠标
右

键选择 Insert > Fixed Support （固定约束）

b.

作业 5.1 –环境 Workshop Supplement
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WS5.1-9

8. 这是模型分析选项：
a. 选择 Analysis Settings 设置 Max modes 

to Find （最大模态阶数）值（默认是 6
阶）

? 最后检查一下分支的状态图标：
– 黄色闪电符号（将被求解）
– 绿色副选标记（已完全定义）

9. 求解模型

作业 5.1 –分析设置 Workshop Supplement

a.

9.
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WS5.1: Basics

作业 5.1 –结果 Workshop Supplement

10. 选择查看模态的形状：
a. 点击 Solution (A6) ，将得到 Timeline 图形和 Tabular Data 表，给出了对应
模 态的频率表。

b. 在 Timeline 上点击鼠标右键选择 Select All ，选择所有的模态
? 提示：这也可以在 Tabular Data 中完成

c. 点击鼠标右键选择 Create Mode Shape Results
d. 点击 Solve 查看结果

WS5.1-10

c.

a. b.

d.



WS5.1: Basics

WS5.1-11

. . . 作业 5.1 –结果 Workshop Supplement

? 查看结果 （选中想要查看的模态）：

? 提示：模态形状中反映的位移 不代表真实的位移。实际位移依赖于输入到系统的能量。
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WS5.1: Basics

Workbench - Mechanical 
Introduction

作业 5.2

预应力模态分析

WS5.2-1 





WS5.2: Pre-Stressed Vibration Analysis

WS5.2-2

作业 5.2 –目标 Workshop Supplement

?目标是模拟在有预应力和无预应力两种状态下，拉杆的模态响应。
?确切的说，是给拉杆施加一个 4000N 的拉力，然后同自由状态下的拉杆固
有 频率作比较。



WS5.2: Pre-Stressed Vibration Analysis

WS5.2-3

作业 5.2 – Project Schematic Workshop Supplement

1. 双击 Toolbox 上的 Static Structural
，创建一个新的系统。

1.
2. 把 Modal 系统拖放到 static structural
系统中的 Solution 模块

2.
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WS5.2: Pre-Stressed Vibration Analysis

. . .作业 5.2 – Project Schematic Workshop Supplement

?当正确设置了 schematic 后，将显示如下图。

? 上一页的 drop target （拖放目标）表示了拖放操作的结果。 A 系统中的 A2
到 A4 是和系统 B 共享的。同样把 solution (A6) 移到系统 B 设置中。 实际
上，结构进行的是屈曲分析。

“Drop T arget ”
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WS5.2: Pre-Stressed Vibration Analysis

. . .作业 5.2 – Project Schematic Workshop Supplement

?确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV)
–选择 Display Values in Project Units
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WS5.2: Pre-Stressed Vibration Analysis

. . .作业 5.2 – Project Schematic Workshop Supplement

3. 在 static structural system (A) 的
Geometry 上点击鼠标右键选择
Import Geometry 导入文件
tension_link.x_t

3.

4. 双击 Model 打开
Mechanical application
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WS5.2: Pre-Stressed Vibration Analysis

5.

5. 设置作业单位制系统：
– Units > Metric (mm, kg, N, s, mV, mA)

6. 给模型施加约束（选中 Static Structural (A5) ）

a. 选中一个垫片的一个内表面，然后点击鼠标右键选
择 Insert 施加 Fixed Support （固定约束）

b. 选中另一个垫片的边缘，然后点击鼠标右键选择
Insert 施加 Frictionless Support （无摩擦约束）

Fixed Support a.
Frictionless

Support

b.

作业 5.2 –步骤 Workshop Supplement
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WS5.2: Pre-Stressed Vibration Analysis

作业 5.2 –前处理 Workshop Supplement

7. 给模型施加拉力：
a. 必要时，旋转模型并放大查看垫片的内表面
。该垫片的边缘施加了光滑约束。

b. RMB（点击鼠标右键选择） > InsFeorrtc>e

Force
c. 在 Details of Force 中改变 Components
d. 给 Z component 赋值 4000 a.

? 提示：根据选择的约束，载荷应定义为
4000N 来拉把杆。

c.

d.
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WS5.2: Pre-Stressed Vibration Analysis

作业 5.2 –分析设置 Workshop Supplement

8. 选中 modal 中的 Solution (B6) 和 Solve.

– 在求解结束情况下进行该操作

9. 插入模态结果：
a. 在 timeline 上点击鼠标右键选择 Select All
b. 在 timeline 上点击鼠标右键选择 Create 

Mode Shape Results

10. 在 Solution 点击鼠标右键选择 Evaluate All
Results
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WS5.2: Pre-Stressed Vibration Analysis

11. 选择不同结果来查看模态形状。

作业 5.2 –后处理 Workshop Supplement
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WS5.2: Pre-Stressed Vibration Analysis

?该表给出了随载荷增加时的一届固有频率的变化。（注意它只是用来说明
的，并不是作业的一部分）

⋯ Workshop 5.2 – Postprocessing Workshop Supplement
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第六章热

分析

6-1 





热分析

6-2

概念 Training Manual

?本章练习稳态热分析的模拟，包括：
A. 几何模型
B. 组件 -实体接触
C. 热载荷
D. 求解选项
E. 结果和后处理
F. 作业 6.1

? 本节描述的应用一般都能在 ANSYS DesignSpace Entra 或更高版本中使用，除了
ANSYS Structural

? 提示：在 ANSYS 热分析 的培训中包含了包括热瞬态分析的高级分析
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稳态热传导基础 Training Manual

?对于一个稳态热分析的模拟，温度矩阵 {T}通过下面的矩阵方程解得：

?假设：

K T T QT 
–在稳态分析中不考虑瞬态影响
–[K] 可以是一个常量或是温度的函数
–{Q}可以是一个常量或是温度的函数
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?上述方程基于傅里叶定律：
?  固体内部的热流（ Fourie r’s Law ）是 [K] 的基础；
? 热通量、热流率、以及对流 在 {Q} 为边界条件；
? 对流被处理成边界条件，虽然对流换热系数可能与温度相关

?在模拟时，记住这些假设对热分析是很重要的。

稳态热传导基础 Training Manual
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?热分析里所有实体类都被约束：
–体、面、线

? 线实体的截面和轴向在 DesignModeler 中定义

?  热分析里不可以使用点质量（ Point Mass ）的特性

?壳体和线体假设：
–壳体：没有厚度方向上的温度梯度
–线体：没有厚度变化，假设在截面上是一个常量温度

? 但在线实体的轴向仍有温度变化

A. 几何模型 Training Manual
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?唯一需要的材料特性是导热性（ Thermal Conductivity ）

? Thermal Conductivity 在
Engineering Data 中输
入

? 温度相关的导热性以表格 形式
输入

若存在任何的温度相关的材料特性，就将导致非线性求解。

⋯ 材料特性 Training Manual
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? 对于结构分析，接触域是自动生成的，用于激活各部件间的热传导

B. 组件 -实体接触 Training Manual
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–如果部件间初始就已经接触，那么就会出现热传导。

–如果部件间初始就没有接触，那么就不会发生热传导（见下面对 pinball 的解释
）。

–总结：

Contact Type
Heat Transfer Between Parts in Contact Region?

Initially Touching Inside Pinball Region Outside Pinball Region 
Bonded Yes Yes No 
No Separation Yes Yes No 
Rough Yes No No 
Frictionless Yes No No 
Frictional Yes No No 

–Pinball 区域决定了什么时候发生接触，并且是自动定义的，同时还给了一个相
对较小的值来适应模型里的小间距。

⋯ 组件 -接触区域 Training Manual
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?如果接触是 Bonded （绑定的）或 no
separation （无分离的），那么当面出现在
pinball radius 内时就会发生热传导（绿色实线
表示）。

Pinball Radius

右图中，两部件间的间距大于 pinball
区域，因此在这两个部件间 会发生热
传导。

⋯ 组件 -接触区域 Training Manual
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热分析

? 默认情况下，假设部件间是完美的热接触传导， 意味着界面上不会发生温
度降

?实际情况下，有些条件削弱了完美的热接触传导：
–

–

–

–

–

–

–

–

表面光滑度

表面粗糙度

氧化物 包

埋液 接触

压力 表面

温度
T

使用导电脂

. . . .
T

x
?接着⋯⋯
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热分析

⋯ 组件 -导热率 Training Manual

T

–穿过接触界面的热流速，由接触热通量 q 决定：

q TCC target
Tcontact 

–式中 Tcontact 是一个接触节点上的温度， T target 是对应目标节点上的温度

–默认情况下，基于模型中定义的最大材料导热性 KXX 和整个几何边界框的对角
线 ASMDIAG ， TCC 被赋以一个相对较大的值。

TCC KXX 10,000 / ASMDIAG
–这实质上为部件间提供了一个完美接触传导
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? 在 ANSYS Professional 或更高版本，用户可以为纯罚函数和增广拉格朗
日 方程定义一个有限热接触传导（ TCC）。
–在细节窗口，为每个接触域指定 TCC 输入值
–如果已知接触热阻，那么它的相反数除以接触面积就可得到 TCC 值

在接触界面上，可以像接触热阻一样
输入接触热传导
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热分析

⋯ 组件 -导热率 Training Manual

? Spotweld （点焊）提供了离散的热传导点：
–Spotweld 在 CAD 软件中进行定义（目前只有 DesignModeler 和 Unigraphics
可 用） 。

T2

T1

点焊
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热分析

⋯ 热边界条件 Training ManualC. 热载荷

?热流量：
–热流速可以施加在点、边或面上。它分布在多个选择域上。

–它的单位是能量比上时间（ energy/time ）

?完全绝热（热流量为 0）：

?热生成：
–内部热生成只能施加在实体上

–它的单位是能量比上时间在除以体积（ energy/time/volume ）

正的热载荷会增加系统的能量。

–可以删除原来面上施加的边界条件

?热通量：
–热通量只能施加在面上（二维情况时只能施加在边上）

–它的单位是能量比上时间在除以面积（ energy/time/area ）
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热分析

温度、对流、辐射：

? 完全绝热条件将忽略其它的热边界条件

?给定温度：
–给点、边、面或体上指定一个温度

–温度是需要求解的自由度

? 至少应存在一种类型的热边界条件，否则，如果热量将源源不断地输入到系统中，稳
态时的温度将会达到无穷大。

? 另外，给定的温度或对流载荷不能施加到已施加了某种热载荷或热边界条件的表面上
。
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热分析

⋯热边界条件 Training Manual

?对流：
–只能施加在面上（二维分析时只能施加在边上）
–对流 q 由导热膜系数 h，面积 A，以及表面温度 Tsurface 与环境温度 Tambient 的差

值
来定义。

q hA Tsurface Tambient

–“h”和 “Tambient ”是用户指定的值
–导热膜系数 h 可以是常量或是温度的函数
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热分析

⋯热边界条件 Training Manual

?与温度相关的对流：
–为系数类型选择 Tabular

(Temperature)
–输入对流换热系数 -温度表格数据
–在细节窗口中，为 h(T)指定温度的处理 方
式
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热分析

⋯热边界条件 Training Manual

?几种常见的对流系数可以从一个样本文件中导入。新的对流系数可以保存
在文件中。
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热分析

⋯热边界条件 Training Manual

?辐射 : 
–施加在面上 （二维分析施加在边上）

4 4 

–式中：

QR  FA Tsurface Tambient

? σ=斯蒂芬一玻尔兹曼常数
?  ε  =放射率
?  A = 辐射面面积
?  F = 形状系数 （默认是 1）

–只针对环境辐射，不存在于面面之间（形状系数假设为 1）
–斯蒂芬一玻尔兹曼常数自动以工作单位制系统确定
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热分析

D. 求解选项 Training Manual

?从 Workbench toolbox 插入 Steady-State Thermal 将
在 project schematic 里 建 立 一 个 SS Thermal 
system （ SS 热分析）

?在 Mechanical 里，可以使用 Analysis Settings 为热
分 析设置求解选项。

–注意，第四章的静态分析中的 Analysis Data Management 选项在这里也可以
使用。
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热分析

⋯ 求解模型 Training Manual

加的结构载荷和约束。
–求解结构

?为了实现热应力求解，需要在求解时把结构分析关联到热模型上。
?在 Static Structural 中插入了一个 imported load 分支，并同时导入了施
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热分析

?后处理可以处理各种结果：
–温度
–热通量

–反作用的热流速
–用户自定义结果

?模拟时，结果通常是在求解前指定，但也可以在求解结束后指定。
–搜索模型求解结果不需要在进行一次模型的求解。

E. 结果和后处理 Training Manual
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热分析

?温度：
–温度是标量，没有方向

⋯ 温度 Training Manual
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热分析

?可以得到热通量的等高线或矢量图：
–热通量 q 定义为

q KXX T
–可以指定 Total Heat Flux （整体热通量）和

Directional Heat Flux （方向热通量）

? 激活矢量显示模式显示热通量的大小和方向

⋯ 热通量 Training Manual
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热分析

?对给定的温度、对流或辐射边界条件可以得到响应的热流量：
–通过插入 probe 指定响应热流量 ，或
–用户可以交替的把一个边界条件拖放到 Solution 上后搜索响应

从 Probe 菜单
下
选择

或

拖放边界条件

⋯ 响应热流速 Training Manual
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热分析

?作业 6.1 –稳态热分析
?目标：
–分析图示泵壳的热传导特性

F.作业 6 –稳态热分析 Training Manual
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热分析

Workbench - Mechanical 
Introduction

作业 6.1

稳态热分析

WS6.1-1 



WS6.1: Steady State Thermal Analysis

WS6.1-2

作业 6.1 –目标 Workshop Supplement

?本作业中，将分析下图所示泵壳的热传导特性。
? 确切说是分析相同边界条件下的塑料（ Polyethylene ）泵壳和铝（

Aluminum ）泵壳。
?目标是对比两种泵壳的热分析结果。



WS6.1: Steady State Thermal Analysis

WS6.1-3

作业 6.1 –假设 Workshop Supplement

假设：

?泵上的泵壳承受的温度为 60 度。假设泵的装配面也处于 60 度下。
?泵的内表面承受 90 度的流体。
?泵的外表面环境用一个对流关系简化了的停滞空气模拟，温度为 20 度。



WS6.1: Steady State Thermal Analysis

WS6.1-4

?打开 Project 页
? 从 Units 菜单上确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV)
–选择 Display Values in Project Units

作业 6.1 – Project Schematic Workshop Supplement
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WS6.1: Steady State Thermal Analysis

⋯作业 6.1 – Project Schematic Workshop Supplement

2. 在 Geometry 上点击鼠标右键
选
择 Import Geometry ，导入文
件 Pump_housing.x_t

2.

1. 在 Toolbox 中双击 Steady-
State Thermal 创建一个新的
Steady State Thermal （稳态
热分析）系统。

1.



WS6.1-6

WS6.1: Steady State Thermal Analysis

⋯作业 6.1 – Project Schematic Workshop Supplement

3. 双击 Engineering Data 得到
material properties （材料特性）

WS6.1-6

4. 选中 General Materials 的同时，点击
Aluminum Alloy 和 Polyethylene 旁边
的 ‘+’符号，把它们添加到项目中。

5. Return to Project （返回到项目）

4.
5.

3.



WS6.1: Steady State Thermal Analysis

⋯作业 6.1 – Project Schematic Workshop Supplement

WS6.1-7

6. 把 Steady State
Thermal 拖放到第一
个系统的
Geometry 上。
– 在生成性的系统前，
在拖放盒中应包含
A2 和 A3 子模块

? 完成后，在
schematic 中将图
形 显示如图所示的
共享 数据（现在出
现两个 系统： A 和
B）

6.



WS6.1: Steady State Thermal Analysis

⋯作业 6.1 – Project Schematic Workshop Supplement

WS6.1-8

7. 在第一个系统 A 中，双击 Model 打开
Mechanical application.

8. 在 Units 菜单中选择：
–Metric (mm, kg, N, s, mV, mA)
–Celsius (For Metric Systems)

7.

8.



WS6.1-9

WS6.1: Steady State Thermal Analysis

作业 6.1 –前处理 Workshop Supplement

9. 改变 material 并对泵壳进行网格划分
（Part 1）：
a. 选中 geometry 下的 Part 1
b. 在 details of Part 1 上导入材
料 polyethylene

c. 选中 Mesh ，设置 relevance （相关系
数）为 100.

c.

a.

b.
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WS6.1: Steady State Thermal Analysis

作业 6.1 –环境 Workshop Supplement

10. 施加温度载荷（选中）：
a. 选择泵壳的内表面（ 13 个面）（提示：使

Extend To Limits 选择方

b. RMB （点击鼠标右键选择） > Insert > 
Temperature.

c. 把 Magnitude 设为 90 度

d. 选择泵壳装配面
e. RMB（点击鼠标右键选择） >

Insert > Temperature
f. 把 Magnitude 设为 60 度

f.

a. b.

c.

e.

d.



WS6.1-11

WS6.1: Steady State Thermal Analysis

11. 施加 Convection （对流载荷）： a. 
b.

a. 选择泵壳的外表面（ 32个面） （提示：使用
extend to limits 选择方式）

b. RMB（点击鼠标右键选择） > Insert >
Convection

c. 在 Details of Convection 中点击
Film Coefficient 选择 Import . . .

确定导入对流载荷 convectionsd. 导入 Stagnant Air – Simplified 
Case

e. 把 Ambient Temperature 设为 20 度

c.
d.

e.

Workshop Supplement. . .作业 6.1 –环境



WS6.1-12

WS6.1: Steady State Thermal Analysis

作业 6.1 –求解模型
A

Workshop Supplement

12.求解模型 12.
13. 当求解结束时导入 Temperature 和 Total Heat Flux 结果（评价结果）。

? 材料为 polyethylene 的分析结果
13.
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WS6.1: Steady State Thermal Analysis

? 重复步骤 10 和 11 给模型
B 施加同样的边界条件

? 重复步骤 12 和 13 求解和
查看模型 B 的结果

14.在 project schematic 上
双击 B 系统中的 Model 打
开 Mechanical
application 窗口

14.

? 重复步骤 9 （a 到 c） 选
择材料 Aluminum Alloy

作业 6.1 –模型 B 步
骤

Workshop Supplement
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WS6.1: Steady State Thermal Analysis

?材料为 aluminum alloy 的结果

作业 6.1 –求解模型 B Workshop Supplement
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WS6.1: Steady State Thermal Analysis

. . . 作业 6.1 –后处理 Workshop Supplement

? 对比 Heat Flux （热流）：
? 选中每个模型的 Total Heat Flux 结果，并选择矢量显示方式。

激活矢量显示

控制矢量密度

WS6.1-15

Polyethylene Aluminum



WS6.1: Steady State Thermal Analysis

Workbench - Mechanical 
Introduction

第七章 线性屈

曲分析

7-1 





线性屈曲分析

7-2

简介 Training Manual

? 本章将介绍线性屈曲分析。

? 内容 :
A. 屈曲的背景知识

? 本章所述的功能，一般可用于 ANSYS DesignSpace Entra 及以上版本
的 许可。
– 本章讨论的某些选项可能需要更高级的许可，但这些都指出相应的许可。

B.  屈曲分析步骤
C.  Workshop 7-1



线性屈曲分析

7-3

A. 屈曲的背景知识 Training Manual

F

?需要评价许多结构的稳定性。在薄柱，压缩部件，和真空罐的例子中，稳
定性是重要的。

?失稳（屈曲）的结构，负载基本上没有变化（超出一个小负载扰动）会有
一个非常大的变化位移 { x}  。

稳定的 不稳定的

F



线性屈曲分析

7-4

?特征值或线性屈曲分析预测理想线弹性结构的理论屈曲强度。

–非弹性的材料响应。
–非线性作用。
–不属于建模的结构缺陷（凹陷等）。

?此方法相当于教科书上线弹性屈曲分析的方法。

–用欧拉行列式求解特征值屈曲会与经典的欧拉解一致。

?缺陷和非线性行为使现实结构无法与它们的理论弹性屈曲强度一致。线性
屈曲一般会得出不保守的结果。

?线性屈曲无法解释的问题

⋯屈曲的背景知识 Training Manual



线性屈曲分析

7-5

?尽管不保守，线性屈曲有多种优点：
–它比非线性屈曲计算省时 ,并且可以作第一步计算来评估临界载荷 (屈曲开始时的
载荷 ).

? 在屈曲分析中做一些对比可以体现二者的明显不同
–线性屈曲分析可以用来作为确定屈曲形状的设计工具 .

? 结构屈曲的方式可以为设计提供向导

⋯屈曲的背景知识 Training Manual



线性屈曲分析

7-6

?对于线性屈曲分析求解特征值要用到屈曲载荷因子 i和屈曲模态 i:

? 利用小变形理论并没有包括非线性

?重要的是要记住与进行线性屈曲分析模拟有关的这些假设。

假设 :
–[K] 和 [S] 不变 :

K i S i  0 

? 假定为线弹性材料

⋯ 线性屈曲基础 Training Manual



线性屈曲分析

7-7

?需要在屈曲分析之前（或连同）完成静态结构分析。蓝色显示的步骤是屈
曲分析特有的。
–附上几何体

–指定材料属性
–定义接触区域 (如果合适 )
–定义网格控制 (可选 )

–求解
–模型求解
–检查结果

–加入载荷与支撑

–求解静力结构分析

–链接线性屈曲分析
–设置初始条件

B. 屈曲分析步骤 Training Manual



线性屈曲分析

7-8

?与线性静力分析类似，任何 DS 支持的类型的几何体都可以使用：

?尽管模型中可以包含点质量，但是由于点质量只受惯性载荷的作用，因此在应用中有
一些限制。

?材料属性，杨氏模量和泊松比是必须有的。

–实体
–壳体 (确定适当的厚度 )
–线体（定义适当的横截面）

? 只有屈曲模式和位移结果可用于线体。

⋯ 几何体和材料属性 Training Manual



线性屈曲分析

7-9

?屈曲分析中可以定义接触对。但是，由于这是一个的线性分析
，因此接触行为不同于非线性接触类型 :

? 前提讨论 (见表 5)。

Contact Type
Linear Buckling Analysis

Initially Touching Inside Pinball Region Outside Pinball Region
Bonded Bonded Bonded Free 
No Separation No Separation No Separation Free 
Rough Bonded Free Free 
Frictionless No Separation Free Free 

⋯ 接触区域 Training Manual



线性屈曲分析

7-10

至少有一个导致屈曲的结构载荷，以适用于模型：

F x λ = 屈曲载荷

屈曲分析所有施加载荷（ F）与载荷
因子 (λ)相乘得到屈曲得到临界载荷

?至少要施加一个能够引起结构屈曲的载荷 :
–所有的结构载荷都要乘上载荷系数来决定屈曲载荷，因此不支持不成比例或常值的载荷 (
参考下一张幻灯片 )

–不推荐只有压缩的载荷

–结构可以是全约束，在模型中没有刚体位移 .

⋯ 载荷与支撑 Training Manual



线性屈曲分析

7-11

?如果接触和比例载荷存在应特别考虑。–用户可以对屈曲结果进行迭代，调整可变载荷直到载荷乘数变为 1.0 或接近 1.0.
–以自重 WO并施加一外力 A 得柱子为例。

–当调整 A 的值到 = 1.0，结果可以达到叠加。这保证自重 =真实重量或 WO  * 
WO 。

⋯ 载荷与支撑 Training Manual



线性屈曲分析

7-12

在项目图表中屈曲分析经常与结构分析进行耦合。
–在分支中的“ Pre- Stress ”项包含结构分析的结果。
–在线性屈曲分支下的 “Analysis Settings ”的详细介绍允许用户指定找到的屈 曲
模型的代号。

⋯ 设置屈曲 Training Manual



线性屈曲分析

7-13

?建立屈曲分析模型后可以求解除静力结构分析以外的分析。
–线性屈曲分析计算机的使用率比相同模型下的静力分析高。
–The “Solution Information ”分支提供详细的求解输出。

⋯ 求解模型 Training Manual
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线性屈曲分析

⋯ 检查结果 Training Manual

?求解完成后，可以检查屈曲模型：
–每个屈曲模态的载荷因子显示在图形和图表的详细查看中，载荷因子乘以施加
的载荷值即位屈曲载荷。

F 屈 = (F 施加 x 
) 
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线性屈曲分析

⋯ 检查结果 Training Manual

?载荷因子 ( ):
–下面塔模型求解了两次。在第一种情况施加单位载荷。第二个施加预测的载荷
（见下页）
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线性屈曲分析

⋯ 检查结果 Training Manual

?载荷因子 ( ):

BucklingLoad * Actual _ Load

 BuclingLoad   Safety_ Factor 
Actual _ Load

BucklingLoad * Unit _ Load

BucklingLoad 



7-17

线性屈曲分析

⋯ 检查结果 Training Manual

?屈曲载荷因子可以在 “线性屈曲分析 ”分析分支下 “Timeline ”的结果中进行
检查。

–这是求解多个屈曲模态的一个很好的方法，以便观察结构屈曲在给定的施加载
荷下的多个屈曲模态。



线性屈曲分析

C. Workshop 7.1 –线性屈曲 Training Manual

? Workshop 7.1 –线性屈曲
?目标 :
–验证下图管道模型的线性屈曲仿真结果。 与使用手册上的计算结果进 行比
较。

7-18



Workbench - Mechanical 
Introduction

作业 7

线性屈曲分析

WS7.1-1 



WS7.1: Linear Buckling

WS7.1-2

作业 7.1 –目标 Workshop Supplement

? 本作业的目标是在 ANSYS Workbench 中审查线性屈曲结果，并同手册中
的封闭形式的解进行对比。

? 然后给模型施加一个 10,000 lbf 的力，并给出它的安全因子。
?最后，确定结果在屈曲发生前不会发生破坏失效。



WS7.1: Linear Buckling

WS7.1-3

作业 7.1 –假设 Workshop Supplement

P' K ? L2 

?对于一端固支，一端自由的梁来说，参数 K = 0.25。

?模型是一个钢管，假设一端固定而另一端自由，且在自由端施加了 一个
纯压力。管子的尺寸和特性如：

? OD = 4.5 in ID = 3.5 in. E = 30e6 psi, I = 12.7 in^4, L = 120 in.
?此例中，假设管道符合手册中的下列公式，其中 P是临界载荷：

2 ?E I 



WS7.1: Linear Buckling

WS7.1-4

P'  0.25 ?
(120)2  65648.3lbf

?根据上一页给出的公式和数据可以推导出屈曲载荷为：

2 ?30e6 ?12.771

. . . 作业 7.1 –假设 Workshop Supplement



WS7.1: Linear Buckling

WS7.1-5

1. 双击 Toolbox 下的 Static Structural
创建一个新系统

1.
2. 把 Linear Buckling 系统拖放到

static structural 系统中的 Solution
模块

2.

作业 7.1 – Project Schematic Workshop Supplement



WS7.1: Linear Buckling

WS7.1-6

?当 schematic 设置正确时，它将显示如下：

? 上一页的 drop target （拖放目标）表示了拖放操作的结果。 A 系统中的 A2
到 A4 是和系统 B 共享的。同样把 solution (A6) 移到系统 B 设置中。 实际
上，结构进行的是屈曲分析。

“Drop T arget ”

. . . Workshop 7.1 – Project Schematic Workshop Supplement



WS7.1-7

WS7.1: Linear Buckling

. . .作业 7.1 – Project Schematic Workshop Supplement

?确定项目单位设为 US Customary (lbm, in, s, F, A, lbf, V)
?确定选择了 Display Values in Project Units



WS7.1: Linear Buckling

. . .作业 7.1 – Project Schematic Workshop Supplement

3. 在 static structural system (A) 上双击
Engineering Data 3.

4. 为了于前面提到的手册中的计算结果匹
配，改变 structural steel 的
Young’sModulus （杨氏模量）
a. 选中 Engineering Data a.

b. 选中 Structural Steel
c. 展开 Isotropic Elasticity ， 修改 Young’s

Modulus 为 3.0E7 psi. b.

? 提示：在 Engineering Data 中改变它的特性，是不
会对一般材料库中 Structural Steel 的值有影响的。
为了将来使用某种材料，需要使用 Export 把它的
特性作为一个新材料导入到材料库中。因为本作业只
需要它的值，故不需要进行上面的操作。

c.
WS7.1-8



WS7.1: Linear Buckling

. . .作业 7.1 – Project Schematic Workshop Supplement

5. 在 A 系统 static structural 的
Geometry 上点击鼠标右键选择
Import Geometry 导入文件
Pipe.x_t

6. 双击 Model 启动 Mechanical.

WS7.1-9

6.

?当 Mechanical application 打开时，
project
schematic 会随着改变设置。

5.



WS7.1: Linear Buckling

WS7.1-10

作业 7.1 –前处理 Workshop Supplement

7. 把作业单位制系统设为 U.S. customary system:
a. U.S. Customary (in, lbm, psi, °F, s, V, A).

8. 给管道施加约束：
a. 选中 Static Structural (A5).
b. 选择管道的一个端面 a.
c. RMB（点击鼠标右键选择） > Insert > Fixed 

Support （固定约束）

b.

a. c.



WS7.1: Linear Buckling

作业 7.1 –环境 Workshop Supplement

WS7.1-11

c.

d.
b.

9. 施加屈曲载荷：
a. 选择管道的另一端面
b. RMB（点击鼠标右键选择） > Insert > Force
c. 在 details of force 中把 Define by 设为

Components
d. 在 details of force 中给 Magnitude 下的 Z 

Component

a.



WS7.1: Linear Buckling

WS7.1-12

. . .作业 7.1 –环境 Workshop Supplement

10. 求解模型：
a. 选中 Linear Buckling (B6) 下的 Solution ，点击 Solve

? 注意，这将自动启动上面的静态结构分析

11. 当求解完成时：
a. 选择 Solution (B6)

– Timeline （时域图）和 Tabular Data （数据表） 给出
了 一阶屈曲模态（更多模态也可以得到）

b. 在 Timeline 上点击鼠标右键选择 Select All a.
c. 点击鼠标右键选择 Create Mode Shape Results 
（添 加 Total Deformation 分支）

c.

b.a.
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作业 7.1 –结果 Workshop Supplement

– 点击 Solve 查看一阶模态

WS7.1-13

? 醒一 ， 于施加的是单位 ， 此结果与闭合 65648 lbf 合很 。
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. . .作业 7.1 –结果 Workshop Supplement

12. 改变载荷为 10000 lbf ：
a. 选中 Static Structural (A5) 下的 Force
b. 在 details of force 中改变 Z Component 值
为 10000.

13. 求解：
a. 选中 Linear Buckling (B6) ，并点击鼠标右键选
择 Solve

11a.

12a.
11b.

WS7.1-14
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WS7.1-15

. . .作业 7.1 –结果 Workshop Supplement

? 当求解结束时，在 Load Multiplier 中给出了一个值 6.56。因为现在施加的
是实际应用中的力，故这个载荷乘子即为施加载荷的屈曲安全因子。

?根据已经计算得到的屈曲载荷值 65600 lbf ，这个结果明显没有价值（
65600 / 10000）。在这里给出只是为了分析的完整性。
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WS7.1-16

作业 7.1 –验证 Workshop Supplement

?此例屈曲分析中添加了最后一步，作为最好的实践练习

?已经得到了预期的屈曲载荷和所加载荷的安全因子。目前为止，这个结果
只针对屈曲失效，因此无法判断屈曲载荷对结构的应力和变形有什么影响
。

? 选择一个不会导致过大应力和变形的载荷 10000 lbf
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WS7.1-17

14. 查看 10,000lbf 载荷下的应力结果：
a. 选中 Static Structural (A6) 下的 Solution
b. RMB （点击鼠标右键选择） > Insert > Stress >

Equivalent （Von-Mises ）
c. RMB（点击鼠标右键选择） > Insert > 

Deformation > Total.
d. 求解

c.

b.

. . .作业 7.1 –验证 Workshop Supplement

a.
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WS7.1-18

?快速查看应力结果，发现模型没有超过使用材料的力学极限（
Engineering Data 给出抗压极限为 36,259 psi ）

? 正如说的那样，这不是屈曲分析中的必要步骤，但是很好的工程锻炼 。

. . .作业 7.1 –验证 Workshop Supplement
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第八章 结

果后处理

8-1 



Results Postprocessing

8-2

概述 Training Manual

?在本章里，将介绍后处理部分的内容：
A. 查看结果
B. 区域结果显示
C. 输出结果

H. 收敛性

?本章本节描述的应用都能在所有 ANSYS 版本中使用，除了注明不可以使用
的版本。

D. 坐标系和指定方向的结果分量
E. 组合求解
F. 应力奇异性
G. 误差评估
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8-3

动画工具

A. 查看结果 Training Manual

? 当选择了一个结果项后， 上下文工具栏显示了查看结果的方式：

矢量显示控制

?另外， Timeline 也有一个 栏，它允许用户设置动画控制

分布
输出

播放 暂停 图标 帧速率控制

最大 /最小 Probe

显示比例 显示方法 云图设置 纲要显示
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8-4

? 对于结构分析 （静态、模态、屈曲分析），可以改变变形形状：
–默认的是一个标量（ multiplies ）乘上实际的位移。
–用户可以改为真实比例或显示未变形的模型图

⋯ 位移比例 Training Manual

真实比例自动选择的位移比例
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8-5

?在图形区的图例上点击鼠标右键，可以调整图例控制。
值编辑

输出、输入或保存图例设置

增加或减少等高线带 水平或垂直放置图例

显示日期和时间

选择对数比例 在图例中显示最大最小图标

切换到科学计数法
有效数字位数

?然后⋯⋯

图例控制 Training Manual
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8-6

利用图例边界可以更清楚地显示出等高线图的 结果
分布。

没有改变最大最
小值

点击并拖放等高线分配器（或键盘输 入一个
值）来指定等高线范围。

也可以使用非均匀分布的等高线。

⋯ 图例控制 Training Manual
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? Independent Bands （独立带） 使用中性色来代表高于或低于指定图例限
制的模型区域。

图例等高线范围

⋯ 图例控制 Training Manual
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Exterior IsoSurfaces

? Geometry 按钮控制着等高线显示方式。有四种可选选择：

Capped IsoSurfaces
Slice Planes

“Exterior ”（外观图）是
默认的显示选项，而且是
最常用的。

“IsoSurfaces ”（等值面）
对现实具有相同值的区域
很有用。

“Capped IsoSurfaces ”
（上限等值面）将删除模
型中高于（或低于）一个
指定值的区域。

“Slice Planes ”（切面）
让用户可以从视觉上穿过
模型。同样可以使用
capped slice plane （上
限切面） 如左图所示。

⋯ 显示方式 Training Manual
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8-9

? Capped IsoSurfaces 通过独立菜单控制操作
–允许进行 isosurface, top 或 bottom capped 绘图

–图例中做记号的区域表示该区域不被显示
–分界值通过调整滑块或者直接输入数值来控制

底部封顶等值面顶部封顶等值面

⋯ 显示方式 Training Manual
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? Contours 按钮控制着模型上的等高线显示形式
Smooth Contours

（平滑等高线）

Contour Bands

（等高线带）

Isolines

（等值线）

Solid Fill

（实芯填充）

⋯ 等高线设置 Training Manual
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? Edges 按钮允许显示未变形前的几何或单元

Show Elements

（显示单元）
Show Undeformed Model

（显示未变形的模型）

No WireFrame

（无线框）

Show Undefined WireFrame

（显示未变形的线框）

⋯ 纲要显示 Training Manual
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截断面
Training Manual

?在前、后处理器中都可以添加和编辑截断面。
–选择 Draw Section Plane ，然后用鼠标左键点击并拖放该图 标，就可以获得
一个截断面。

– 在细节窗口中，可以通过复选框开启或关闭截断面。
–使用删除图标删除截断面。
–通过选中需要的截断面名称后，再使用图形窗口中操纵器来编
辑截断面。

通过拖动操纵起来移动一个切面 Sliced view 前处理器中的几何模型

Sliced view 结果后处理中的模型

点击操纵器的一边，进行上限等
高线查看

8-12
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Probe 工具 Training Manual

? Probe 工具允许指定特定位置的结果并使其参数化。
? Probe 工具可限定于几何模型，局部坐标系或使用远程 点来指
定。

?结果的方向可以以整体或局部坐标系指定。



Results Postprocessing

. . . Probe 工具 Training Manual

? Probe 工具示例：
–如图定义局部坐标系
–Probe 设置在局部坐标系上
–指定所有应力结果

8-14

Probe 位置

局部坐标系



Results Postprocessing
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图形和表格 Training Manual

?把多分析步（静态或瞬态）的结果数据联合成图形或表格的形式：
–选择 New Chart and Table 图标
–在 details of Multiple Selection 中选中需要的结果。

? 按住 CTRL 键选择多个结果

–在 details of Multiple Selection 中选择需要显示的项目。
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动画控制 Training Manual

? Animation 工具可以播放、暂停和停止动画显示

? 提示：通过图形屏幕底部的 Timeline 得到动画

开始 /暂停 /停止 控制分辨率和速度

当结果设置为动画显示求解点时，可以进行分布式 输出影音文件

动画插值结果。

注意：在播放过程中可以使用暂停功能
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? Alert （报警器）是一种简单的检查方式，查看是否有一个标量结果值满足
标准：
–Alerts 可以在等高线结果 (contour results ) （除了矢量结果）， 接触结果（

Contact Tool results ）和形状搜索上使用（ Shape Finder ）。
–选中特定的结果项，点击鼠标右键选择插入 Alert （报警器）。
–在细节窗口中，指定标准值。

–在大纲树下，一个绿色对号表示符合标准，一个红色惊叹号表示不符合标准。

⋯ Alert Training Manual
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?矢量图包含了任意结果的大小和方向，如挠度，主应力和主应变，以及热
通量。
–通过矢量图形图标激活适量大小的矢量。

–一旦矢量可见，可以通过矢量显示控制改变它们的外观。（见下一页的示例）

矢量长度控制 矢量密度控制

比例矢量 等长度矢量 单元对齐 网格对齐 线形式 实体形式

⋯ 矢量图 Training Manual
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?示例

实体形式，等长度等长度

比例长度实体形式，网格对齐

⋯ 矢量图 Training Manual
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? 多个视窗能够同时显示各种图片（模型或后处理结果） 。
–有利于对比多个结果，如不同环境得到的结果或多个模态形状

⋯ 多视窗 Training Manual
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?在后处理中，显示限定结果很有用：
–指定自动缩放选定区域结果的图例。

?指定等高线结果：
–先选中几何模型，然后指定感兴趣的结果。
–没有选中的几何模型将显示成半透明的。

B. 指定结果 Training Manual
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⋯ 指定面或部件上的结果 Training Manual

?指定面或部件上的结果示例：

8-22

所选面上的应力结果

指定单个部件上的结果

单个部件上的主应力矢量
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⋯ 指定边和点上的结果 Training Manual

?可以指定单个边（或点）上的结果：
–为指定结果选择一条独立边 .

–将显示出映射到边上的结果路径图。
?对一个图形使用 Worksheet 查看，只显示路径图。
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. . . 指定一条路径上的结果 Training Manual

8-24

?结果可以映射到按以下方式定义的路径上：
?一个坐标系统（或多个坐标系统）
?存在的几何模型（边或点）
?存在的点
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?使用结构几何建立路径。
?通过坐标系，模型边或存在的点定义路径。
?示例：

. . . 指定一条路径上的结果 Training Manual



Results Postprocessing

. . . 指定一条路径上的结果 Training Manual

8-26

?可以以图形形式显示路径结果。
? X轴可以代表路径位置（ S）或时间（瞬态分析）。
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?一个线性应力计算可以使用路径显示特点来显示（通常使用各种结构代码
如 ASME 表示）

. . . 线性应力 Training Manual
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Results Postprocessing

C. 输出结果 Training Manual

?输出 Worksheet （工作表）标签信息：
–选择需要的选项并点击 Worksheet 标签
–用鼠标右键点击相同选项，并选择 “Export ”

?输出等高线结果：

输出 Worksheet 输出结果

输出表格

–用鼠标右键点击感兴趣的结果项并选择 “Expo rt ”.
?模拟中的表格数据可以输出到电子表格中：
–选择要输出的模块
–点击鼠标右键选择 Copy cell ，复制模块中的所有数据
–粘贴到电子表格中
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Results Postprocessing

⋯ 输出结果 Training Manual

? 为了在结果输出中包含节点的位置和矢量方向，需要把 Include Node
Location 选项改为 Yes ，通过 “Tools menu > Options ⋯  > Simulation:
Export ”实现。
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Results Postprocessing

?指定分量的结果可以映射到局部坐标系下：
–从细节窗口中的下拉菜单中选自定义好的坐标系

–指定方向的变形、正应力（应变）、切应力（应变）和指定方向的热通量可以
使用坐标系统。

D. 坐标系统 Training Manual
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Results Postprocessing

? 对于下图所示模型，在局部柱坐标系中的显示结果，同时把应力结果转换到了该 系
统下。

在整体坐标系下 Y 方向上的应
力

在局部柱坐标系下 Y 方向上的应
力

⋯ 坐标系统 Training Manual
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?在 project schematic 中，复制 Model 后面的分析模块（ Setup ，
Solution
或 Result ） ，允许创建组合求解来快速评价组合结果。

? 组合求解只是用于线性静态结构分析 。
?不同环境下的约束也应该是一样的（只有加载可以改变）。
? ANSYS Professional 或更高版本。

E. 组合求解 Training Manual
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Solution Combination = Coeff 1 * Environment 1 + Coef 2 * Environment 2 + . . .

选中 Model 的同时，可以在主菜单下选择一个 Solution
Combination （组合求解）
在新出现的分支中可以指定和搜索组合结果。

选中 Solution Combination 时， worksheet 查看允
许 组合多个环境。提示：在组合中可以包含一个乘子
（见 下面）。

. . .组合求解 Training Manual
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在这里的简单示例中， 2 个环境包含 着
等大反向的载荷。组合的结果肯 定就
是 0。

组合

⋯ 组合求解 Training Manual
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?在大多数有限元分析中，采用加密网格划分的目的是为了获得更加精确的
数值结果。
–直接求解得到的值（自由度），如位移和温度，通常都容易收敛。

–当网格加密时，派生值，如应力、应变和热通量也应该是收敛的，但不如自由
度那样容易。

–有些时候，当网格加密了，这些派生值仍然不收敛，甚至可能出现偏离。
–这些情况，有时是应力奇异性导致的结果。

Force
Area

As Area Zero

F. 应力奇异性 Training Manual
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?在线性结构分析中，下面几种情况可能导致人为高应力：

理想化的几何 点约束 点载荷

?在上面情况中，在认为高应力区域加密网格，仍将保持应力的提高。

⋯ 应力奇异性 Training Manual
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?补救措施：
–如果奇异性没有出现在感兴趣的区域，通常就可以指定感兴趣区域的结果。

–如果奇异性出现在感兴趣的区域，可以通过下面几种方法获得更精确的应力 结
果：

? 带有倒角或其它细节处理的几何模型，它不会导致几何不连续。
? 把力或约束施加在面域上而不是加在点上。

点加载 分布加载

示例

⋯ 应力奇异性 Training Manual
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?可以插入一个基于应力（结构分析）或热通量（热分析）的误差结果，帮
助确定高误差的区域（见下一页的示例）。

?这些区域显示，模型通过在该区域进行更加密的网格划分，可以获得更加
精确的结果。

?如果采用了收敛控制，高误差区域也显示了什么地方需要进行加密控制。

G. 误差评估 Training Manual
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?误差图显示了具有高能量单元的区域
，在这些地方加密网格可以提高结果 的
质量。

?在薄板示例中，初始求解得到高能量 区域出现在 2
个空洞之间。

?加密网格（底部的图）显示了局部误 差
的降低 。

?请注意，误差是一个相对方法，即单
元之间的比较。能量的实际值一般不
重要。

. . .误差评估 Training Manual
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?因为网格加密了，显然数值模型变得更精确。然而，存在于细密网格相关
的计算成本问题。

?要获得一个优秀的网格，需要如下条件：
–需要一个标准来确定网格是否已经足够好。
–只在需要的地方划分更多的单元。

?手动执行这些任务是繁琐而不精确的：

? Convergence controls （收敛控制）不能使用在所有结果项上。

–用户可能不得不人工加密网格、重新求解后再对比前面的求解结果。

?模拟时可以选择收敛控制，根据用户定义的一个精度水平自动进行网格自
动加密。

H. 收敛性 Training Manual
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⋯ 收敛性 Training Manual

? 选中一个结果项，然后点击鼠标右键选择 Insert > Convergence ：
–选择 convergence 的最大最小值和允许的变化（默认是 20%）。
–在 Details of Solution 中，输入最大加密循环的值。

?输入一个可行的值，如 1 到 4 之间的数，这样模拟时不会尝试无限期的进行网格加密。
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⋯收敛性 Training Manual

?模拟过程将自动加密网格和重新求解：
–至少需要两次迭代步 （初始求解和第一个加密循环）

–最大加密循环的值控制着允许的迭代步数（ 2到 4 个循环一般就 可
以了）。

–基于误差的近似技术，网格在有必要的区域进行自动加密。

–收敛状态在 “Convergence ” 上显示成 :
?  不受敛： 出现一个红色惊叹号

?  收敛： 显示出一个绿色对号

–只显示左后求解得到的结果
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⋯ 收敛性 Training Manual

?在求解结束后，可以查看结果和最终的网格：
–注意，只在高应力区域进行网格加密，如下所示例子。
–Convergence （收敛）给出了每个加密循环的趋势。

Convergence

收敛

Divergence

发散
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?除了添加删除应力奇异性的细节，还可以在指定结果上进行收敛控制。
?如果对人为的高应力区域不感兴趣，可以指定所选部件或面上的结果，并
只对这些结果进行收敛控制：
–对需要进行网格加密的地方提供控制

可能出现应力奇异性的地方

感兴趣区域

–忽略不感兴趣的人为高应力区域

–示例：

⋯收敛性和指定结果 Training Manual
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⋯收敛性和指定结果示例 Training Manual
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在指定结果上的收敛控制，允
许只在用户指定位置处进行自
动加密

提供更多关于网格划分和自动
求解的控制

实现感兴趣区域的精确应力

施加在整个模型上的收敛控制

几何不连续导致应力奇异性出
现分歧

由于存在应力奇异性，导致求
解变得很费时
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I. 作业 8.1 –高级结果后处理 Training Manual

?作业 8.1 –结果后处理
?目标：
–分析下面所示的高压排气组件，然后使用高级后处理特点来查看应力
和变形结果。



Workbench - Mechanical 
Introduction

作业 8.1

结果后处理

WS8.1-1 



WS8.1: Results Processing

WS8.1-2

作业 8.1 –目标 Workshop Supplement

?本作业分析了一个高压排气组件的应力和挠度。
?如果在结果后处理（ postprocessing ）中所有部件都激活的话，部分分析
结果很难得到解释。我们的目标是分离模型的部件，使用先进的
Workbench-Mechanical 特性进行结果后处理。
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WS8.1-3

作业 8.1 –假设 Workshop Supplement

?假设：气体是由进气管到膨胀室被排出的。在膨胀室内部，压力比进气管
处降低了 20%。

?膨胀室是刚性连接在进气管上的，因此把这里的接触定义为 bonded 。
?支架允许管子出现有限的移动，因此这里使用无分离接触。
–查看下一页的接触描述

?用结构钢（ structural steel）模拟进气管和支架，而膨胀室是橡胶
（ Polyethylene ）。



WS8.1: Results Processing

WS8.1-4

Expansion 
Chamber
（ 膨 胀
室）

Bonded Contact

（结合接触）
Support Bracket

（支架）

No Separation
Contact

（无分离接触）

Inlet Pipe

（进气管）

作业 8.1 –部件和接触描述 Workshop Supplement
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WS8.1-5

?打开 Project 页
?在 Units 菜单中确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV)
–选择 Display Values in Project Units

作业 8.1 – Project Schematic Workshop Supplement



WS8.1: Results Processing

WS8.1-6

1. 在 Toolbox 中双击 Static Structural
创建一个新系统

1.

2. 双击 Engineering Data 得
到 material properties.

2.
3. 在 General Materials 中点击

Polyethylene 旁的‘+’符号，把材
料 添加到当前系统

3.

⋯ 作业 8.1 – Project Schematic Workshop Supplement



WS8.1: Results Processing

WS8.1-7

）4. Return to Project （返回到项目

5. 在 geometry 上点击鼠标右键选择
Import Geometry ，导入文件
Pressure_System.x_t

6. 双击 Model 打开
Mechanical
application

6.

. . . 作业 8.1 – Project Schematic Workshop Supplement

4.

5.
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WS8.1-8

7. 设置作业单位制系统：
? Units > Metric (mm, kg, N, s, mV, mA)

8. 改变 expansion chamber 的材料：
a. 选中该膨胀室部分
b. 在 details of solid 窗口中点击 material 栏，改变

material assignment 为 Polyethylene

a.

b.

作业 8.1 –前处理 Workshop Supplement

7.
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WS8.1-9

9. 根据管的接触行为修整支架：
a. 选中 Connections 下的 Contact Region 2
b. 在 Details of Contact Region 2 窗口改变接触类型为 No Separation

b.

a.

. . .作业 8.1 –前处理 Workshop Supplement
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WS8.1-10

10. 给管道施加一个压力：
a. 选中 Static Structural (A5)
b. 选择管道的 5个内表面 （提示：使用 Extend

to limits）

c. RMB（点击鼠标右键选择） > Insert >
Pressure

d. 输入 Magnitude 值 1MPa

a.

c.
b.

d.

作业 8.1 –环境 Workshop Supplement



WS8.1: Results Processing

. . .作业 8.1 –环境 Workshop Supplement

a.

11. 给 expansion chamber 施加一个压力：
a. 选择 expansion chamber 的三个内表面

?   提示：使用平面选择，状态栏和 CTRL键可以简化选择。
? 交替选择 expansion chamber ，并点击鼠标右键选择 Hide All Other Bodies ，隐藏其它实体。

b. RMB （点击鼠标右键选择） > Insert > Pressure.
c. 给 Magnitude 输入一个值 0.2MPa.

WS8.1-11

c.

b.
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. . .作业 8.1 –环境 Workshop Supplement

12. 给 pipe 施加约束：
a. 选择管的端面 a.– RMB （点击鼠标右键选择） > Insert >

Fixed Support （固定约束）

13. 给 bracket （支架） 装配孔施加约束
：
a. 选择支架上的圆柱面
b. RMB （点击鼠标右键选择） > Insert > 

Cylindrical Support （选择默认的
fixed, fixed, fixed ）（固支）

a.

b.

WS8.1-12
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. . .作业 8.1 –环境 Workshop Supplement

WS8.1-13

a.

14. 给 bracket 背面施加约束：
a. 选择 bracket 的背面
b. RMB（点击鼠标右键选择） > Insert > 

Frictionless Support （光滑约束）

a.

14. 求解模型：
a. 点击 Solve.

b.



WS8.1: Results Processing

WS8.1-14

作业 8.1 –求解 Workshop Supplement

16. 查看结果：
a. 选中 Solution (A6)
b. RMB（点击鼠标右键选择） > Insert > Stress > Equivalent （Von-Mises ）
c. RMB（点击鼠标右键选择） > Insert > Deformation > Total.

c.

d. Qiujie

a.

b.

d.
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WS8.1-15

作业 8.1 –结果 Workshop Supplement

? 当求解结束时，选择查看两个结果对象。注意整体变形图对组件的 inlet pipe 和
support  bracket 部分的细节显示很少。
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WS8.1: Results Processing

. . .作业 8.1 –结果 Workshop Supplement

17. 查看 expansion chamber 的整体变形：
a. 选中 Solution (A6)
b. 选择实体选择模式，并在图形窗口中选中 expansion chamber
c. RMB（点击鼠标右键选择） > Insert > Deformation > Total

– 重复该步骤选择 Stress > Equivalent (von-Mises)

? 重复以上步骤对余下两个部件进行同样的操作。
? 再次求解，并更新结果。

c.

b.
a.
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WS8.1: Results Processing

. . .作业 8.1 –结果 Workshop Supplement

?对比整体结果和独立结果（如下图）。注意在独立结果查看中增加了细节
显示。
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WS8.1: Results Processing

. . .作业 8.1 –结果 Workshop Supplement

18. 添加一个截面：
a. 选择查看 expansion chamber 的应力结果，然后旋转模型并从 Z 方向查看图
形（如下图）

? 提示： 屏幕底部的黑框可以便捷的改变模式。

b. 点击 New Section Plane 图标，并按住鼠标左键在图中央绘制一条直线。
? 提示：现在，Section   Planes 框中插入了所定义的截面。

b. 添加新截面

a. 删除截面

显示所有单元
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WS8.1: Results Processing

. . .作业 8.1 –结果 Workshop Supplement

–旋转模型来查看截面。
– 通过选中截面和点击出现的句柄的任意端虚线，可以激活截面任意边的结果图
形。注意此时虚线变成了实线。此即一个切换控制。

– 句柄中心的蓝色方框允许平面被拖动。

句柄
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WS8.1: Results Processing

作业 8.1 –截面注释 Workshop Supplement

?可以根据需求建立截面，而且每个都是单独编辑的。 这对类似绘制 1/4 部
分的结果图的时候很有用。

? 在 Section Planes 窗口，通过取消截面名前的复选， 可以隐藏
一个截面。

?通过拉出几何类型图标选择 exterior ，从 section
plane （截面）查看返回到 exterior （外部）查看。
截面仍然保留在现在的位置，任何需要的时候都可以
激活它。。

?不论几何图标是怎么设置的，包含截面的图像都将显
示出截面。
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WS8.1: Results Processing

. . .作业 8.1 –结果 Workshop Supplement

19. 选择 IsoSurfaces （等值面） 显示：
a. 把显示类型由 Slice Planes 改为 Exterior ，并选择显示 support bracket 的

Total Deformation 。
b. 然后，再改为显示 IsoSurfaces 类型

a. b.
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第九章

CAD 模型和参数管理

9-1 





CAD and Parameters

9-2

简介 Training Manual

? 本章主要讨论 CAD 软件和参数的交互性问题。
A. CAD 的交互性
B. DesignXplorer 参数管理
C. Workshop 9-1

? 本节所述的性能普遍适用于所有 ANSYS 的许可。然而，一些 CAD 功能
是特定于某些 CAD 软件，因此这些将指定相应的许可。
– 并不是所有的 CAD 软件具有相同的功能，因此在 Mechanical 中支持与

CAD 相关的功能性上有一些不同。



CAD and Parameters

9-3

A. CAD 互用性 Training Manual

?几何接口适用于大多数商业 CAD 系统：
–关于 CAD 几何接口和支持平台的最新信息，请查看 ANSYS Workbench Mechanical
帮 助文件：

? Mechanical Help > CAD Systems
?几何接口许可对所有指令在只读模式下运行。
? 几何接口在 CAD 软件 “Associative ”列出项时要在嵌入模式下运行 .

? 请注意,并不是这里描述的所有输入能力是可以应用在所有的 CAD 系统中。功能取
决于 CAD 功能，并由 CAD 厂商的 API 提供支持。

? DesignModeler 是 workbench 几何应用程序，并支持所有的功能和商业 CAD 系统中
列出的功能。



CAD and Parameters

9-4

?有迹象表明可以从支持的 CAD 系统输入各种
项目：
–几何 , 点焊 , 参数 ,材料属性 , 等.

?要访问那些输入的参数，使用在项目图表中
的 Geometry properties 进行设置。

⋯ CAD 互用性 Training Manual
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9-5

?输入实体，面，或线体：
–可以导入实体和面体的装配体。
–选择想要的几何类型可以进行几何过滤。
–不能输入由实体和面体组成的混合零件。

?坐标系 :
–允许从 CAD 模型导入几何局部坐标系。

? Use Associativity:
–允许在不定义材料属性，载荷，约束等条件下，
在 Mechanical 中进行 CAD 几何体的更新。

?智能 CAD 更新 :
–只仅对装配体中修改的 CAD 模型进行更

⋯ 几何输入 Training Manual
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? CAD 尺寸参数可以导入到 Mechanical ：
–当“Yes” （ 默认），尺寸命名包含 parameter key( 默认
为 “DS”)将会输入到 Mechanical 中
。

–若要输入所有的参数，使得 parameter key 的 区域空
白。

–CAD 参数将会出现在对几何体的详细列表中。

⋯ 参数输入 Training Manual
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?如果“groups ”定义在 CAD 包内，它们可以

–若要输入所有 groups ，使得 named 
selection key 的空白区域。

作为 Named Selections 输入 :
–“Groups”的名字包含特定的前缀是在

Named Selection 分支中输入的（默认的
为 “NS”）。

⋯输入命名选择集 Training Manual



CAD and Parameters

9-8

? 材料属性 : 允许材料属性从支持的 CAD 系统中 输
入（看到由不同的 CAD 商支持的当前文档 的参
数）。

?材料从 CAD 输入将出现在 “Engineering

– 如果材料类型在 CAD 中改变，这将会在更新
中反应出来。– 如果材料属性 值在 CAD 中改变，这将会不更
新。

? 这阻止用户定义值在 Mechanical 重写。

Data”分支，并将指定给个人的部分。

?注意 :

⋯ 材料属性输入 Training Manual
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?更新几何体 :
–修改原来的几何体后，项目图表将显示模型为恢复

/更新状态 (RMB 完成 ).

? 刷新 : 读入新的几何模型，但是不改变有限元网
格。

? 更新 : 更新几何模型，并且重新进行网格划分。

需要恢复

恢复完成，需要更新 更新完毕

RMB 部件

更新修改几何体参数 Training Manual
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?更新参数值：
–RMB 参数值（或双击），从 “Parameter Set”到项目图表。

RMB 或双击进入参
数

参数值显示在 parameter set 的不同地
方，

均可以进行更改。

更新修改几何体参数 Training Manual
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?当参数更改完成时，回到项目。

?注意模型和几何体处于恢复 /更新状态。

?恢复 /更新几何体要发送参数信息到原来的几何体 (CAD 系统 ).
?恢复 /更新模型进行参数改变变为有限元模型。

. . .更新修改几何体参数 Training Manual
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?很大的荷载保持不变：–注意：如果在面上施加压力并且面积变化，压力的值保持不变但是施加在面上
的结果改变。

?载荷的方向保持不变：
–如果载荷方向是现有几何体指定的，如果几何体改变载荷的方向 不会改变。

更新几何体记录 Training Manual
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“ ”

?输入和输出参数由 Mechanical 中通过参数开关按钮进
行定义。

?点击正方形蓝色 p 出现，标志着这个值可以像参数一
样被操作。

?材料属性在工程数据应用中参数化。

输入参数的例子

Example of output parameters

B. 定义参数 Training Manual
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? Workbench Mechanical 使用 Workbench Parameter Manager 管理从
分 析和原来几何体参数化的值 。

?可以创建及管理派生参数。

双击或 “RMB > Edit ”
“Parameter Set ”访问参数

使用参数管理 Training Manual
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?参数信息显示在一系列的列表中。
–提纲 :列出所有输入，输出或派生的参数。
–属性 :列出关于提纲中参数的信息 。

DP
表

提纲

表的设计要点 :允许多个参数配置，以
在求解前准备。

性质

. . . 使用参数管理 Training Manual
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?求解多个设计要点后，在参数管理中的几个后处理工具可用。
? Parameter Parallel Chart:

  DP3  
每个 XY 焦点提供了特

定
DP 下的所有参数的形

态  DP2  

水平线（ X）代表设
计要点   DP0  

垂直线（ Y）代表每
个参数 (P1, P2, 等).

DP1

⋯ 使用参数管理 Training Manual
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CAD and Parameters

?通过突出显示的参数，选择不同图表形态。

注意突出的 P1，图表选项考虑到这个参数
。

在选择（双击）想要的图表后，提纲（下面
）设定这样显示。



9-18

CAD and Parameters

⋯使用参数管理 Training Manual. . .使用参数管理
? 图表创建，它们列在提纲窗口中，并通
过在提纲窗口中突出的图表名称进行恢
复。

? 通过选择，用户可以建立惯用图表以使
用任何参数的组合。
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CAD and Parameters

?图表可以在窗口下定制。
?“右击 > Edit Properties ”在图表中。
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CAD and Parameters

⋯使用参数管理 Training Manual

?作业 9.1 –参数管理
?目标 :
–使用 DesignXplorer 参数管理器来改变指定的负荷大小和所示的模
型 材料属性，并在同一时间求解各种情况 。

C. 作业 9.1 –DesignXplorer 参数管理
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CAD and Parameters

Workbench - Mechanical 
Introduction

作业 9.1

参数管理器

WS9.1-1 



WS9.1: Parameter Management

WS9.1-2

作业 9.1 –目标 Workshop Supplement

?目标：
–使用 Workbench Parameter Manager （参数管理器）（在 Projet 页中
可用）建立多个方案，并同时对它们求解。



WS9.1: Parameter Management

WS9.1-3

. . . 作业 9.1 – Project Schematic Workshop Supplement

?打开 Project 页
?在 Units 菜单中确定：
–项目单位设为 Metric (kg, mm, s, C, mA, mV).
–选择 Display Values in Project Units



WS9.1: Parameter Management

WS9.1-4

1. 在 Toolbox 中双击 Static Structural
创建一个新系统

1.

2. 在 geometry 上点击鼠标右键选
择 Import Geometry 导入文件
Lever.x_t

作业 9.1 – Project Schematic Workshop Supplement

2.
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WS9.1-5

3. 双击 Model 打开 Mechanical application.

4. 设置作业单位制系统：
? Units > Metric (mm, kg, N, s, mV, mA)

3.

作业 9.1 –前处理 Workshop Supplement

4.
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WS9.1-6

5. 给模型施加约束（选中 Static Structural (A5) ）
： a.
a.  选择大孔的表面
b. RMB （点击鼠标右键选择） > Insert > Cylindrical 

Support （圆柱形约束）
c. 在 details of Cylindrical support 窗口中
把 Tangential （切向）设为 Free （自由）

d. 选中竖直圆柱孔的底面
e. RMB （点击鼠标右键选择） > Insert > Fixed Support （固
定约束）

b.

e.

d.
c.

作业 9.1 –环境 Workshop Supplement
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WS9.1-7

6. 给模型施加载荷：
a.  选择图示小一点的孔的表面

b. RMB（点击鼠标右键选择） > Insert > Bearing Load （弯
曲力）

c. 在 Details of “Bearing Load”中，选择分量方式 , 
d. 给 Y 方向指定一个 5000 N 的力
e.  把 Y Component 前的复选框切换为 P，把力作为一个参
量。

c.

d.

a.

b.

e.

. . . 作业 9.1 –环境 Workshop Supplement



WS9.1: Parameter Management

WS9.1-8

? 选中 Static Structural (A5) 查看载荷和约束

作业 9.1 –边界条件 Workshop Supplement
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WS9.1-9

8. 在每个结果的细节窗口中，通
过把对应的复选框切换为 P
把 “Maximum” （ 最 大 结
果）作 为一个参数。

7. 插入结果（选中 Solution(A6)
）：

a.
a. RMB（点击鼠标右键选择） >

Insert > Stress > Equivalent 
(von Mises).

b. RMB（点击鼠标右键选择） >
Insert > Deformation > Total. b.

作业 9.1 –求解步骤 Workshop Supplement

8.



WS9.1: Parameter Management

WS9.1-10

9. 返回到 Project Schematic ，启动
Engineering Data 程序：
a. 双击 Engineering Data a.

10.在 Engineering Data 中点击参数材料特性旁的 复选框，使其成为一个参
数：
a. Young’s Modulus （杨氏模量）
b. Density （密度）

提示：如果
Properties 窗口没有
显示，则从 View 菜

单中切换到
Properties 

作业 9.1 –材料参数 Workshop Supplement

a.

b.
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WS9.1-11

11. 进行参数设置：
a. 返回到 Project 页

?
b. 双击 Parameter Set

如图示参数管理器由一系列窗口组成，下面分
开来查看它们。

b.

作业 9.1 –参数管理器 Workshop Supplement

a.
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WS9.1-12

? Outline 窗口包含了一个项 目中
定义的所有参数的表单
（包含输入和输出） 。如
果保存了图形，在这里也能 看到
它们。

? Properties 窗口包含了
Outline 中的选中项的细
节
。这里选择了参数 P3 。

?注意，具体的参数个数的显
示依赖选择的命令（ P1,P2
等），可能和图示不同。

. . .作业 9.1 –参数管理器 Workshop Supplement
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? Table of Design Points 包含了一个所有已定义参数方案的完整表单。 在图 A 中只
有原始参数值是定义了的，而在图 B 中给出了多个已定义的设计点。

图 A. 

图 B. 

. . .作业 9.1 –参数管理器 Workshop Supplement
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WS9.1: Parameter Management

. . .作业 9.1 –参数 Workshop Supplement

12. 给 bearing load ， density 和 Young’s modulus 按如图所示赋值：

13. Update All Design Points 将让 Mechanical 执行对 table of Design
Points 中的每个方案的求解。

13.

12.



WS9.1-15

WS9.1: Parameter Management

. . .作业 9.1 –参数 Workshop Supplement

? 一旦更新过程开始，将会弹出一个下图示的信息。实际上在更新过程中会
关闭 Mechanical application 窗口，这很正常。

? 当更新结束时， Table of Design Points 将给出所有输出参数的计算值。

WS9.1-15
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. . .作业 9.1 –参数 Workshop Supplement

WS9.1-16

14. 创建一个整体变形随设计点的变化
图：
a. 选中 Outline 中的参数 P2

b. 双击 Toolbox 中的 Design 
Points Vs P2 选项

b.

a.
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WS9.1: Parameter Management

. . .作业 9.1 –参数 Workshop Supplement

15. 创建一个并行显示所有参数的图：
a. 双击 Parameters Parallel Chart (all)

WS9.1-17

图中每个彩线代表了一个设计点，在图的底部分别显示了参数名。

图的顶部和底部
值显示了每个对
应参数的变化范
围

a.
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. . .作业 9.1 –参数 Workshop Supplement

谐响应分析

Module 3



模块 3

谐响应分析
Training Manual

A. 谐响应分析定义以及目的 .

B. 谐响应分析的基本术语和概念 .

C. 学习如何在 WorkBench 中进行谐响应分析 .

D. 进行谐响应分析的练习 .
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? 2007 ANSYS, Inc.  All rights reserved.

ANSYS, Inc. Proprietary Inventory #002406
3-2

Workbench-Simulation

Dynamics



谐响应分析

A. 定义与目的
Training Manual

什么是谐响应分析 ? 谐响应是分析结构在承受一个或多个同频率的正弦（简谐）载荷作
用下，确定 系统稳态响应的一种技术。

? 输入 :
–已知幅值和频率的简谐载荷 (力、压力和强迫位移 )
–可以是具有相同频率的多种载荷 . 力和位移可以同相或者不同相 .但是压力分
布载荷和体载荷只能指定零相位角 .

? 输出 :
–在每个自由度的谐响应位移，通常和施加的载荷是不同相的 .
–其它导出值，比如应力和应变 .

July 10, 2007
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Workbench-Simulation

Dynamics

谐响应分析

⋯定义与目的
Training Manual

谐响应分析通常用于如下结构的设计与分析：

–旋转设备（如压缩机、发动机、泵、涡轮机械等）的支座、固定装置和部
件；

–受涡流（流体的漩涡运动）影响的结构，例如涡轮叶片、飞机机翼、桥和
塔等。
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谐响应分析

⋯定义与目的
Training Manual

? 为什么要做谐响应分析 ?

–确保一个给定的结构能经受住不同频率的各种正弦载荷（例如以不同 速度
运行的发动机）；

–探测共振响应，并在必要时避免其发生（例如：借助于阻尼器来避免 共
振） .
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谐响应分析

B. 术语和概念
Training Manual

涉及主题

? 运动方程

? 谐响应载荷性质

? 复位移

? 求解方法

July 10, 2007
? 2007 ANSYS, Inc.  All rights reserved.
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F 

u 

谐响应分析 –术语和概念

运动方程
Training Manual

? 运动控制方程 :

M &u& C u& K u F

? [F] 和{u} 是谐波形式的 :

F max ei ei t  ( F1 i F2 )e i t

u max ei ei t ( u 1 i u )e i t

? 谐响应分析的运动方程 :

( 2 M i C K )( u i u ) ( F i F )
1 2 1 2 

July 10, 2007
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谐响应分析 –术语和概念

简谐载荷性质
Training Manual

? 以给定频率呈正弦变化 .

? 相位角 允许可以不同，可以施加不
同相位载荷，默认的相位角为 0. Real

July 10, 2007
? 2007 ANSYS, Inc.  All rights reserved.
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谐响应分析 –术语和概念

复位移
Training Manual

? 计算得到的位移将会是复数，如果：
–指定了阻尼 . 
–施加的载荷呈复数形式  ( 即虚部不为 0). 

? 相对于施加的载荷，复数位移会有相位角的延迟 . 

? 结果的查看可以以实部 /虚部方式或幅值 /相位角的方式 . 
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谐响应分析 –术语和概念

接触区域
Training Manual

? 接触区域可用在模态分析中，但在线性分析中的接触行为不同于非线性
接触问题，如下表所示 :

? 接触行为类似于模态分析。在模态分析中，由于简谐模拟是线性的，非
线性接触相对于它的线性对应部件做出了简化 .
–一般在谐分析中不要使用非线性接触
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谐响应分析 –术语和概念

求解方法
Training Manual

求解谐响应运动方程的两种方法 :

? 完全法
–所有方法中最简单的。
–使用完全结构矩阵，允许存在非对称矩阵（如，声学）。

? 模态叠加法
–从模态分析中叠加模态振型。
–缺省方法；所有方法中最快的。

July 10, 2007
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谐响应分析 –术语和概念

⋯ 求解方法
Training Manual

? 完全法和模态叠加法比较 :

Full Mode Superposition

Relative running time Fast Fastest 

Relative ease of use Easiest Easy 

Element loads (e.g, pressures) allowed? Yes Yes 

Non-zero displacement loading allowed? Yes No 

Prestressing available? No No 

Need to select modes for solution? No No 
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谐响应分析 –术语和概念

⋯ 求解方法 –模态叠加法
Training Manual

? 模态叠加法是在模态坐标系中求解谐响应方程的。

–对于线性系统，用户可以将 x 写成关于模态形状的 i 的线性组合的表达式：

–在关系式中， y i指模态的坐标（系数）。
? 例如，用户可以通过求解一个模态分析来确定固有频率 i和相应的模态形状因子 i
。

? 可以看到，包括的模态 n 越多，对 {x} 逼近越精确。

July 10, 2007
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谐响应分析 –术语和概念

⋯求解方法 –模态叠加法
Training Manual

? 记住 :

– 模态叠加法首先自动进行一次模态分析。
? 程序会自动确定获得准确结果速需要的模态数。

? 虽然首先进行的是模态分析，谐分析部分的求解还是很迅速且高效的，因此，总的
来说，模态叠加法通常比完全法要快的多。

– 在由于进行了模态分析， DS 将会获得结构的自然频率。谐响应分析中，响
应的峰值是与结构的固有频率相对应。由于自然频率已知， DS 能够将结果
聚 敛到自然振动频率附近。

July 10, 2007
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谐响应分析 –术语和概念

⋯求解方法 –模态叠加法
Training Manual

Cluster 例子 :

In this example, the cluster option
captures the peak response better 
than evenly-spaced intervals 
(4.51e-3 vs. 4.30e-3)
The C luster Number determines 
how many results on either side of
a natural frequency is solved.
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谐响应分析 –术语和概念

⋯ 求解方法 –完全法
Training Manual

? 完全法也是求解谐分析的一种方法。

–在完全法中，直接在节点坐标系下求解矩阵方程， 除了使用了复数基本类似 于线
性静态分析。

K C 
2 M j C K 

xC 

FC 

x1  

F1  

jx2 

jF2 

K C xC FC 
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谐响应分析 –术语和概念

⋯求解方法 –完全法
Training Manual

? 记住 :
1. 对每一个频率，完全法必须将 [K c]因式分解。
– 在模态叠加法中是求解化简后的非耦合方程；在完全法中，必须将复杂的耦
合矩阵 [K C] 因式分解。

– 因此，完全法一般比模态叠加法更耗计算时间。、

2. 支持给定位移约束
由于对 {x} 直接求解，允许施加位移约束，并可以使用给定位移约束。

3. 完全法没有计算模态，所以不能采用结果聚敛，只能采用平均分布间隔

July 10, 2007
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谐响应分析

C. 步骤
Training Manual

四个主要步骤：

? 建立模型

? 选择分析类型与选项

? 施加简谐载荷与求解

? 查看结果

July 10, 2007
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谐响应分析步骤

建立模型
Training Manual

模型

? 不允许存在非线性 .

? 在 Module 1 的建模考虑点中的注意内容

July 10, 2007
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谐响应分析步骤 选
择分析类型和选型

Training Manual

建立模型

选择分析类型与选项

? 选择谐响应分析 Harmonic Response

? 主要的分析选项是求解方法的选择 -在后
面讨论

? 指定阻尼 -后面讨论

July 10, 2007
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谐响应分析步骤

⋯选择分析类型和选型
Training Manual

分析选项 阻尼
? 求解方法 –完全法或者模态叠加法。

? 对于大模型 (>100 万自由度 ),设置
“Store Results at All Frequencies ”为
“No”.

? 选择 β阻尼和阻尼比（常值阻尼最常使用）
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谐响应分析步骤

施加简谐载荷与求解
Training Manual

建立模型

选择分析类型与选项

施加简谐载荷与求解

? 结构载荷与支撑可以被使用，但是下面除外：
–不支持的载荷 :

? 重力载荷 Gravity Loads
? 热载荷 Thermal Loads
? 旋转速度 Rotational Velocity
? 螺栓预紧载荷 Pretension Bolt Load
? Compression Only Support ( 如果存在，其行为类似为于 Frictionless Support)

? 记住所有的结构载荷将以相同的激励频率呈正弦变化。
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谐响应分析步骤

⋯施加简谐载荷与求解
Training Manual

? 所有支持的载荷如下所示：

–并不是所有的载荷都支持相位的输入。加速度载荷、轴承载荷、弯矩载荷的 相位角
为 0°。
若有其它载荷存在，改变其它载荷的相位角，加速度载荷、轴承载荷、弯矩 载荷
的相位角仍然为 0° 。
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谐响应分析步骤

⋯施加简谐载荷与求解
Training Manual

? 简谐载荷需要指定：
–幅值与相位角
–频率

? 载荷在第一个求解间隔即被施加
(stepped )。

? 幅值与相位角

F2 max

F1 max

–载荷值代表幅值 Fmax.
–相位角 是指两个或者多个谐响应载荷之
间的相位变换，如果只有一个载荷存在的
话就没必要输入。非 的相位角只对力、
位移以及压力简谐载荷有效 。

Real 
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谐响应分析步骤

⋯施加简谐载荷与求解
Training Manual

? 幅值和相位角 (continued)
–允许在 Details 窗口中直接输入幅值和相位角。

F2 max

Real
F1 max

July 10, 2007
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谐响应分析步骤

⋯施加简谐载荷与求解
Training Manual

? 简谐载荷频率：
–在谐分析分析设置中，用户能通过输 入最大
值、最小值来确定激振频率域
，并确定求解的步长。

–比如， 0-50Hz 的频率范围，求解 间隔为
10，将会得到 5、10、15、
⋯、45 和 50 Hz 的结果。同样地
，如果间隔为 1的话，将只有 50Hz 的结
果。
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谐响应分析步骤

查看结果
Training Manual

建立模型
选择分析类型和选项

施加简谐载荷与求解

查看结果

?三个步骤 :
–绘制结构的指定点的位移 -频率曲线。
–识别关键频率和相位角。

–产看结构在关键频率和相位角下的位移和应力。
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谐响应分析步骤

查看结果
Training Manual

绘制结构的指定点的位移 -频率曲线

? 选择变形最大的节点，然后选择自
由度方向。

? 然后图形显示频率响应。
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谐响应分析步骤

⋯查看结果
Training Manual

识别关键的频率和相位角

? Bode plot 显示了幅值发生的对应频率值

? 峰值发生时的幅值和相位角可以在 Worksheet 中显示
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谐响应分析步骤

⋯查看结果
Training Manual

? 下一步是查看整个模型在指定频率和相位角下的位移和应力分布。

? 频率和相位角必须在 Details 窗口中手动输入。
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谐响应分析步骤

⋯查看结果
Training Manual

? 谐响应分析产生实部和虚部结果（作为不同的结果集） .

? 绘制在指定频率和相位角作用下的变形、应力云图和其它关心的结果 .
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谐响应分析步骤
Training Manual

建立模型

选择分析类型和选项

施加简谐载荷和求解

查看结果
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Workshop –谐响应分析
Training Manual

? 电机支架谐响应分析，具体见 WorkShop12 ：
WS12: Harmonic Analysis - Frame
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随机振动分析

PSD 分析

Module 5

July 10, 2007
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随机振动分析
Training Manual

主题 :
? 定义和目的
? WorkBench 分析功能概述
? 分析步骤

Workbench-Simulation

Dynamics
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随机振动分析

⋯定义和目的
Training Manual

Workbench-Simulation

Dynamics

A. 定义和目的

什么是随机振动分析 ?
–基于概率统计学的谱分析技术。
–例如火箭在每次发射中由载荷（例如加速度载荷等）产生的不同时间历程

Reference: Random vibrations in mechanical systems by Crandall & Mark
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随机振动分析

Workbench-Simulation

Dynamics

什么 PSD?
? PSD记录了激励和响应的均方根值同频率的关系，因此 PSD 是一条功率谱
密度值－频率值的关系曲线
–PSD曲线下的面积就是方差，即响应标准偏差的平方值
–PSD 的单位是 mean square/Hz （如加速度 PSD 单位 G2/Hz）
–PSD 可以是位移、速度、加速度、力或者压力
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随机振动分析

⋯定义和目的
Training Manual

Workbench-Simulation

Dynamics

? 典型的应用包括：
–飞机电子封装
–大气载荷作用下的飞机部件
–爆破导流片

–激光制导系统
–光学望远镜平台

–大型结构的地震载荷
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随机振动分析

⋯定义和目的
Training Manual

Workbench-Simulation

Dynamics

? 由于时间历程不是确定的，所以瞬态分析不是可选的。
? 而利用统计学标本功率谱密度 PSD 代表载荷时间历程。

Image from “RandomVibrations Theory and Practice”by Wirsching, PaezandOrtiz.
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随机振动分析

⋯定义和目的
Training Manual

输入 :
–结构的固有频率和固有模态
–PSD 曲线 （后面解释）

输出 :
–1 位移和应力，能够用于疲劳寿命预测

Workbench-Simulation

Dynamics
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随机振动分析

⋯定义和目的

Workbench-Simulation

Dynamics

⋯ Workbench 分析功能概
述

Training Manual

? 加载 :
–单点激励 : 施加于所有地面点单点 PSD 激励

? 求解 :
–相对或者绝对 1 结果输出
–整体结构的求解结果，如结果能够被绘制成云图
–结果输出形式： 1 位移、速度、加速度

? 后处理 :
–1 结果能够像其它分析一样被绘成云图
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随机振动分析
B. 随机振动分析步骤

? 模型 : 电线塔。

? 分析: PSD 谱的地面运动的随机振动
分析。

? 步骤 : 建立分析树、进行模态分析和
随机振动分析、查看结果

Training Manual

Workbench-Simulation

Dynamics



⋯随机振动分析步骤
Training Manual
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Dynamics

分析首先打开仿真数据库文件 ,
Tower.dsdb.

?如果文件不存在则
选择浏览文件



⋯随机振动分析步骤
Training Manual
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Workbench-Simulation

Dynamics

? 下一步，点击“ New Analysis ”工具条，选择“ Map of Analysis Types⋯ ”。
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Workbench-Simulation

Dynamics

? 分析类型向导便于建立随机振动分析的步骤
. 向导图显示在随机振动分析之前需要进行
模态分析 . 模态分析之前可以进行静力结构
分析，比如确定热载荷引起的预应力 .

? 选择“ Random Vibration ”，点击 OK，然
后就会在目录树中创建模态分析和随机振动
分析 . 同时会出现进行模态分析步骤向导 .

July 10, 2007 ANSYS, Inc. Proprietary Inventory #002406
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Workbench-Simulation

Dynamics

? 当点击 OK 之后，将会出现如右图所示的信息
.

? 当选择前面要求的 4 个步骤时，注意显示的信
息 .

? 在向导中选择 “Specify  Number of Modes ”
，就会出现如下所示的提示，输入所要使用 的模态阶
数 .
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Workbench-Simulation

Dynamics

? 下一步是插入支撑，所有的支撑点
全部为固定约束。
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Workbench-Simulation

Dynamics

? 完成了模态分析的准备工作之后，
求解，获取结果

? 模态分析结果可以在如右图所示的
Timeline 和 Tabular Data 窗口
查 看.
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o 
k

- S

i 

y

? 在向导中选择“ View Modal Results ”
将会提示显示以两种方式显示模态分析
结果 .

? 使用 shift 键 , 可以在 Tabular Data 窗
口 选取 12 阶频率结果，然后右键选择
“Create Mode Shape Results ”.

W
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? 同样可以在目录树中选择 12 阶模态结果，改变结果类
型为 Y 方向的变形 . 这是随机振动施加的方向，所以
比较关心该方向的变形 .

? 右键单击模态分析结果，选择“ Rename based on
definition ”，如下所示重新命名模态结果 .

Workbench-Simulation

Dynamics
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? 第 1 阶模态的结果动画如右图所示 .

Workbench-Simulation

Dynamics
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? 注意随机振动分析的初始条件已经自动设置
为前面的模态分析 .

? 为了说明的阻尼的效应，将把默认 0阻尼结果
和阻尼比为 0.05 的结果进行对比 .

Workbench-Simulation

Dynamics
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? 右键点击“ Random Vibration ”，会出现插入 PSD 基础激励的选项 .

? “PSD Base Excitation ”的 Details 窗口中选择插入新的 PSD 载荷 .

? 典型的 PSD 选项 , 用以 G^2/Hz 为单位的 G Acceleration 作为 PSD
输入 谱.

? PSD 表如下所示 .

Workbench-Simulation

Dynamics
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? 将激励方向有默认的 X 方向改为如右图所示 Y 方向 .
? 右键点击 Solution, 选择 Solve ，初始化 PSD 求解
? 当求解完毕，可以在 solution 分支中出入结果 ,比
如 Directional Deformation 结果 . 在 Details 窗
口 中的 Scale Factor 中将 1 Sigma 改为 3 
Sigma.

Workbench-Simulation

Dynamics
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? Directional Deformation 可以如右图所示根
据 定义重新命名

? PSD 谱 3σUY位移如右图所示输入 .
? 注意在右图所示的最大的 3σUY位移为 5944 mm.
? 下一步进行分析设置，设置常值阻尼比为 0   .05.

Workbench-Simulation

Dynamics
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? 该分析以 0.05 的阻尼比重新进行计算。

? 注意，如右图所示， 3σY方向位移有了明显的
减小 .

Workbench-Simulation

Dynamics
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C. Workshop –随机振动 (PSD)
Training Manual

? 在该例中，在于确定加劲梁在加速度 PSD 谱作用下的位移和应力。

WS7: Response Spectrum (PSD) Analysis of a Girder Assembly

Workbench

imula
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Workbench-Simulation
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D. Workshop –随机振动 (PSD)
Training Manual

? 在该例中，在于确定机翼模型在已知加速度 PSD 谱作用下的位移和应力。

WS8: Response Spectrum (PSD) Analysis of Model Airplane Wing
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概述
Training Manual

? 柔体动力学分析使用户能够确定结构系统在任何类型的时变载荷作用下
的动态响应。

–与刚体动力学不同的是，物体可以是刚性的还可以是柔性的。对于柔性体， 可以
包含非线性材料，能够获得应力和应变结果。

–柔体动力学同时也称为时程分析或者瞬态动力学分析。

–要进行柔体动力学分析，
必须要有以下 license ：
ANSYS Structural ,
ANSYS Mechanical , 或者
ANSYS Multiphysics

Assembly shown here is from an Autodesk Inventor sample model

Workbench-Simulation

Dynamics
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主题
Training Manual

A. 柔体动力学分析介绍
B. 初步线性动力学探讨
C. 非线性分析背景
D. 演示：冲击问题
E. 零件指定和网格
F.  非线性材料
G. 接触、连接和弹簧
H. 初始条件
I.   载荷、支撑和连接条件
J.  阻尼
K. 柔体动力学分析设置
L.  查看结果
M. 演示：刚柔混合动力学
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A. 介 绍
Training Manual

? 柔体动力学分析用于评估惯性效应不可忽视的柔性体系统的动力学响应

–如果惯性和阻尼效应可以忽略的话，可以考虑用线性或非线性静力分析替代

–如果载荷呈正弦变化以及响应是线性的，采用谐响应分析会更为有效

–如果物体可以被认为是刚性体，而且是只关注系统的运动学性能，采用刚体 动力
学分析能够节省计算成本

–对于其它情况，则采用柔体动力学分析，因为其是动力学分析的最通用的类
型

Workbench-Simulation

Dynamics
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Workbench-Simulation

Dynamics

⋯介 绍
Training Manual

? 在柔体动力学分析中， Workbench Simulation 是求解如下运动控制方
程：

M x C x K x x F t

几个注意点 :
–施加的载荷和连接条件可以是时间的函数

–从以上可以看出，惯性和阻尼效应已经被包含，因此必须在模型中输入密度 和阻
尼

–通过刚度矩阵的更新，包含非线性效应，比如几何非线性、材料非线性和接
触非线性



July 10, 2007
? 2007 ANSYS, Inc. All rights reserved.

ANSYS, Inc. Proprietary Inventory #002406
4-6

⋯介 绍
Training Manual

? 柔体动力学分析使用范畴比结构静力分析和刚体动力学分析更广，其允
许存在所有的连接类型、载荷和支撑。

? 进行柔体动力学分析一个很重要的考虑因素就是时间步长：

–时间步长必须足够小才能正确地描述随时间变化的载荷；

–时间步长控制着动力学响应的准确性。因此在 Section B 中建议首先进行一次
模态分析；

–时间步长同样控制着非线性系统的准确性和收敛行为。在 Section C 会有
Newton-Raphson 背景信息的相关阐述。

Workbench-Simulation

Dynamics
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Workbench-Simulation

Dynamics

B. 初始模态分析
Training Manual

? 虽然柔体动力学分析采用自动时间步长，选择合适的初始、最小、最大
时间步长对于动力学响应的计算准确性是非常重要的：

–不同于采用显式时间积分的刚体动力学分析，柔体动力学采用的是隐式时间
积分。因此柔体动力学分析的时间步长通常会较大。

–动力学响应可以认为是结构在载荷激励作用下引起的不同模态振型的组合。 初始
时间步需要基于系统的模态（或者固有频率）确定。

–推荐使用自动时间步长（缺省）：
? 最大的时间步长根据精度要求确定。该值可以与初始时间步一样或者稍大一点。

? 最小的时间步长可以用于防止 Workbench Simulation 无限次地进行求解。最小
时 间步长可以指定为初始时间步长的 1/100 或者 1/1000 。
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⋯ 初始模态分析
Training Manual

? 初始时间步长选择建议采用以下方程确定：

tinitial 
1  

20 f
response

f response 是所关心的最高阶模态振型的频率。

? 为了确定所关心的最高阶的模态，在柔体动力学分析之前需要首先进行
系统的模态分析 。
–通过这种方式，就可以确定结构的振型（即结构动态响应时可能激活的振动
形态）。

–同样可以确定 f response 的具体值。

Workbench-Simulation

Dynamics



July 10, 2007
? 2007 ANSYS, Inc. All rights reserved.

ANSYS, Inc. Proprietary Inventory #002406
4-9

Workbench-Simulation

Dynamics

⋯ 初始模态分析
Training Manual

注意点 :

? 自动时间步算法在求解过程中会根据计算的反应频率，增大或者减小时
间步长的大小。
–自动时间步算法仍然依赖于初始、最小、最大的时间步长；

–如果最小的时间步长被使用，表明初始时间步长被设置得太大了。可以在
Solution Information 分支下的 Details 中，选择 “Solution Output:
Time Increment ”显示时间步长的大小。

?当进行模态分析确定合适的反应频率值时，仅获取一些模态并使用计算
得到的最大频率，这样做是不充分的。最好是考察不同的模态振型，最
后确定哪些模态是对结构的响应的有贡献的，进而确定所关心的最高阶
的模态频率。
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Workbench-Simulation

Dynamics

C. 包含非线性
Training Manual

? 非线性的行为具有几种来源，柔体动力学分析通常会包含以下几种非线性：

–几何非线性:如果结构发生了大变形，变化后的

几何构型会引起非线性行为。
–材料非线性 : 非线性的应力应变关系，比如右
图所示的金属的塑性，是另外一种非线性的来源。

–接触 : 包含接触效应是状态非线性的一种，当 部件之间发生接触或者分离的时候胡
引起刚

度的突然变化。
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⋯包含非线性
Training Manual

K

Workbench-Simulation

Dynamics

? 在线性分析中，施加的力 F   和系统的位移 x关系如下：
如果力的大小增大一倍，则相应的位移、应力和应变也 F
增大一倍
–假设初始和变形后的几何形状改变是可以忽略不计的，因 为采用的刚度矩阵

[K] 是一样的 .

x

? 在非线性分析中，施加的力 F 和位移 x 的关系事先是未知
的

–因为结构几何发生了大变形，所以刚度矩阵 [K] 会发生变 F
化

–求解非线性问题需要用牛顿 -拉普森（ Newton-Raphson ）
方法求解 .

x
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⋯包含非线性
Training Manual

3
4

2

1

Workbench-Simulation

Dynamics

? 非线性分析需要多次求解迭代 :
–施加的载荷与变形的实际关系事先是未知的（如图绿色点划线所示）
–Newton-Raphson 方法 ,要进行一系列待修正的线性近似

? 在 Newton-Raphson 法中 , 第一次迭代施加全载荷 Fa， 结果为 x1. 通过位移可计算
内力 F1  ，如果 Fa  F1, 系统就不平衡。因此，就要利用当前条件计算新的刚度矩阵
（蓝线的斜率） .

? 重复上述过程直到 Fa  =F i   ，此时解收敛

? 有时，需要按照增量形式施加的载荷
Fa ， 以保证收敛 .因此，对于突变载荷，
需要有小的时间步长以保证收敛 . Fa

F1

x1 x
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⋯包含非线性
Training Manual

? 如前所述，时间步长的大小同样对非线性分析有所影响 :
–时间步长必须足够小，使 Newton-Raphson 方法获得力的平衡（收敛）
–用户也需要基于非线性的考量，指定初始、最小、最大的时间步长

? 通常，像在 Section B 中阐述的选择时间步长的考量已经足够充分 .
–因为 Workbench Simulation 只采用一组时间步长设置，重新求解动力学响
应通常能够能为重新求解非线性效应提供足够小的时间步 .

–根据非线性因素决定时间步长并不像选择动态时间步长直接 . 因此，用户可以 依赖
自动时间步长算法来保证收敛和精度 . Workbench-Simulation

Dynamics
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⋯包含非线性
Training Manual

? 自动时间步长算法考虑了如下非线性效应 :
–如果不满足力平衡（或者其它收敛准则） ,时间步长自动二分 ;
–如果最大的塑性应变增量超出了 15%,时间步长自动二分 ;
–另外 : 如果接触状态发生突变，时间步长自动二分 .

? 二分是自动时间步长算法的一部分.在二分时，求解器退回到前一步时间t i

的收敛解，采用更小的时间步长 t i.
–二分提供了一种更准确求解非线性问题或者克服收敛困难的自动方法 .
–注意：二分会导致使用更多的求解时间，因为求解会退回到上一步收敛的解
，然后采用更小的时间步长 .因此，选择合适的初始和最大的施加步长可以减
小二分的次数 .

Workbench-Simulation

Dynamics
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⋯包含非线性
Training Manual

? 缺省地，大变形效应和自动时间步长是被激活的 :
–为了考虑非线性效应，用户并不需要做特别的操作 .

? 然而，如前所提，如果非线性占主导，时间步长就以非线性考虑，而不是动态响应 .
? 在“Analysis Settings ” 分支下，大变形效应（ Large Deflection ）可以在 Details
窗口中设置 .

–如果用户想根据接触状态打开时间步长设置，可以在具体接触区域的 Details
窗口中的 “Time Step Controls ”设置 .

? 使用该选项可以减小时间步长，保证像在冲击问题中正确地传递动量

? 注意：这样时间步长可能会变得非常小，所以通常会不推荐采用，特别在初步分析
中 .

Workbench-Simulation

Dynamics
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D. 演示 : 概述
Training Manual

在该例中，将会进行一个球体撞击方形箱体的柔体动力学分析：

–首先会进行模态分析用于确定固有频率；
–下一步进行包含接触和塑性的柔体动力学分析；

Workbench-Simulation

Dynamics
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演示 : 打开模型
Training Manual

? 打开 “ Impact Problem.wbdb ”

? 从项目页，打开 “ ImpactProblem”在
“Geometry”分支下，可以在 “Engineering
Data”检查“plate ”定义为弹塑性双线性各项同性
强化模型（ BISO）。
已经添加网格控制，创建 thin-solid 网格（单元
类 型为实体壳），在撞击点位置的网格进行加
密处 理。

? 从单位工具栏，选择 “Metric (mm, kg, N, °C,
s, mV, mA) ”作为单位系统。
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演示 : 定义模态分析
Training Manual

首先进行“plate ”部件的模态分析，进而确定结 构的自然频
率。

? 从标准工具栏 , 添加 “New Analysis > Modal”

? 在“Analysis Settings ”的 Details 中 ，修改
“MaxModes to Find: 20”

Workbench-Simulation

Dynamics
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演示 : 施加支撑
Training Manual

? 选择“Modal”分支，而后选择 “Supports> Fixed
Support ”

为了指定部件底部的约束，之前已经创建命名选
择。

? 在 “Fixed Support ”的 Details 中 ， 选 择
“ScopingMethod: Named Selection ” ，然后修
改 “NamedSelection: Fixed_Base”
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演示 : 获取模态分析结果
Training Manual

? 选择 “Solution ” 分支 , 然后插入 “Deformation 
> Total ”

因为只是关心 “plate ” ，所以将“ball ”体抑制。
? 右键点击 “Geometry > ball ”，然后选择
“Suppress”。 注意响应的接触对也会
被抑制。

? 求解模型
在 3.2 GHz 的 PC闪，该模型至少要花费 1分钟进
行求解。

Workbench-Simulation

Dynamics
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演示 : 查看模态分析结果
Training Manual

? 选择“Total Deformation ”分支，查看模态振型

? 选择 “Solution Information ”分支 . 搜索 (Ctrl-F)
“ParticipationFactor ”，查看在 Y方向的参与因
子. 

注意到第 6阶振型 (~450 Hz) 具有最大的参与因子
。根据 Section B 的阐述，我们确定时间步长为
1/20f 或者为 1e-4 s. 

（这里还有高阶模态对该系统的响应有贡献，但是 在该例中，我
们只考虑前 6阶模态）
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演示 : 改变分析类型
Training Manual

改变分析类型：从 Modal 改变为 Flexible
Dynamic Analysis 

? 选择 “Modal”分支 , 然后在 Details 中, 修改
“Analysis Type: Flexible Dynamic”

在柔体动力学分析中，球将会冲击平板，所以
“ball ”不能够被抑制。

? 单击 “Geometry > ball ”，选择 “Unsupress”
注意相应的接触对自动变为非抑制状态。

Workbench-Simulation
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演示 : 分析设置
Training Manual

? 选择 “Analysis Settings ”分支，在 Details 中, 
改 变以下参数：
– 载荷步结束时间 Step End Time: 5e-3 
– 初始时间步长 Initial Time Step: 1e-4 
– 最小时间步长 Minimum Time Step: 1e-4 
– 最大时间步长 Maximum Time Step: 1e-3 

该分析的计算持续时间是 5ms，根据系统的频率
内容，选择 0.1ms 是合适的时间步长。
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演示 :初始条件
Training Manual

球的初始速度： (0, 5 m/s, 1 m/s) 
? 选择 “ Initial Condition ” 分支 . 在 details 中， 设
置如下参数：

– Input Type: Constant Velocity 
– Define By: Components 
– Y Component: -5000 
– Z Component: 1000 
– Scoping Method: Geometry Selection 
– Geometry: [Body- select the “ball ”part] 

因为对于“plate ”部件没有任何指定，所以认为其
初始处于静止状态。

Workbench-Simulation
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演示 : 添加欲获取的结果
Training Manual

? 选择 “Solution ”分支之后 , 添加 “Total
Deformation ”结果 ,同时添加其它感兴趣的结
果：
– Stress > Equivalent (von-Mises) 
– Strain > Equivalent (von-Mises) 
– Strain > Equivalent Plastic Strain 

? 选择 “Solution ”分支 , 然后添加 “Probe >
Force Reaction ” . 在 Details 中， 选择
Boundary Condition: Fixed Su pport ”
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演示 : 求解柔体动力学问题

? 单击 “Solve ”，启动求解过程 。 该柔体动力学
分析包含大变形效应、接触和材料 塑性，因此是
非线性分析。

通过选择“SolutionInformation ”，在 Details 中改
变“Solution Output: Force Convergence ”求解过
程可以被监控。

该分析在 3.2 GHz 的 PC 上大概要 30 分钟的求
解时
间。

Training Manual

Workbench-Simulation
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演示 :获取结果
Training Manual

? 当求解完毕，查看结果

? 右图所示的为等效应力云图以及动画显示。



July 10, 2007
? 2007 ANSYS, Inc. All rights reserved.

ANSYS, Inc. Proprietary Inventory #002406
4-29

演示 : 添加变形结果
Training Manual

? 将选择改变为 “BodySelect ”，只选择 “plate ”体.
然后 , 在 “Solution ”分支下 , 插入 “Deformation 
> Directional ”.在 Details 中 , 改变
“Orientation: Y Axis ”. 点击右键 “Retrieve
Results ”。

Workbench-Simulation
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演示 : 添加曲线图
Training Manual

? 选择 “Equivalent Plastic Strain ”和“Directional
Deformation ”,然后点击标注工具栏的 “New Chart
and Table ”图标 . 

? 在新添加的 “Chart ”分支 , 在 Details 窗口中改变
“Output Quantities > Equivalent Plastic Strain
(min): Omit ” . 

注意观察 Y 方向变形图和等效塑性应变曲线图。
在 计算中，等效塑性应变随着时间增加直到
0.3ms， 而后直到 1.1ms 一直保持为常值，再往后
达到最大 塑性应变 2.6%。此后，“ball ”体与
“plate ”体失去 了接触，所以塑性应变不再发
展。



分析步骤
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E. 零件指定
Training Manual

? 在柔体动力学分析中，部件可以是柔性或者刚性的：
–在 “Geometry”分支 , “Stiffness Behavior ”可以从“Flexible ”改变为
“Rigid”

–在同一个模型中，可以同时存在刚性体和柔性体

? 柔性体部分需要考虑的内容同静力分析中一样：
–指定恰当的材料属性，比如密度、弹性模量、泊松比等
–非线性材料属性，比如塑性或者超弹性

? 对于刚形体：
–只有 3D 单体部件可以指定为刚形体；
–密度是唯一需要的材料属性，用于计算质量
属性，其它的材料属性将会被忽略；

– “ Inertial Coordinate System”会自动在部
件的质心被定义

Workbench-Simulation

Dynamics
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On the figure on the right, one can 
see flexible bodies (meshed) and 
rigid bodies (not meshed) in the 
same model.

Workbench-Simulation

Dynamics

⋯零件指定
Training Manual

? 对于柔性体，网格密度是基于如下考虑：
–网格必须足够细，才能捕捉到结构相应的振型（动态响应）；

–如果关心应力和应变，网格要足够细才能准确捕捉到梯度变化；

? 对于刚形体，不用产生网格
–刚形体是刚性的，没有计算应力、应变和相对变形，因此不需要网格；
–在内部处理中，刚形体是表示为位于惯性坐标系统中中心的点质量。

Assembly shown here is from an Autodesk Inventor sample
model
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F. 非线性材料
Training Manual

? 对于柔性体，非线性材料可以被指定为：
–金属塑性：

? 定义杨氏模量和泊松比；
? 选择各向同性强化或者各向异性强化，双线性或者多线性应力应变曲线

– 对于多线性应力应变曲线，记住数值必须要以对数应变和真实应力输入

–超弹性：
? 选择超弹性模型 (neo-Hookean, Polynomial, Mooney-Rivlin, or Yeoh) 或者

(Ogden):
– 如果材料常数未知，可以输入试验测试数据，然后选择超弹性模型进行曲线拟合；

– 如果材料常数已知，选择相应的超弹性模型，然后输入相关参数；

? 为了考虑惯性效应，不管对于柔性体还是刚形体，都必须指定密度。

? 材料阻尼（在 Section I 中讨论），可以在柔性体中输入。

Workbench-Simulation

Dynamics
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G. 接触、连接和弹簧
Training Manual

? 在柔体动力学分析中，接触、连接或者弹簧是在 “Connections ”      分支下
定义的。

–接触只能在 2D或者 3D的柔性体之间定义.接触是用在部件之间的相互作用关系
或者零件之间的摩擦效应是重要的情况 .

? 非线性接触 (rough, frictionless, frictional) 只能用在 3D 体的表面之间或者 2D 体的
边之间的接触 .

–连接只能在 3D刚形体或者柔性体之间定义。连接可以在两个体之间或者体和
地面之间定义。连接的含义在于当部件之间是相互连接的并且可以发生相对运动是
的力学建模 。

? 连接只能在 3D 体的表面之间定义。

–弹簧只能在 3D刚形体或者柔性体之间定义 .弹簧提供了在指定区域考虑纵向刚
度和阻尼，在于表示没有建模区域的弹簧阻尼效应 .

? 弹簧可以定义在 3D bodies 的顶点、边以及表面上 .
? 所定义的弹簧长度为 0.



⋯ 接 触
Training Manual
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? 接触区域可以在柔性体之间定义：
–接触在接触区域未知的情况下或者接触区域随着分析过程发生变化的情况下
是有用的。

–任何一种接触行为 (线性 , 非线性 )都可以指定，包括摩擦效应。

Play Animation

In the animation, some 
surfaces of two parts are 
initially not in contact, but 
as the analysis 
progresses, the surfaces 
come into contact, as 
shown on the right, 
allowing for forces to be 
transmitted between the 
two bodies.
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⋯ 接 触
Training Manual

? 在接触中，部件之间被放置相互穿透。不同的接触行为在于描述法向分
离和切向滑移方向的不同 ：

Normal Direction Tangential Direction
Contact Type Separate Slide
Bonded no no 
No Separation no yes 
Rough yes no 
Frictionless yes yes 
Frictional yes yes (when F t≥N) 



⋯ 接 触
Training Manual
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? 不同的接触算法允许建立不同接触体之间的数学关系。

–对于绑定或者不分离接触，接触区域根据几何和 pinball 可以预先知道。
? 推荐的接触算法是使用 “Pure Penalty ” 或者 “MPC” 。

–对于 rough , frictionless 和 frictional 接触 ,
接触区域不能预先知道，所以必须进行迭代计算 。

? 推荐的接触算法是： “Augmented Lagrange ”。
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⋯ 连 接

? 连接是在不同的体之间或者体跟地面之间定义 :
–连接在面上定义允许的运动方式（动态约束）
–柔性体与刚形体之间可以定义不同的连接类型 :

Training Manual

? Fixed, Revolute, Cylindrical, Translational, Slot, Universal, Spherical, Planar,
或者 General Joints

–连接的定义以及设置会在另外单独的培训教程 ANSYS 刚柔混合动力学分析
（ANSYS Rigid and Flexible Dynamic Analysis ）中涉及

–不同于刚体动力学分析，而是指定实际的自由度，而不是相对的自由度 .

Assembly shown here is from an Autodesk Inventor sample model

The animation on the right shows 
an assembly using cylindrical and 
revolute joints
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⋯ 连 接
Training Manual

? 在柔体动力学分析中，还有指定连接行为的另外选项 :
–“Rigid ” (默认 )行为意味着选取的表面不会变形，而当做刚性面 .这就意味着在
分析过程中，圆柱面仍然保持为圆柱面 .

–“Deformable ”行为意味着虽然连接能够满足， 但是选取的表面能够自由变形 .这
就意味着在分

析过程当中，圆柱面可能不再保持为圆柱面 .

Workbench-Simulation

Dynamics
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⋯ 弹 簧

? 弹簧可以在不同体之间或者体与地面之间定义：
–弹簧可以定义表面的刚度和阻尼

? 阻尼的细节参考 Section I

–弹簧可以在刚形体和柔性体上定义
–弹簧是纵向的，所以刚度或者阻尼是相对于弹簧的长度改变

? 弹簧的长度不能为 0
? 弹簧可以在顶点、边或者面上定义

Training Manual

? 弹簧的定义以及设置会在另外单独的培训教程 ANSYS 刚柔混合动力学分析

（ANSYS Rigid and Flexible Dynamic Analysis ）中涉及
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H. 初始条件
Training Manual

? 对于柔体动力学分析，必须要有初始位移以及初始速度 :
–用户可以在 “ Initial Condition ”分支下定义初始条件或者采用多个载荷步。

? 通过“ Initial Condition ”分支定义初始位移和速度 :
–默认的初始条件是所有的体都处于静止状态

? 无需另外的操作

–如果有些体初始位移为 0，但是初始速度不为 0，
可以按照如下输入 :
? 只有体能够被指定
? 输入常值初始速度 (这种方法不能输入多个常值初始速度 )

Workbench-Simulation

Dynamics
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⋯ 初始条件
Training Manual

? 通过多个载荷步定义初始位移和速度：
–对于其它情况，必须采用这种方法

–让 “Initial Conditi ons”保持为 “At Rest. ”对于 “Analysis Settings ”，
采用在短时间间隔内分两个载荷步：

? 第一步在 Details 中设置非常小的 “Step End Time” . 同时 , 第一个载荷步改
变 “Time Integration: Off ”和“ Auto Time Stepping: Off ”. 修改“ Define 
by: Substeps ” 为“ Number of Substeps: 1”.

–在载荷步 1，施加合适的位移约束值 . 在载荷步 2，删除该位移。

–这种方法的理念在于第一个载荷步通过一个很短的时间步长 t 1 ，根据施加的 强制
位移 x initial ，得到初始位移和速度 .

vinitial xinitial

t1
如果时间步长 t1 足够小，对实际结束时间的影响是可以忽略不记的 .
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⋯ 初始条件
Training Manual

–初始位移 = 0, 初始速度 ≠ 0
? 在很短的时间间隔内施加很小的位移，得到想施加的初始速度 .然后在载荷步 2 中，
将位移删除 .

–初始位移 ≠ 0,初始速度 ≠ 0
? 在很短的时间间隔内施加期望的位移，得到想施加的初始速度 .然后在载荷步 2 中，
将位移删除 .

–初始位移 ≠ 0,初始速度 = 0
? 需要用两个子步来实现，所加位移在两个子步间是阶跃变化的。如果位移不是阶跃
变化的（或只用一个子步），所加位移将随时间变化，从而产生非零初速度。

Workbench-Simulation
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I. 载荷、支撑和边界条件
Training Manual

? 对于刚形体，在刚体动力学分析中，只支持惯性载荷、远端载荷和连接
条件。
–刚形体不能够变形，所以不要施加结构和热载荷。

? 对于变形体，所有载荷类型都可以施加：
–惯性和结构载荷

? PSD 基础激励只能在随机振动分析中施加，所以其不归于结构载荷。
–结构支撑

–连接和热载荷



July 10, 2007
? 2007 ANSYS, Inc. All rights reserved.

ANSYS, Inc. Proprietary Inventory #002406
4-46

⋯ 时变载荷
Training Manual

? 结构载荷与连接条件能够被表示为随时间变化的载荷历史。
–当添加一个载荷或者连接条件时，幅值
可以定义为常值、表格或者方程 .
–值可以直接在 Workbench Simulation GUI
中输入或者在 Engineering Data 页面中输入

Workbench-Simulation

Dynamics
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J. 阻 尼
Training Manual

? 如在 Section A 所述 ,柔体动力学分析所求解的方程包含有阻尼项 。

? 有三种型式的阻尼 :
–材料阻尼

? 对于每种材料单独指定。

–单元阻尼
? 在指定区域的弹簧连接可以包含阻尼效应。

–全局阻尼
? 影响整体模型的阻尼。

? 阻尼效应是累加的，因此定义 2%的材料和 3%的系统阻尼，则系统将会
有 5%的阻尼。
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⋯ 阻尼的定义
Training Manual

?粘性阻尼力 Fdamp 是同速度成比例的，其中 c 为阻尼常数 :

–临界阻尼 ccr 为系统出现振荡和非振荡行为临界状态时的阻
尼

Fdamp cx

–阻尼比 为实际阻尼 c 同临界阻尼 ccr .的比
值

? 阻尼的常用度量 :
–品质因子 Q i =1/(2 i)
–损耗因子 i 等于 Q 的倒数或者 2 i

–对数衰减率 i 近似等于 2 i

–半功率带宽 i近似等于 2 i i

c  
ccr

Workbench-Simulation

Dynamics
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⋯ 材料阻尼
Training Manual

? 在 Engineering Data 页面中 , 可以添加材料阻尼因子 :
–假设阻尼同刚度矩阵成正比 : c k
–如下所示，阻尼比 对于材料阻尼因子 随着频率呈线性增大 .  因此，材料阻尼
对于该种材料会抑制高阶频率 .

–注意采用的单位是 [s / rad] ，尽管因子同选择的单位系统无关

–注意材料输入中的 “Constant Damping Coefficient ”只适用于谐响应分析
，而不能用于柔体动力学分析 .

c  k  i
material

ccr 2 i m 2 
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⋯ 单元阻尼
Training Manual

? 如在 Section F 所述 , 弹簧连接可以包含纵向阻尼 c 的输入 .
–阻尼 c 的单位是： [力 / 长度 / 时间 ]

–如前面所述，阻尼比 是阻尼 c 同临界阻尼 ccr 的比

值：

c  
ccr

Workbench-Simulation
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⋯ 全局阻尼
Training Manual

? 全局阻尼参数是在 “Analysis Settings ”中输入 :
–同材料阻尼相似，阻尼值可以以 因子输入 , 尽管该阻尼是影响整个模型

–如果 值未知，可以改变 “Beta Damping
Define By” 为“Damping vs. Frequency. ”
? 在“ Beta Damping Measure”下指定阻尼比 .
在“ Beta Damping Frequency” 下指定相应的频率 .

? Workbench Simulation 将会计算合适的 值 .

–同时可以指定数值阻尼，默认值是 0.1 (10%).
? 数值阻尼来源于 HHT 数值积分方法 .
? 相关细节可以参考 Theory Reference for

ANSYS and ANSYS Workbench documentation
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K. 分析设置
Training Manual

? 除了阻尼，在 “Analysis Settings ”分支下还有其
他选项需要用户设置。

? 很重要的是，在 “StepControls ”中指定求解时
间

–“Number of Steps ”控制如何分割载荷历史 .如在
Section G 所述 , 可以通过多个载荷步施加初始条
件
–使用“ Time Integration ”控制某个载荷步是否考
虑时间积分效应

–“Step End Time ”是针对“Current Step Number”
的具体结束时间

–初始、最小、最大的时间步长必须如在 Sections B
& C 中所述的要求定义

Workbench-Simulation

Dynamics
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Dynamics

⋯ 分析设置
Training Manual

? “SolverControls ”中允许用户选择方程求解器，
是否使用弱弹簧、是否考虑大变形效应

–柔体动力学分析通常包含大变形效应，所以默认的
是打开大变形 “Large Deflection: On”

–“Output Controls ”允许用户控制结果数据存入
ANSYS 结果文件的频率 ,可以只存储最后载荷步的
结果 .  同样可以尽可能地均匀地存储结果 (取决于自
动时间步长 )
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L. 查看结果
Training Manual

? 当求解完毕，查看柔体动力学分析通常包含如下输出 :
–云图以及动画
–探测和图标

? 云图以及动画的创建同其它结构分析相似
–注意刚体的变形位置会在云图结果中显示，
但是刚体部分并不能任何位移、应力、应 变

的云图，因为它们是刚性体
Workbench-Simulation

Dynamics
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Dynamics

⋯ 查看结果
Training Manual

? 探测 (Probes) 在产生时间历程曲线是有用的，便于理解系统的瞬态响应 .
一些有用的探测结果如下：
–变形、应力、应变、速度、加速度

–力和弯矩反力
–连接、弹簧和螺栓预紧结果

? 图标对象，可以基于探测结果，添加
在报告中或者当做单独的图片



演示

刚柔混合动力学
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M. 演示 : 概述
Training Manual

在该例中，会进行引擎装配体中的一个零件的柔体动力学分析 :
–同时进行刚体动力学分析和柔体动力学分析

? 对于柔体动力学分析，连杆的应力最为关注，所以将该零件设置为柔性体

–连接定义和载荷

–装配体来自于 Autodesk 
Inventor 模型文件

Assembly shown here is from an Autodesk Inventor sample model

Workbench-Simulation

Dynamics
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演示 : 打开模型
Training Manual

? 打开 “Engine Assembly Example.wbdb”

? 从项目页 , 打开仿真数据库 “Model”装配体已经
被导入.注意装配体初始是没有对齐的 在
“Geometry”分支，查看各个零件，注意所有
的零件都可以指定为刚体，一些不需用到的已经
被抑制 . 

? 注意选择的单位系统一定要为 “Metric (mm, kg,
N, °C, s, mV, mA)”.
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演示 : 连接概述
Training Manual

对于该模型，将会定义 9对体与体的连接（如左下图所示），描述 9个体之间的运
动约束关系 .
两个体对地的连接在 Crank 与 Bore 之间定义（如右下图所示） .
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Dynamics

演示 : 创建连接
Training Manual

? 右键单击 “Connections ”，然后选择 “Create
Automatic Joints ”根据面与面的相邻关系，将
会自动创建连接 .

尽管连接被自动创建，通常需要校核一下创建的
连接 . 在该例中，一些连接是不需要的，可以删
除;其它的连接需要被修改 ; 最后一些连接需要手
工定义 . 
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演示 : 删除多余的连接
Training Manual

? 选择如下四个连接，点击右键选择 “Delete ” ,删
除下面四个连接 : 
– Revolute - bore:1 To conrod-brg:2 
– Fixed - conrod:1 To conrod-brg:1 
– Fixed - conrod-cap:1 To conrod-brg:2 
– Fixed - conrod-brg:1 To conrod-brg:2 
上面的连接是不需要的，所以需要删除 . 

? 将下列的连接类型从 “Revolute ”变为 “Fixed ”:
– Revolute - conrod:1 To conrod-brg:2 

– Revolute - conrod-cap:1 To conrod-brg:1 选择
如上两个连接，然后在 Details中，连接类型 从
“Type: Revolute ” 改变为 “Type: Fixed”

Workbench-Simulation

Dynamics
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演示 :修改连接
Training Manual

? 选择 “Fixed - conrod:1 To conrod- cap:1 ”

? 在工具栏，激活 “BodyViews”
当“Body Views”打开后，就能够更容易地查看 和选择连接
对中的两个部件中的面 . 

? 在 Details 中, 选择“ Reference > Scope: 1
Face”.按住<Ctrl>键选择“conrod:1 ”另外一边其
它的面 . 保证两边的面都选择，然后点击 “Apply”.

? 在 Details 中, 选择“Mobile > Scope: 1 Face”.按
住<Ctrl>键选择“conrod-cap:1”另外一边其它的面
. 保证两边的面都选择，然后点击 “Apply ”

? 点击 “Body Views”，关闭之 .
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演示 : 添加 Cylindrical 连接
Training Manual

? 选择“ bore:1 ”的内圆柱面和 “piston:1 ”的外圆柱面

? 从工具栏 , 选择 “Body-Body > Cylindrical ”
这就在“piston:1 ”和“bore:1 ”之间建立一个连接对
.

Workbench-Simulation

Dynamics
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Dynamics

演示 : 添加 Revolute Ground
Training Manual

? 选择“ crank:1 ”端部的面 ,从工具栏选择 “Body-
Ground > Revolute ”.
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演示 : 添加 Revolute 连接
Training Manual

? 选择 “conrod- brg:1 ”的内圆柱面 和 “crank:1 ”的
圆柱面 . 

? 从工具栏，选择 “Body-Body > Revolute ”这就
在两个部件之间添加 Revolute 连接 . 此时， 两
个部件之间并没有对齐，这在后面会进行更正 .

Workbench-Simulation

Dynamics
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Dynamics

演示 : 添加 Fixed Ground
Training Manual

? 选择“ bore :1”的外圆柱面，从工具栏选择
“Body-Ground > Fixed ” . 

? 这就将“ bore:1 ”与地面固定 . 



演示 : 将 Rod 和 Crank 对
齐 Training Manual
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Dynamics

? 选择 “Revolute - conrod-brg:2 To crank:1 ”.

? 在 Details 中,选择 “Mobile > Initial Position:
Override ”，添加 “Mobile Coordinate System”
子分支 .
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Dynamics

演示 :将 Rod 和 Crank 对齐
Training Manual

? 选择“Mobile Coordinate System”

? 在 Details 中, 选择“ Geometry: Click to
Change” . 选择在连接定义中所使用的圆柱面 , 如
右图所示的圆 .点击“Apply”



演示 : 将 Rod 和 Crank 对
齐 Training Manual
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? 从工具栏 , 点击 “Configure ”注意，根据定义的
连接，活塞和连杆可以移动（ 对于曲柄也一
样）

使用 Configure Triad, 可以看出只有 RZ 自由度是 活动的，可
以将部件移动到任一初始位置 . 对于该例，初始位置并不需要
改变 . 

? 点击工具栏的 “Set”，确认所做的改变 . (因
为坐标系统并不是完全相关的，所以会出现 消
息窗口 .关闭之 .) 
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演示 : 连接自由度校核
Training Manual

? 选择 “Connections ”分支 , 然后点击
“Worksheet”.
“Joint DOFChecker”提供了一种校核系统是否 过约束的方法：
显示模型的自由度数 .注意必须校核模型的自由度数 –该值必
须大于 0. 
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演示 : 刚体动力学设置
Training Manual

? 从标准工具栏 , 选择 “New Analysis > Rigid
Dynamic”

? 在“Analysis Settings ”分支的 Details 中, 将
“Number of Steps ” 改变为 “2”

? 对于“Current Step Number: 1 ”,设置“Step
End Time”为 0.1

? 将“Current Step Number ” 改变为“ 2”,设置
“Step EndTime”为 0.2 这就定义了刚体动力学
分析的两个载荷步 , 第一
个载荷步在 0.1s 后结束，第二个载荷步在 0.2s 后
结束 . 

Workbench-Simulation
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演示 : 添加连接条件
Training Manual

? 从工具栏 , 选择 “Condition > Joint Condition ”
在 Cylindrical 连接上施加力载荷以驱动活塞运动 . 

? 在“Joint Condition ”的 Details 中，选择
“Joint:Cylindrical - piston:1 To bore:1 ”

? 选择“DOF: Z Displacement ”
? 选择“ Type: Force”
? 在 Tabular Data 中 , 输入如下数据 :

– For Time: 0, Force: “0”
– For Time: 0.1, Force: “-100”
– (Leave Time: 0.2 to “=-100”)
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演示 : 添加连接条件
Training Manual

? 在 Timeline 中选择“2”,点击右键选
择 “Activate/Deactivate at this 
step! ”
-100 N 的载荷只在第一个载荷步施加，第二个载
荷步移除该载荷 . 

Workbench-Simulation
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演示 : 求解刚体动力学
Training Manual

? 选择 “Solution ”分支 , 从工具栏添加
“Deformation > Total ”
– 在 Details 中, “Boundary Condition ”设为
“Revolute - Ground to crank:1 ”

– 选择“ Result Type: Relative Rotation ”

– 选择“ Result Selection: Z Axis ”

? 点击 “Solve ”求解刚体动力学分析
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演示 : 查看刚体动力学结果
Training Manual

? 选择 “Total Deformation ”，利用 Timeline 的
控 制按钮显示动画

Workbench-Simulation

Dynamics
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演示 : 复制模型
Training Manual

? 右键单击 “Model”分支，将其改名为 “Rigid
Dynamic Model”

? 右键单击 “Rigid Dynamic Model”，选择
“Duplicate ”

? 将“Rigid Dynamic Model 2”重命名为
“Flexible Dynamic Model”
后续的步骤都是在新创建的 “Flexible Dynamic
Model”分支上操作
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演示 : 柔体部件
Training Manual

? 选择 “Geometry > conrod :1”

? 在 Details 中, 改变其刚度行为为
“Stiffness Behavior: Flexible ”

在该分析中，除了 “conrod:1 ”之外的部件都被指
定为刚体 . 

Workbench-Simulation

Dynamics
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演示 : 设置成柔体动力学分析
Training Manual

? 选择 “Rigid Dynamic”分支 .

? 在 Details 中,改变分析类型为 “Analysis Type:
Flexible Dynamic”使用刚体动力学分析中的连
接条件和载荷，所以 不必重新定义另外的载荷
和支撑 .
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演示 : 柔体动力学分析设置
Training Manual

? 选择“Analysis Settings ”

? 在 Details 中, 改变 “Current Step Number” 为
“1”
– 初始时间步长 “Initial Time Step: 1e- 2”
– 最小时间步长 “Minimum Time Step: 5e- 3”
– 最大时间步长 “Maximum Time Step: 0.1”

? 改变 “Current Step Number”为“ 2”
– 初始时间步长 “ Initial Time Step: 1e- 2”
– 最小时间步长 “Minimum Time Step: 1e- 2”
– 最大时间步长 “Maximum Time Step: 0.1”

柔体动力学的时间步考量同刚体动力学是不同的 . 
参考 Workbench Simulation 11.0 帮助手册中的
柔体动力学分析时间步长确定分析指南 . 

Workbench-Simulation

Dynamics
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演示 : 求解柔体动力学分析
Training Manual

? 选择 “Solution ”分支 , 从工具栏选择 “Stress >
Equivalent (von- Mises) ”

? 从工具栏选择 “Probe > Energy”
获取所感兴趣的结果 . 

? 点击 “Solve ”，初始化求解
Workbench Simulation 将首先划分柔性体的网格
，然后进行求解 . 
通过选择 “Solution Information ”分支，在 Details
中选取 “Solution Output: Force Convergence”，可
以监测非线性瞬态分析的进程
.
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演示 : 查看结果
Training Manual

? 选择 “Equivalent Stress ”，从 Simulation 中查
看 等效应力 .
– 如果想查看指定时间点的应力，从 Timeline 或者

Tabular Data 中选择时间，点击右键选择
“Retrieve thisResult ”

– Timeline 中同时显示了云图结果的最大值和最小值 . 

? 动画显示等效应力结果

Workbench-Simulation

Dynamics
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演示 : 查看结果
Training Manual

? 选择和查看 “Joint Probe ” 和“Energy Probe”
结果

注意对于能量，在分析中只有动能起作用，因为
没有部件产生应变以抵抗活塞的运动（这也是应
力值如此低的原因） . 
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演示 :总结
Training Manual

在该例中，进行了一个装配体的刚体动力学分析和柔体动力学分析 .
有一些注意点值得提醒：

–连接含有坐标系来使连接的相对自由度相联 .最好保证参考坐标系和移动坐标
系是相关的。

? (由于时间的限制，这在练习中并没有进行操作 .)

–对于柔体动力学分析，任何类型的接触、载荷和支撑都可以使用，这些在刚
体动力学是不可能的 .

? 在该例中，只有演示连接和连接条件 .

–刚体动力学分析和柔体动力学分析的“ Total Deformation ”结果是不同的
(77.8 与 79.2). 原因在于刚体动力学的变形只是部件中心的变形，在包含旋转
的情况下就会影响变形的结果 .

Workbench-Simulation
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D. Workshop –瞬态分析

? 在该例中，主要研究脚轮在边缘受到冲击后的动力学响应。

WS6: Transient Analysis of a Caster Wheel

Training Manual

Striker
Tool

Wheel



第十二章

Workbench 谐响应分析练习



谐响应分析

E. 12 – Training Manual

? 目标 :
– 在这个练习，我们的目标是研究如图所示的电机机架 (Frame.x_t) 的谐响应 . 
在给定频率的作用下，确定机架的频率响应与应力、变形状况。



谐响应分析

12 – Training Manual

? 假定机架是用结构钢制造。

? 假设机架为一焊接件，并是一个连续体（无接触）。

?我们假定机架被设计用于支撑一台设备，该设备在 Y 方向上传递 400N
的 力，并以 200Hz 频率运行。该设备被连接在与其它相互作用 60 度
相位差 的两个不同位置上。

? 结构钢的阻尼比率被认为是常数 0.2。

? 在进行谐分析前，我们将会在结构上进行一次模态分析。虽然在谐分析
并不一定要求先进行模态分析，但这样能更好地了解结构的固有频率的
情况，这会有助于选择谐分析中被认为更重要的结果。



” “

谐响应分析

12 – 建分析流 Training Manual

双击工具栏中的“ Modal （ANSYS ）
，然后拖动 Harmonic 

Response （ANSYS ）”，将其放置
在 A4 上，创建谐响应分析流程



谐响应分析

入几何模 Training Manual

在“Geometry ”单元
格中 RMB（单击右

键
），导入机架几何模
型 Frame.x_t



谐响应分析

入仿真处理界 Mechanical Training Manual

双击 Model 单
元格，进入
Mechanical
界面



谐响应分析

12 – 处 Training Manual

? 将单位制改为国际单位制
1. “Units > Metric (m, kg, N,  s，V，A)”.

1.



谐响应分析

12 – 态分 Training Manual

2. 选中 Modal （A5）命令条 .

3. 在图形窗口中选中在机架管子部分的 8个圆柱孔表面。

4. “RMB > Insert > Cylindrical Supports ”. 2.

4.

3. (8 faces)



谐响应分析

. . . 12 – 态分 Training Manual

5. 在明细表窗口中将圆柱体支撑约束的定义变更为 Fixed/Fixed/Free.

5. 6.

6. 选中”Analysis Settings ”

7. Details 窗口中”Max Modes to Find”：10（提取前 10 阶模态）

求解 Solve .



谐响应分析

. . . 12 – 态分析结 Training Manual

? 模态的结果表明一阶固有频率大约为 150Hz，主要由 Y 方向的运动控
制。



Training Manual

谐响应分析

. . .作 12 –环
8.

8. 选中“ Cylindrical Support ”，RMB->Copy

9. 选中“ Harmonic Response (B5) ”命令条 ,RMB
>Paste, 复制边界条件

10. 在如图所示的角度选中左边安装孔上的两个圆柱
面。

10. (2 faces)

9.



谐响应分析

. . . 12 –
11. 选中“ Harmonic Response (B5) ”

11.

12. “RMB > Insert > Force”.

Training Manual

12.

从力的明细窗中指明 : 

13. 时间类型 :简谐

14. 定义方式 :分量

15. Y 方向分量 : 400 N 13.
14.

15.



谐响应分析

. . . 12 –
16. 在如图所示的角度选中右边安装孔上的两个圆柱面。

Training Manual

16. (2 faces)



谐响应分析

. . . 12 –
17.“RMB > Insert > Force”.

Training Manual

从力 2 的明细窗中指明 : 

18. 时间类型 :简谐

19. 定义方式 :分量

20. Y方向分量 : 400 N

21. 相位角 : 60 degrees
18.

19.

20.

21.

17.



谐响应分析

12 –
22. 选中 “Harmonic Response (B5) ”的“ Analysis Settings ”

Training Manual

22.

注意 :从之前完成的模态分析中，我们可以了解到，所发生的最高频率（ 第六阶）是
约为 600Hz。由于我们限制了简谐模拟的范围在 800Hz 之内
。同样，我们也可以要求在整个频率区间求解 30 个结果，而不是默认的
10 个。



谐响应分析

. . . 12 – Training Manual

23.
24.

25.

在“Analysis Settings ”明细窗中指定 : 23.范围最值 : 

800 Hz.

24. Solution Intervals: 30. 

25.Constant Damping Ratio: 0.2.



8. 选择如下所示的安装孔的顶边

谐响应分析

. . . 12 –
26.选择“ Solution （B6）” . 27.

27.将选择过虑器改变为 “Edge”选择 .

28.选择如下图安装孔的边

Training Manual

28.
2



谐响应分析

. . . 12 –
29.“RMB > Insert >Frequency> Deformation ”.

Training Manual

29.

30.

30.在明细窗中将 orientation 设定为 “Y Axis ”.



谐响应分析

. . . 12 –
? 选择同第 28 步一样的边

31.“RMB > Insert >  Phase Response > Deformation ”.

Training Manual

31.

32.在明细窗中将 orientation 设定为 “Y 
Axis ”

33. 在 Frequency 区域输入 200.

32.

33.



谐响应分析

. . . 12 –
34.选择如下所示的安装孔的顶边

Training Manual

35.

? 重复从 30 到 33，输入数值同前。



谐响应分析

. . . 12 –
35.选中 “Solution （B6）” . 

36.“RMB > Insert > Stress > Normal”.

? In the detail change the definition to: 

37.Orientation: Y Axis

Training Manual

38. Frequency: 200 Hz 37.
38.

36.

36.



谐响应分析

. . . 12 – Training Manual

39.“RMB > Insert > Deformation > Directional ”.

? 在明细窗中修改为 : 

40.Orientation: Y Axis

41. Frequency: 200 Hz

? 求解 40

41

39.



谐响应分析

12 –
? 选中频率响应对象。默认的格式是

Bode plot ( 见右图 )，图中在同一窗口
显示了振幅和相位角。

? 通过改变明细窗，可以看到其它结果
的信息。

Training Manual



谐响应分析

. . . 12 – Training Manual

? 相位响应图可以看到不同的输入力与结果（在选定点处）的对比。当施
加第二个力载荷有 60 度相位角的变化。



谐响应分析

. . . 12 –
? 结果云图可以绘出激励频率为 200，相位角为 0的应力
SY。

Training Manual



谐响应分析

. . . 12 –
? 结果云图可以绘出激励频率为 200，相位角为 0的 Y方向位移
UY。

Training Manual


